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Preface

The Sun Enterprise SyMON 2.0.1 User’s Guide provides instructions on how to use the

Sun Enterprise SyMON™ system management solution. These instructions are

designed for a system administrator with networking knowledge.

Note – In the Sun Enterprise SyMON software, all alarm messages are displayed in

English.

Using UNIX Commands

This document may not contain information on basic UNIX® commands and

procedures such as shutting down the system, booting the system, and configuring

devices.

See one or more of the following for this information:

■ Solaris Handbook for Sun Peripherals

■ AnswerBook™ online documentation for the Solaris™ software environment

■ Other software documentation that you received with your system
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Typographic Conventions

Shell Prompts

TABLE P-1 Typographic Conventions

Typeface Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your .login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when

contrasted with on-screen

computer output

% su
Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized

Command-line variable; replace

with a real name or value

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

To delete a file, type rm filename.

TABLE P-2 Shell Prompts

Shell Prompt

C shell machine_name%

C shell superuser machine_name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #
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Related Documentation

Sun Documentation on the Web
The docs.sun.com sm web site enables you to access Sun technical documentation

on the Web. You can browse the docs.sun.com archive or search for a specific book

title or subject at:

http://docs.sun.com

Sun Welcomes Your Comments

We are interested in improving our documentation and welcome your comments

and suggestions. You can email your comments to us at:

docfeedback@sun.com

Please include the part number of your document in the subject line of your email.

TABLE P-3 Related Documentation

Product Family Title Part Number

Midrange Servers Sun Enterprise SyMON 2.0.1 Supplement
for Sun Enterprise Midrange Servers

806-0649

Workgroup Servers Sun Enterprise SyMON 2.0.1 Supplement
for Workgroup Servers

806-1183

Workstations Sun Enterprise SyMON 2.0.1 Supplement
for Workstations

806-1184
xxxiii
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CHAPTER 1

Introduction

This chapter provides an overview of the Sun Enterprise SyMON™ version 2.0.1

product, its component layers, and how they interact with one another.

This chapter includes the following topics:

■ Sun Enterprise SyMON Overview

■ Sun Enterprise SyMON Architecture

■ Sun Enterprise SyMON Concepts

■ Sun Enterprise SyMON Monitoring Features

Sun Enterprise SyMON Overview

Sun Enterprise SyMON software is an open, extensible system monitoring and

management solution that uses Java™ software protocol and Simple Network

Management Protocol (SNMP) to provide an integrated and comprehensive

enterprise-wide management of Sun products and their subsystems, components,

and peripheral devices.
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Sun Enterprise SyMON technology provides a solution to extend and enhance the

management capability of Sun’s hardware and software solutions.

Sun Enterprise SyMON Architecture

Sun Enterprise SyMON software comprises three component layers: console, server,

and agent. It is based on the manager/agent architecture, in which:

■ The console is the user interface which interacts with you to initiate management

tasks.

■ The server (manager) executes management applications and sends requests to

agents in order to perform management tasks on your behalf.

■ The agents (that are executing on the managed nodes) access the management

information, monitor local resources, and respond to manager requests.

The three component layers are depicted in FIGURE 1-1.

TABLE 1-1 Sun Enterprise SyMON Technology

Feature Description

System Management Monitors and manages the system at the hardware and operating

system levels. Monitored hardware includes boards, tapes, power

supplies, and disks.

Operating System

Management

Monitors and manages operating system parameters including load,

resource usage, disk space, and network statistics.

Application and

Business System

Management

Provides enabling technology to monitor business applications such

as trading systems, accounting systems, inventory systems, and

real-time control systems.

Scalability Provides an open, scalable, and flexible solution to configure and

manage multiple management domains (consisting of many

systems) spanning across an enterprise. The software can be

configured and used in a centralized or distributed fashion by

multiple users.
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FIGURE 1-1 Sun Enterprise SyMON Component Layers

The major Sun Enterprise SyMON layers and their functionality are described below.

Console Layer

You may have multiple consoles, serving multiple users, for the same Sun Enterprise

SyMON server. The consoles provide you with:

■ Visual representations of the managed objects (for example, hosts and networks)

■ The ability to manipulate attributes and properties associated with the managed

objects (for example, create alarm thresholds)

■ The ability to initiate management tasks (for example, dynamic reconfiguration)

The Sun Enterprise SyMON console layer is the interface between you and the other

component layers of Sun Enterprise SyMON software.

Server Layer

The server layer accepts requests from you through the console and passes these

requests to the appropriate agent. It then relays the response from the agent back to

you.

Console Console

Server

Agent Agent Agent
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For example, if you want information on the number of users accessing a host, the

server layer receives this request from the console, and sends it to the agent on that

host. The agent finds the answer, sends it back to the server, which passes on the

information to you (through the console)

Similarly, if an error condition is created on one of the hosts, the agent on that host

sends notification of this error (an event) to the server, which forwards the

information to you (through the console) as an alarm.

In addition, this layer provides the console with a secure entry point to interface

with the agents.

The server layer includes five components (FIGURE 1-2):

■ Sun Enterprise SyMON server

■ Topology manager

■ Trap handler

■ Configuration manager

■ Event manager

FIGURE 1-2 Sun Enterprise SyMON Server Layer

Sun Enterprise SyMON server layer Console

RMI

Configuration
manager

Topology
manager

Event
manager

Trap
handler

Remote
SNMP
agent

Local
SNMP
agent

SNMP SNMP

SNMP SNMP

SNMP SNMP

 Server
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The server component is the core of the server layer. It is based on Java technology

and is multithreaded, and it handles multiple data requests from various Sun

Enterprise SyMON users.

Sun Enterprise SyMON Topology manager provides services including the

management of user domains and the topology layout of managed objects.

The Trap handler is a centralized SNMP trap receptor that performs logging and

forwarding of traps to interested components. It is this server layer component that

is responsible for receiving all alarm notifications.

The Sun Enterprise SyMON Configuration manager provides security services to the

server and the agents.

The Sun Enterprise SyMON Event manager sends and receives event information

from the agents. These events can trigger alarms, which are forwarded to the

console.

Agent Layer

The agent layer performs the actual information gathering, monitoring, and

management of objects on the nodes managed by the Sun Enterprise SyMON

software. The server layer interacts with the agent layer to gain access to the

managed objects by using SNMP.

Sun Enterprise SyMON agents are scalable, extensible, and SNMP-based. They

monitor and manage objects including hardware, operating systems, and

applications by loading modules that focus on a specific aspect of the system, as well

as application health and performance.

The agents use rules to determine the status of the managed objects. When the

conditions specified by a rule become true, the software automatically generates

alarms or performs actions as specified in the rules.

Server Context

A Sun Enterprise SyMON server context is defined as the server layer and the agent

layers. When starting the console, you log into a particular server context. The

managed objects whose agents send information to that same server also belong to

the same server context.

A managed object can belong to the same server context or a remote server context.

(A managed object in a remote server context sends information to a different server

while a managed object in the same server context sends information to the server

host that is connected to your console.)
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By default, the Sun Enterprise SyMON software manages an object in the same server

context but only monitors an object in a remote server context. For a precise

definition of manage and monitor, see the Glossary. For more information on the

server context, see Chapter 15.

FIGURE 1-3 Console Logs Into a Server Context

Sun Enterprise SyMON Concepts

The following concepts are fundamental to understanding Sun Enterprise SyMON

software:

■ Domains

■ Modules

■ Alarms and Rules

Note – In this document, “domain” refers to a Sun Enterprise SyMON

administrative domain, and should not be confused with uses of the term “domain”

related to other Sun products or documentation. See Chapter 4 for more information.

Console

 Server

Agent Agent Agent

Server

Server context 1 Server context 2
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Domains

A domain is a hierarchical collection of resources that you want to monitor and

manage. The resources can include a complete campus, individual buildings, hosts,

networks, subnets, links, and so on. Each domain may consist of these resources,

which can be combined with other resources to form groups within a domain. Each

of these groups may contain additional groups of resources, providing a multilevel,

hierarchical domain.

You should create domains based on your business needs. You can create one or

more domains. For example, you may create a lab domain that contains all the lab

machines. Similarly, you may create an accounting domain that contains all the

machines used for accounting.

The Sun Enterprise SyMON software displays the domain and its members in a

visual representation (FIGURE 1-4).

In the following example, the host, Payroll2 , belongs to the Building B group,

which belongs to the Payroll Servers 1 domain.

FIGURE 1-4 Sun Enterprise SyMON Main Console Window Showing a Domain and Its
Members

Domain

Domain
members
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Modules

Unlike most agents, the Management Information Base (MIB) provided by Sun

Enterprise SyMON agents is not implemented in a monolithic code that contains a

wide variety of functionality in a single program. Instead, Sun Enterprise SyMON

software uses several components, called modules, for each agent. Each module

implements its own MIB. Therefore, the Sun Enterprise SyMON agent MIB is the

cumulative total of all the modules and their individual MIBs (FIGURE 1-5).

FIGURE 1-5 Sun Enterprise SyMON Agent MIB

Sun Enterprise SyMON modules monitor and manage the resources of systems,

applications, and network devices.

The modules serve two purposes:

■ To monitor and notify you (through alarms) when error conditions occur

■ To monitor and notify you (through alarms) when performance tuning is required

For more information on alarms, see“Alarms and Rules” on page 9.

Each module consists of one or more properties that can be monitored on your

system. For example, one of the default modules loaded during installation is the

Kernel Reader. This module monitors kernel properties. These properties include

user statistics, disk statistics, file system usage, and so on.

Note – You can add or remove modules dynamically. This feature enables you to

customize the modules loaded on each agent (object), based on your need.

Agent

Module
C

Module
B

Module
A

Module
C MIB

Module
B MIB

Module
A MIB
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Alarms and Rules

Sun Enterprise SyMON software enables you to monitor your system with alarms of

differing severities. The thresholds that generate these alarms are defined in the

modules. The software enables you to set the thresholds that trigger simple alarms.

For example, one of the properties of the Kernel Reader module is the number of

user sessions. The software enables you to set the threshold that generates the alarm.

For example, you may tell Sun Enterprise SyMON software to generate a critical

alarm when there are seven or greater user sessions. Similarly, you may also tell the

software to generate only a cautionary alarm when there are five-to-six user

sessions.

Although the software is configured with default alarm conditions, you can set and

define your own alarm thresholds for simple alarms such as those based on the

simple rCompare (comparison) rule.

Complex rules also generate alarms. For example, one complex rule states that when

a disk is over 75 percent busy, the average queue length is over 10 entries and the

wait queue is increasing, then an alert alarm is generated. This rule combines three

conditions:

■ Percentage of the disk that is busy

■ Average queue length

■ Wait queue

Unlike simple rules, these complex rules are predefined and cannot be modified.

Consequently, you cannot set thresholds for complex alarms.

When an alarm is generated, the software notifies you through the main console

window.

For more information on alarms, see Chapter 13. For more information on rules, see

Appendix E.

Sun Enterprise SyMON Monitoring
Features

Sun Enterprise SyMON software includes the following monitoring features:

■ Autonomous Agents

■ Main Console Window

■ Hierarchy and Topology Views

■ Processes View

■ Log View
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■ Physical View

■ Logical View

■ Graph

■ Security

These are graphical user interface or GUI-based features, except for autonomous

agents. Security is both a GUI-based and command-line feature.

Autonomous Agents

Sun Enterprise SyMON agents work autonomously by actively sampling key data

on host systems. These agents can be polled through SNMP get requests for the

current status of the monitored data.

When an agent gathers data for a monitored resource, it checks the data against the

alarm threshold set for the resource and determines whether the data values

constitute an alarm condition. If the monitored data meets the alarm threshold, the

agent performs the action associated with the alarm condition. Agents send

asynchronous messages (SNMP traps) to the server, which delivers notification of

the change in the status of the monitored data.

Main Console Window

Sun Enterprise SyMON software provides a main console window to depict,

monitor, and interact with your system. You can monitor multiple domains,

spanning different locations, through multiple console windows.

Hierarchy and Topology Views

Sun Enterprise SyMON software offers both hierarchy and topology views (for every

domain) and hierarchy and contents views (for every object). The hierarchy enables

you to navigate through the domain or host to find the object of interest. The

topology view or contents view displays the members of the object that is selected in

the hierarchy.

For a domain, the hierarchy and topology views are displayed in the main console

window. In addition, you may customize the domain topology view by adding a

background or creating a connection between objects in the domain.
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For an object, the hierarchy and contents views are displayed in the Details window.

The Details window consists of a series of tabs; the tabs are dependent on the type of

object. For example, a typical host object contains the following tabs: Info, Browser,

Alarms, Processes, Log View, and Configuration.

Processes View

The processes view tab button enables you to view and select detailed information

about processes running on the selected host or node.

Log View

The log view tab button enables you to view informational messages, including error

messages, about your host.

Physical View

The physical view provides you with photo-realistic front, back, and side views of

the host. With your mouse button, you can click on individual components of the

host and see detailed information about that component. For example, you can click

on a board in a server, and see detailed information about that board, such as CPUs,

memory, and board temperature.

Note – Physical views are only available for some hardware platforms.

Logical View

Sun Enterprise SyMON software provides a logical view of the overall hardware

configuration of the host. Like the physical view, you can click on a single

component and obtain detailed information about that hardware component.

Note – Logical views are only available for some hardware platforms.
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Graph

Sun Enterprise SyMON software enables you to create a two-dimensional graph of

any monitored data property that has a numerical value.

Security

The Sun Enterprise SyMON security feature authenticates user login and access

control privileges for users and groups. It enables users to set security permissions at

the domain, group, host, and module levels.

You can restrict access by setting different permissions. For example, one group of

users can see and modify properties on a host while a second group of users can

only see the host (with no modification privileges).

You can access Sun Enterprise SyMON security features from the Attribute Editor

within the software.

Getting Started With the Sun Enterprise
SyMON Software

Note – For additional documentation describing new functionality, refer to the Sun
Enterprise SyMON 2.0.1 Software Release Notes, which is located on the Sun Enterprise

SyMON web site: http://www.sun.com/symon and on the Sun Enterprise

SyMON 2.0.1 CD.

Sun Enterprise SyMON supports multiple hardware platforms. Refer to the Sun
Enterprise SyMON Configuration and Deployment Guide on the Sun Enterprise SyMON

web site for more information on the supported hardware platforms: http://
www.sun.com/symon/ .

This Sun Enterprise SyMON 2.0.1 Software User’s Guide describes the software

functionality that is common to all the supported hardware platforms while

platform-specific information is included in the supplements. For example, Sun

Enterprise SyMON functionality specific to the SPARCserver™ 1000 and 1000E, the

SPARCcenter™ 2000 and 2000E, and the Sun Enterprise™ 6x00/5x00/4x00/3x00 is

contained in the Sun Enterprise SyMON 2.0.1 Supplement for Sun Enterprise Midrange
Servers. This supplement is located on the Sun Enterprise SyMON web site: http:/
/www.sun.com/symon and in the Sun Enterprise SyMON 2.0.1 CD.
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Note – For complete information on how you can use the Sun Enterprise SyMON

software to manage and monitor your machines, read both this user’s guide and the

hardware supplement applicable to your machines.

After installing Sun Enterprise SyMON software, spend some time navigating

through the various windows and testing their functionality. By exploring and

testing the software, you will have a better understanding of how you can customize

Sun Enterprise SyMON software to aid in your system monitoring. See Appendix A

for more information.

If you prefer to set up your monitoring environment now, see Chapter 15 for

information on security.
Chapter 1 Introduction 13
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CHAPTER 2

Preparing to Install the Sun
Enterprise SyMON 2.0.1 Software

This chapter describes the requirements your system must meet prior to installation

of the Sun Enterprise SyMON version 2.0.1 product on your system.

The following topics are discussed in this chapter:

■ System Requirements

■ Sun Enterprise SyMON Agent Supported Systems

■ Supported Operating Environments

■ Sun Enterprise SyMON Compatibility

■ Installation Packages

■ Pre-Install Information

■ To Resolve the SNMP Port Conflict

■ Uninstalling the Sun Enterprise SyMON Software

■ To Remove Sun Enterprise SyMON Software

Note – Sun Enterprise SyMON software limitations and bugs are listed on the web

at http://www.sun.com/symon .

System Requirements

The Sun Enterprise SyMON installation script enables you to install the console

layer, the server layer, and the agent layer separately or together. TABLE 2-1 lists the

minimum disk space requirements for the three layers.
15



Note – If you are installing all three layers on one machine, you must have a

minimum of 50 Mbytes of disk space available. This is not the sum total of the disk

space requirements for the individual layers, as the layers share some common

packages.

Note – Depending upon your system, disk space requirements may be different.

Refer to the Sun Enterprise SyMON Configuration and Deployment Guide on the

following web site for more information on Sun Enterprise SyMON disk space

requirements: http://www.sun.com/symon .

Sun Enterprise SyMON Agent
Supported Systems

For the latest information on supported hardware platforms, go to the following web

site: http://www.sun.com/symon . The Config-Reader module is required for

hardware configuration information.

The Config-Reader and the Dynamic Reconfiguration modules are not supported on

all Sun hardware platforms. All the other core Sun Enterprise SyMON modules are

supported on Sun hardware platforms. For more information on core modules, see

Appendix C and Appendix D. For more information on supported hardware

platforms, go to the Sun Enterprise SyMON web site and read the Sun Enterprise
SyMON Configuration and Deployment Guide.

TABLE 2-1 Minimum Disk Space Required for the Sun Enterprise SyMON Installation

Layer Minimum Disk Space Required (Mbytes)

Server 45

Agent 25

Console 25
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Supported Operating Environments

The following Solaris operating environments are supported with the Sun Enterprise

SyMON 2.0.1 product:

■ Solaris 2.5.1 or subsequent compatible versions

■ Solaris 2.6 or subsequent compatible versions

■ Solaris 7 (32-bit and 64-bit modes)

Note – Sun Enterprise SyMON software is supported only on Solaris SPARC
Platform Edition systems, not on Solaris Intel Platform Edition systems.

Sun Enterprise SyMON Compatibility

Version 2.0.1 of Sun Enterprise SyMON software is compatible with:

■ Any simple network management protocol SNMP V1, V2c, and V2usec entities,

regardless of the operating environment and architecture

■ Solstice Enterprise Agents™ of Solaris 2.6 and 7 software can be converted to

subagents of the Sun Enterprise SyMON agent

■ Version 2.0 of Sun Enterprise SyMON software

Sun Enterprise SyMON software does not offer:

■ Backward compatibility with the Solstice SyMON™ 1.x software

■ SunVTS™ support in the Sun Enterprise SyMON 2.0.1 software
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Sun Enterprise SyMON Component Layer

Compatibility

There are three supported combinations of the Sun Enterprise SyMON component

layers, as shown below:

Installation Packages

By design, Sun Enterprise SyMON software is an open and extensible system

management tool, and the packaging and installing of this product reflects this

extensibility. The Sun Enterprise SyMON product is divided into a core set of

packages, and a set of add-on components. Although this distinction exists, the

installation and setup of all Sun Enterprise SyMON software (including add-on

components) is done with a single command as described in the following sections.

Core Packages

The core packages provide the fundamental layers, such as console, server, and

agent. In addition, the core packages provide architecture-specific support for the

SPARCserver™ 1000 and 1000E, the SPARCcenter™ 2000 and 2000E, and the Sun

Enterprise™ 6x00/5x00/4x00/3x00 systems.

TABLE 2-2 Supported Combinations of the Sun Enterprise SyMON Component Layers

Console Server Agent

2.0 2.0 2.0

2.0.1 2.0.1 2.0.1

2.0.1 2.0.1 2.0
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TABLE 2-3 describes the core packages provided with the Sun Enterprise SyMON 2.0.1

software.

These packages are located on the Sun Enterprise SyMON 2.0.1 Software CD or the

Sun Enterprise SyMON web site (http://www.sun.com/symon ). To install these

packages, see “Pre-Install Information” on page 21” and “Installing the Software on

Your System” on page 28.

Add-on Components

Depending on the hardware platform on which you are installing Sun Enterprise

SyMON software, your system may require additional add-on platform-specific

components. These add-on components, described in the Sun Enterprise SyMON 2.0.1
Supplement for your hardware platform, provide additional functionality such as

support for other Sun hardware architectures or new agent management.

TABLE 2-3 Sun Enterprise SyMON 2.0.1 Core Packages

Package Name Description

SUNWescon Console package

SUNWesagt Agents package

SUNWesmod Agent modules

SUNWsycfd Config-Reader module for the core Sun Enterprise SyMON product1

1. The Config-Reader module for the core Sun Enterprise SyMON product supports the SPARCserver 1000 and
1000E, the SPARCcenter 2000 and 2000E, and the Sun Enterprise 6x00/5x00/4x00/3x00 systems. Config-Reader
modules for other hardware platforms are included in the platform-specific add-on components.

SUNWesdb Database

SUNWescom Common Components

SUNWeshlp Help

SUNWesjp Additional Components

SUNWessrv Server

SUNWessa Server/Agent

SUNWesae /etc files needed by the Agent

SUNWesse /etc files needed by the Server
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Note – Always read your Sun Enterprise SyMON 2.0.1 Supplement for

architecture-specific installation instructions before installing Sun Enterprise

SyMON software on a particular hardware platform. Refer to the Sun Enterprise

SyMON 2.0.1 CD or go to the web site: http://www.sun.com/symon and click on

Documentation for the supplement.

Add-on components are released in one of two ways:

■ as part of the Sun Enterprise SyMON distribution (CD or web download image)

■ separately (add-on component only)

If the add-on components are part of the Sun Enterprise SyMON distribution, the

add-on components are installed during the installation process. The core

components are installed first, followed by installation of the add-on components

that are part of the distribution.

Many add-on components offer architecture-specific support. Because of this, the

installation checks your hardware. For example, if an add-on component package

supports workstation systems, the workstation package is automatically added

when Sun Enterprise SyMON is installed on a workstation host. In some cases, user

confirmation is required prior to installing an add-on component package.

If the add-on component is released separately, the add-on component will include

installation instructions.

Note – Refer to your supplement for more information.
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Pre-Install Information

The following table briefly lists some of the pre-requisite information that you

should have before installing the version 2.0.1 of Sun Enterprise SyMON software.

TABLE 2-4 Issues to Consider Prior to Installing Sun Enterprise SyMON Software

Issue Description

Removing old packages Make sure to remove all the Solstice SyMON 1.x packages. For

example, the following packages must be removed: SUNWsye,
SUNWsym, SUNWsyrt , SUNWsys, SUNWsyu, SUNWsyua, SUNWsyub,
SUNWsyuc, SUNWsyud, SUNWsyue, and SUNWsyuf. For more

information, see “Uninstalling the Sun Enterprise SyMON

Software” on page 24

Component layers you

want to install

Decide which component layers you want to install - Server,

Agent, Console, and Help.

Space needed in

/opt
Make sure you have enough space available in /opt . If not, make

more space or make a soft link to an area with more space from

/opt/SUNWsymon . For more information, see “Where to Install

Sun Enterprise SyMON Software” on page 29

Permissions Make sure you have permissions to write into the /var/opt (or

/opt/SUNWsymon ) directory as root . You also need privileges to

type commands, such as chmod, in that directory.

Set up Component layer(s) you want to set up are: Server, Agent,

Console. Component layers that have been installed must be set

up.

Information needed for

server

Note that when you install the server, you do not need to have the

console on the same machine. Also, it helps if you have

information on the following items: license key for the software,

ports to be used, and password to be used (referred to as a seed).

Information needed for

agent

Seed (password) to be used. Sun Enterprise SyMON server host if

server is not installed on agent machine.

Information needed for

console

None.

Information needed for

add-on components

Add-on dependent data. For more information, refer to your

supplement.

Online help Decide whether to set up Sun Enterprise SyMON online help on a

remote machine.
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Port Conflicts with SNMP Legacy Agents

Sun Enterprise SyMON software may conflict with port numbers that are used by

legacy subagents. Systems with Solaris 2.6 or Solaris 7 operating environments have

two potential conflicting processes in the following areas: snmpdx and mibiisa .

If you install the software using standard defaults, you may run into port conflicts

with these processes and be unable to start the agent. The setup process notifies you

if there is a problem. Here is an example:

If you choose to use a different port number, the following prompt is displayed:

Caution – If you choose to correct the port conflict by stopping the process that is

using the port, remember to do so before the Sun Enterprise SyMON agent is

started. If the Sun Enterprise SyMON agent fails to start correctly, refer to the

agent.log file to see if there is a port conflict.

Note – View the log file with the command:

/opt/SUNWsymon/sbin/es-run ccat /var/opt/SUNWsymon/log/agent.log .

The log file displays error messages similar to the following:

-------------- WARNING -------------------
It appears that agent.snmpPort 161 is already is use.
SyMON agent may not be able to run due to this conflict.
There are two ways to correct this conflict:
1. Reconfigure the port that Symon uses.
2. Stop the process that is using the port.
You are currently running snmpdx, which may be causing the
conflict.
Do you want to use a different port number for agent.snmpPort?
[y|n|q]

What port number would you like to use? x
Updating /var/opt/SUNWsymon/cfg/domain-config.x with new port
number.

error Nov 05 13:24:59 agent parsing error in base-agent.x(132):
error creating interface: inet://:161/udp: address already in use
error Nov 05 13:24:59 agent *** aborting execution ***
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▼ To Resolve the SNMP Port Conflict

● Make one of the following changes.

■ Change the port numbers used by the Sun Enterprise SyMON software, as

described in“Port Conflicts with SNMP Legacy Agents” on page 22 or

“Configuring Sun Enterprise SyMON Software to Use Different Port Addresses”

on page 306.

■ Turn off snmpdx and mibiisa by completing the following two steps:

a. Turn off snmpdx and mibiisa by using the following command:

b. Prevent snmpdx and mibiisa from starting the next time the machine is booted
to avoid conflicts. Rename the start-up script with the following command to
prevent the snmpdx and mibiisa daemons from starting the next time the
machine is rebooted:

In addition to these two processes (snmpdx and mibiisa) , your system may

have other legacy SNMP agents utilizing port 161. Therefore, you need to take

action to resolve this port conflict with the Sun Enterprise SyMON agent.

Note – For more information, see “Configuring a Legacy SNMP Agent as a

Subagent of a Sun Enterprise SyMON Agent” on page 304 and “Configuring Sun

Enterprise SyMON Software to Use Different Port Addresses” on page 306.

# /etc/rc3.d/S76snmpdx stop

# mv /etc/rc3.d/S76snmpdx /etc/rc3.d/s76snmpdx
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Uninstalling the Sun Enterprise SyMON
Software

We suggest that you delete previous versions of Sun Enterprise SyMON software

from your system before you install a newer version on the same server. In some

cases, previous versions are un-installed for you. Refer to the following table to see

how this might affect your site:

If you must manually remove previous versions, the uninstall program

(es-uninst ) removes all packages that are part of the Sun Enterprise SyMON

software, including the add-on packages.

Note – If the Sun Enterprise SyMON software already replaced an earlier

independent installation of the configd package SUNwsycfd , then this package

will not be uninstalled by the es-uninst script.

▼ To Remove Sun Enterprise SyMON Software

1. Type the following command.

2. Type y to uninstall Sun Enterprise SyMON software, or n to cancel your request.

TABLE 2-5 When to Uninstall Sun Enterprise SyMON Software

Current version of SyMON: Method of installation: How to uninstall previous versions:

1.x Any See your Solstice SyMON 1.0

documentation for information on

removing Solstice SyMON 1.0

software

2.0 Installation script from the

CD or the web

Sun Enterprise SyMON 2.0.1

software removes the previous

version

# /opt/SUNWsymon/sbin/es-uninst
24 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



Caution – This utility does not enable you to remove Sun Enterprise SyMON

packages selectively. Once you type y, all the packages are removed. There is no

additional warning before package removal begins.

The contents of the /var/opt/SUNWsymon directory remain and are unaltered by

the uninstall script. The state of the domain configuration is retained for subsequent

installations or upgrades.

Note – To verify if there are packages that are left, type the following command:

pkginfo -c symon .
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CHAPTER 3

Installing the Sun Enterprise
SyMON 2.0.1 Software

This chapter explains how to install the Sun Enterprise SyMON™ version 2.0.1

product on your system.

The following topics are discussed in this chapter:

■ To Upgrade from 2.0 to 2.0.1 Software

■ To Install the Sun Enterprise SyMON Packages From the CD

■ To Install the Sun Enterprise SyMON Packages From the Web

■ To Set Up Sun Enterprise SyMON Online Help on a Remote Machine

■ To Set Up Sun Enterprise SyMON Component Layers

■ To Add Sun Enterprise SyMON Users

■ To Start the Sun Enterprise SyMON Software

■ To Exit the Sun Enterprise SyMON Console

■ To Stop the Sun Enterprise SyMON Server and Agents

Note – Sun Enterprise SyMON software known limitations and bugs are listed on

the web at http://www.sun.com/symon .

Upgrading from Sun Enterprise SyMON
2.0 to 2.0.1 Software

When you are upgrading from Sun Enterprise SyMON 2.0 to 2.0.1 software, follow

these steps:
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▼ To Upgrade from 2.0 to 2.0.1 Software

1. Install the new Sun Enterprise SyMON 2.0.1 server and console packages first.

You can install these at the same time, or if you want to install them separately,

install the server first, and then the console.

2. Upgrade the agent(s).

Installing the Software on Your System

This section describes how to install, set up, and run your Sun Enterprise SyMON

2.0.1 software. Read this section for general information about your Sun Enterprise

SyMON installation then follow the steps in the appropriate procedure, based on

your delivery method (CD or the web).

Install Sun Enterprise SyMON software using the inst-es script. During

installation, you may install the console, server, agent, and help layers separately or

in combination.

Note – The coexistence of the Solstice SyMON 1.x and Sun Enterprise SyMON 2.x
software is not supported on the same server. In addition, you may have Sun

Enterprise SyMON sessions running on different servers or server contexts. For

more information on server context, see Chapter 1 and Chapter 15.

What to Do About Files or Component Layers

from Earlier Versions of Sun Enterprise SyMON

Software

If you have Solstice SyMON 1.x packages installed on your system, the installation

script fails. You must remove all Sun Enterprise SyMON 1.x packages before

installing Sun Enterprise SyMON 2.0.1 software.
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Caution – The Sun Enterprise SyMON 2.0.1 installation script may overwrite

Solstice SyMON 1.x files. Consequently, you may lose your customized event rules.

If you have modified Solstice SyMON 1.x rules, then you must back up these rules

before installing Sun Enterprise SyMON 2.0.1 software. Depending on where you

modified your event rules, back up the /etc/opt/SUNWsymon directory or the

/opt/SUNWsymon/etc directory.

If you have Sun Enterprise SyMON 2.0 component layers already installed on your

system and they are out of date with the new version of the installation package and

the files that you are trying to install, the install script prompts you to uninstall the

previously installed packages. You can either:

■ uninstall immediately and proceed with a fresh installation, or

■ quit the current session and uninstall the necessary packages automatically by

using the es-uninst command, and then proceed with the installation.

Caution – If you are reinstalling the Sun Enterprise SyMON software and would

like to restore it to a “new” state, do the following:

- Make sure to move any custom configuration files that may have been created

within the /opt/SUNWsymon directory during the previous sessions.

- Remove all subdirectories and files within the /var/opt/SUNWsymon directory by

using the following command: rm -rf /var/opt/SUNWsymon .

- Complete the installation and setup as described in this chapter.

- Then restore the moved files back to this location.

The result of this process is that previous database entries are cleared, as well as

your topology. Be sure this is what you want to do before proceeding.

Where to Install Sun Enterprise SyMON Software

Sun Enterprise SyMON packages are installed in /opt/SUNWsymon .

If there is not enough disk space in the /opt/SUNWsymon directory to accommodate

the Sun Enterprise SyMON packages, then do the following:

● Create a symbolic link to any other file system in which enough space is available.

# mkdir / directory/SUNWsymon
# ln -s / directory/opt/SUNWsymon /opt/SUNWsymon

!
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Caution – Install the Sun Enterprise SyMON agent on every monitored or managed

host. In addition, you must install a Sun Enterprise SyMON agent on your Sun

Enterprise SyMON server host (even if you choose not to run this agent). When the

server is installed, the Sun Enterprise SyMON installation program displays a

message to tell you that it is installing the agent as well.

Note – You can get a listing of all packages related to Sun Enterprise SyMON

software that are currently installed with the following command:

pkginfo -c symon .

▼ To Install the Sun Enterprise SyMON Packages

From the CD

Note – Familiarize yourself with the following file on the CD before beginning your

installation: /cdrom/symon_2_0_1/INSTALL.README .

Any late-breaking news that develops concerning this software installation

procedure is placed at the Sun Enterprise SyMON web site:

http://www.sun.com/symon .

1. Place the Sun Enterprise SyMON 2.0.1 CD in the CD-ROM drive.

2. Open a command window and (if you are not already superuser) become
superuser by using the su command.

3. If you are running the Sun Enterprise SyMON server for the first time, edit the
/etc/nsswitch.conf file. Be sure the groups entry has files as the first token.

4. Change to the CD-ROM directory.

■ If you are using the Volume Manager (vold ), type:

groups:files nis

# cd /cdrom/symon_2_0_1
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■ If the CD-ROM drive is not already mounted, mount the drive by typing:

5. List the files in the symon_2_0_1 directory.

6. Launch the Sun Enterprise SyMON installation script by typing the following
command:

The script presents an interactive list of questions, that guides you through the

installation procedure.

7. Select the Sun Enterprise SyMON component layers (agent, server, console, or
help) you want to install.

Note – Be sure to read “Sun Enterprise SyMON Online Help” on page 34 before

installing the online help.

Note – The inst-es script enables you to set up your Sun Enterprise SyMON

component layers. A set of questions guides you through the setup procedures.

Sun Enterprise SyMON packages are installed in /opt/SUNWsymon .

Note – The installation process installs the Sun Enterprise SyMON packages

(including any applicable hardware add-on component packages) for your system.

In some cases, user confirmation is required prior to installing an add-on

component. Refer to the supplement for more information.

# mkdir /cdrom/symon_2_0_1
# mount -o ro -F hsfs /dev/dsk/c Xt YdZs0 /cdrom/symon_2_0_1
# cd /cdrom/symon_2_0_1

# ls
Copyright   FR_Copyright     Sol_2.5.1    Sol_7
Docs        INSTALL.README   Sol_2.6      inst-es   windows

# ./inst-es

Copyright   FR_Copyright     Sol_2.5.1    Sol_7
Docs        INSTALL.README  Sol_2.6     inst-es   windows
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▼ To Install the Sun Enterprise SyMON Packages

From the Web

Note – Before installing Sun Enterprise SyMON on your system, read the

INSTALL.READMEfile in the downloaded packages. This file provides additional

information that helps you during the installation process.

1. Using your web browser, go to the Sun Enterprise SyMON web site.

2. Click the mouse button on Download Software.

Note – Prior to downloading the Sun Enterprise SyMON software, you must

determine which OS versions you will be installing Sun Enterprise SyMON on.

There is a separate Sun Enterprise SyMON download file for each OS version.

3. Follow the instructions on this web page and download your Sun Enterprise
SyMON packages. Store the software in a location that is accessible by root .

4. Open a command window and (if you are not already superuser) become
superuser by using the su command.

5. After you have downloaded the Sun Enterprise SyMON packages, connect to the
directory where you want the packages located. Use the following command:

6. Extract the Sun Enterprise SyMON packages via the following command:

If you downloaded multiple OS (operating system) versions of the Sun Enterprise

SyMON packages, you may extract all OS versions into a single directory. Simply

execute the above command for all downloaded package files without changing the

current directory.

http://www.sun.com/symon/

 cd / download_directory

# zcat downloaded_filename | tar xvf -
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Note – Place only packages of the same Sun Enterprise SyMON software version in

the same directory.

7. If you are running the Sun Enterprise SyMON server for the first time, edit the
/etc/nsswitch.conf file. Be sure the groups entry has files as the first token.

8. List the files in the symon_2_0_1 directory.

Note – Your directory may appear different, depending on the OS versions you

downloaded and which directory the OS was extracted into.

9. Become root , if you are not already and complete the following:

■ Launch the Sun Enterprise SyMON installation script as shown below:.

The script presents an interactive list of questions, that guides you through the

installation procedure.

10. Select the Sun Enterprise SyMON component layers (agent, server, console, or
help) you want to install.

Note – Be sure to read “Sun Enterprise SyMON Online Help” on page 34 before

installing the online help.

Note – The inst-es script enables you to set up your Sun Enterprise SyMON

component layers. A set of questions guides you through the setup procedures.

Sun Enterprise SyMON packages are installed in /opt/SUNWsymon .

# groups:files nis

# ls
Copyright   FR_Copyright     Sol_2.5.1    Sol_7
Docs        INSTALL.README   Sol_2.6      inst-es   windows

# cd / download_directory
# inst-es
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Note – The installation process installs the Sun Enterprise SyMON packages

(including any applicable add-on component) for your system. In some cases, user

confirmation is required prior to installing an add-on component. Refer to the

supplement for more information.

Installing Separately Released Add-on

Components

If you have separately released add-on components you want to install, refer to the

supplement for installation information.

Sun Enterprise SyMON Directories

After a successful installation and setup, the following directories are created.

Sun Enterprise SyMON Online Help

The Sun Enterprise SyMON online help, based on the Sun Enterprise SyMON 2.0.1
User’s Guide, is designed to be a quick reference. Once your software installation is

complete, you may use your browser to view the English online help files in the

/opt/SUNWsymon/lib/locale/C/help directory, where C represents the English

version. Refer to the Sun Enterprise SyMON online help for detailed information

about windows or procedures.

TABLE 3-1 Sun Enterprise SyMON Directories

Directory Description

/opt/SUNWsymon Root directory or softlink directory which contains the

infrastructure and applications of Sun Enterprise SyMON

/etc/opt/SUNWsymon Contains the init scripts for Sun Enterprise SyMON

software applications

/var/opt/SUNWsymon Contains the Sun Enterprise SyMON configuration files for

your system
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For heterogeneous console installations (that is, an environment which has the Sun

Enterprise SyMON console component layer installed on both Solaris operating

environment workstations and personal computers [PCs]), the Sun Enterprise

SyMON help file Uniform Resource Locator (URL) should be of the type http:// .

The console component layer for PCs does not include the online help packages.

Instead, the httpd daemon should be installed on the Sun Enterprise SyMON help

server where the help packages are loaded.

This help server has the Sun Enterprise SyMON help packages installed and is

http-accessible. All consoles can connect to this help server for online help.

Installing Online Help

Note – Complete the following procedure only if you are installing Sun Enterprise

SyMON online help on a remote machine (not on your console host) or if you are

running the Sun Enterprise SyMON console on a PC.

The following procedure sets up a Sun Enterprise SyMON help server so that the

online help package is web-accessible.

▼ To Set Up Sun Enterprise SyMON Online Help

on a Remote Machine

1. If it has not already been installed, install the httpd daemon on the Sun
Enterprise SyMON help server.

2. Modify the /etc/http/httpd.conf file to specify doc_root as
/opt/SUNWsymon/lib/locale/C/help , where C represents the English version.
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For example:

3. Start the httpd daemon on the Sun Enterprise SyMON help server.

4. During the installation and set up of your Sun Enterprise SyMON server
component layer, specify the base URL for Sun Enterprise SyMON online help.

Caution – Do not click Return. Instead, type http://< online-help-server-host>.

Note – The word “local” in the last line of the above message refers to the console,

not a local server.

# Host Parameters
url {
doc_root           " /opt/SUNWsymon/lib/locale/C/help "
user_doc_enable"yes"
  user_doc_root"public_html"
  cgi_enable"yes"
  cgi_dns_enable"no"
  cgi_suffix_enable"no"
  cgi_user"nobody"
  log_type"clf"
  log_prefix"/var/http/logs/http"
  log_max_files7# number of log files
  log_cycle_time1440# minutes i.e. 1 day
  log_max_file_size1048576# bytes i.e. 1 MB
  ssi_enable"no"
  ssi_exec"no"
}

The SyMON base URL is relative to the SyMON Console. The SyMON
Console is able to request help documentation via the network. If
you have installed SyMON help documentation in an http-accessible
location within your network, you may specify this location. If
SyMON help is installed on the console host, simply accept the
default value.
Please enter base URL to SyMON help [local]:
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Setting Up Sun Enterprise SyMON
Component Layers

Complete the following procedure:

■ when you change your setup configuration, such as changing the server context

■ when asked to do so in your supplement

(If your installation was unsuccessful, see “Uninstalling the Sun Enterprise SyMON

Software” on page 24.)

Note – You may also need to complete the following procedure when you change

your setup configuration, such as changing the server context or changing the

security seed, after you have successfully installed the software. For more

information, see “Sun Enterprise SyMON Remote Server Access” on page 287 and

“Security Seeds” on page 38.

Note – If there is a potential conflict for port addresses, see “Configuring Sun

Enterprise SyMON Software to Use Different Port Addresses” on page 306 before

completing the steps in this section.

▼ To Set Up Sun Enterprise SyMON Component

Layers

1. Open a command window and, if you are not already root, become root .

2. Change to the directory that contains the Sun Enterprise SyMON setup script by
typing the following command:

3. Run the setup script to set up the component layers.

# cd /opt/SUNWsymon/sbin

# ./es-setup
Chapter 3 Installing the Sun Enterprise SyMON 2.0.1 Software 37



4. The setup script finds the installed component layers on your system with set up
requirements and enables you to select the components to set up. A set of
questions guides you through the setup procedures.

Note – See the supplement for more information about set up of add-on

components.

Sun Enterprise SyMON Groups

Sun Enterprise SyMON assigns users to groups. Three groups are created by default

during the installation process. They are:

■ esops

■ esadm

■ esdomadm

See “Access Control (ACL) Categories” on page 282 in Chapter 15 for more

information.

Security Seeds

Sun Enterprise SyMON software generates a security key used for communications

between processes. A seed (or password) must be provided to initialize the keys.

You can choose your own seed, an alphanumeric string of up to eight characters, or

use the standard Sun Enterprise SyMON default (maplesyr) . Here is the prompt

from the setup script:

The seed can be changed at a later time using the procedure described in “Setting

Up Sun Enterprise SyMON Component Layers” on page 37. Also see “Regenerating

Security Keys” on page 301 for more information.

Do you want to generate these keys using the SyMON default seed?
[y|n|q]
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Note – If you choose to enter a seed of your own rather than accept the default, be

sure to keep a record of the seed for use at a later time.

Sun Enterprise SyMON Licensing

Sun Enterprise SyMON software is free-of-charge to manage or monitor an

individual object or host.

The software creates a default domain consisting of one managed object, the host

where the Sun Enterprise SyMON server resides. You may manually configure the

software to change the managed host to another system; however, this is the limit of

free-of-charge use.

A Sun Enterprise SyMON right-to-use license is required to create more than one

domain and to manage or monitor more than one host object. If you do not purchase

a license, you will be operating in violation of your license agreement. For

information on purchasing a license, see the web site, http://www.sun.com/
symon/ .

If you exceed the allowed number of objects, or if you exceed the time period

allowed for your demonstration license, a message is displayed during login, to alert

you that you have exceeded the limits of your license.

If you have exceeded your license limit, contact your Sun service representative or

authorized Sun service provider for more information.

During the setup of the server component, you are given the opportunity to specify

a license token.

■ If you have a license token, you may enter it during setup.

--------------------------------------
      Exceed License Limit!!!
      Authenticated: XXX
      Used:  YYY

      Invalid licenses!!
      Error(s) occurs in your license(s)
      Please verify your license(s)
      -------------------------------------
Chapter 3 Installing the Sun Enterprise SyMON 2.0.1 Software 39



■ If you do not have a license token, you may run the software without one as

described above. When you get a license token, you can install it using the

es-lic script.

Sun Enterprise SyMON Users

Sun Enterprise SyMON users are valid UNIX users on the Sun Enterprise SyMON

server. As such, the system administrator has to add valid users into the following

file; /var/opt/SUNWsymon/cfg/esusers.

If a user’s name is not in this file, that user cannot log into Sun Enterprise SyMON

software. (See the following section for more information.)

Public and Private Users

During the Sun Enterprise SyMON server setup, the file /var/opt/SUNWsymon/
cfg/esusers is created and the following users are added to the file automatically:

■ espublic
espublic is comparable to logging into a UNIX system as guest . It enables

users to have “general” privileges. For example, when a user tries to access

information from a session running in a different Sun Enterprise SyMON server

from their own, they are given access as espublic and are able to view the

information as a guest only.

■ esmaster
esmaster is comparable to being superuser in UNIX. It automatically gives

“admin” access privileges to users logging into the software.

# cd /opt/SUNWsymon/sbin
# ./es-lic

  --------------------------------
  Enterprise SyMON License Program
  --------------------------------

Please enter license key:
#
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The administrator has to add the additional list of user IDs for all other users who

need to log into Sun Enterprise SyMON software. All users in this file have

“general” access privileges, by default, unless they are given additional privileges

using the procedures described in “Using Access Control (ACL)” on page 289.

Note – The user names espublic and esmaster are not configurable during

installation. They must specifically be defined as espublic and esmaster .

▼ To Add Sun Enterprise SyMON Users

1. Become superuser (on the Sun Enterprise SyMON server host).

2. Edit the file /var/opt/SUNWsymon/cfg/esusers . Make sure that the user name
is that of a valid UNIX user.

3. Add the user name on a new line.

4. Save the file and exit the editor.

Note – By adding a user to the users list, the user has default privileges. See

“Default Privileges” on page 295 and “Overriding the Default Privileges” on

page 296 for more information.

For more information on setting up users, see Chapter 15.

▼ To Grant a User esadm, esops , or esdomadm
Privileges

1. Become superuser.

2. Make sure that the user is a valid Sun Enterprise SyMON user.

You may do this by adding the user to the /var/opt/SUNWsymon/cfg/esusers
file.

3. Edit the /etc/group file.

4. Add the user to one of the following lines as applicable: esadm, esops , or
esdomadm.

5. Save the file and exit the editor.
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Starting the Sun Enterprise SyMON
Software

Sun Enterprise SyMON components are started with the es-start utility. The

syntax for this utility is:

Note – The Sun Enterprise SyMON processes are generally started in the

background unless you specify the -i option (valid for only one process in the

interactive mode). The console process is run in the foreground so it can be killed

easily using Control-C.

The choices for option(s) are listed in TABLE 3-2.

# /opt/SUNWsymon/sbin/es-start  - option(s)

TABLE 3-2 Options for es-start Choices

Option Definition

a Starts agent

c Starts console

e Starts Event manager

f Starts Configuration manager

h Lists the options for the es-start utility

i Starts agent in interactive mode; valid only for one of the a, t,
f, l, p, and e options

l Starts Platform agent

p Starts Topology manager

s Starts server

t Starts Trap handler

A Starts all components except the console. Equivalent to es-start
-aefpst

S Starts server and all the server subcomponents. Equivalent to

es-start -efpst
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For example, to start the agents and server, use the es-start -A option. To start

the agent on a monitored host, use the es-start -a option.

Note – You must be root to start any of the Sun Enterprise SyMON components

except the console.

If you need to pass any arguments to the processes being started, you can do so by

listing those arguments after these options. For example, if you wanted to start the

console and tell it to use port 2090, you would use this command.

Here are the commonly used start commands:

After starting other processes, there may be a delay of several seconds before the

console is able to respond.

Note – You can start more than one process at a time. For example, to start both the

console and the server + agent, enter es-start -Ac .

▼ To Start the Sun Enterprise SyMON Software

1. Change directory to the /opt/SUNWsymon/sbin directory.

# es-start -c -- -p 2090

TABLE 3-3 Common Start Commands

To start: Command

Server-only es-start -S

Agent-only es-start -a

Server + agent es-start -A

Console es-start -c

# cd /opt/SUNWsymon/sbin
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2. If applicable, start the Sun Enterprise SyMON server by typing:

3. If applicable, start the Sun Enterprise SyMON agent by typing:

4. Type es-start -c at the prompt to start the console.

# ./es-start -S

# ./es-start -a

# ./es-start -c
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Note – You do not have to be root to run the Sun Enterprise SyMON console.

The Sun Enterprise SyMON login panel (FIGURE 3-1) is displayed. See TABLE 3-4 for

more information on the login panel buttons.

FIGURE 3-1 Sun Enterprise SyMON Login Panel

TABLE 3-4 lists the buttons in the login panel and their corresponding functions.

5. Log in using a valid UNIX user account. This account must be listed in the
/var/opt/SUNWsymon/cfg/esusers file in the Sun Enterprise SyMON server
machine.

Note – The user accounts, espublic and esmaster , should not be used.

6. Type the host name of the Sun Enterprise SyMON server in the Server Host field.

7. If you are not using the Sun Enterprise SyMON server default port addresses or
want to set the console to Sun Enterprise SyMON server message security:

TABLE 3-4 Sun Enterprise SyMON Login Panel Buttons

Button Function

Login Enables users to open the Sun Enterprise SyMON application.

Help Displays the online help for this panel.

Options Displays a dialog box which enables you to specify the port number of the

Sun Enterprise SyMON server and the security scheme for console to Sun

Enterprise SyMON server messages.

Exit Exits the software.
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a. Click the Options button.

b. Type the Sun Enterprise SyMON server RMI host port number in the Server
Port Number field.

See “To Reconfigure Sun Enterprise SyMON RMI Port Address” on page 308 for

more information.

c. Click the circle next to the appropriate security message option (FIGURE 3-2).

FIGURE 3-2 Sun Enterprise SyMON Login Options Dialog

These options allow you to choose among the following:

■ No Message Authentication: If you select this, only the user login is

authenticated. Messages between the console and the server are not verified for

authentication.

■ Console-to-Server Message Authentication: If you select this, the server verifies

the authenticity of the messages coming from the console. However, the

console does not verify the messages from the server.

■ Console-Server-Console Message Authentication: If you select this, both the

console and the server authenticate the messages coming from the other.

d. Click the OK button.

8. Check that you typed in all the information correctly in the Sun Enterprise
SyMON Login window (FIGURE 3-1).
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9. Click the Login button in the Sun Enterprise SyMON Login window to log into
the Sun Enterprise SyMON console.

The message is displayed on the Current status line:

“Login successful. Launching console. ”

The main console window is displayed (FIGURE 3-3).

Note – You may see a warning dialog box before the main console window is

displayed if: the console software version does not match the server version, or you

have exceeded the limits of your license.

FIGURE 3-3 Sun Enterprise SyMON Main Console Window

Exiting and Stopping the Sun Enterprise
SyMON Software

You exit the console through the main console window, and the server and agent

components through a shell window.

Sun Enterprise SyMON server and agent components are stopped with the es-stop
utility. The syntax is:

# /opt/SUNWsymon/sbin/es-stop  - option(s)
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The choices for option(s) are listed in TABLE 3-5.

Note – You must be root to stop the Sun Enterprise SyMON server and agents.

▼ To Exit the Sun Enterprise SyMON Console

1. Select File ➤ Exit from the menu bar on the main console window.

The Exit Sun Enterprise SyMON dialog is displayed (FIGURE 3-4).

2. Click the Exit button to exit the application or the Cancel button to cancel your
request.

FIGURE 3-4 Exit Sun Enterprise SyMON Dialog

TABLE 3-5 Options for es-stop Choices

Option Definition

a Stops the agent

e Stops the Event manager

f Stops the Configuration manager

h Lists the options for the es-stop utility

l Stops the Platform agent

p Stops the Topology manager

s Stops the server

t Stops the Trap handler

A Stops all the components except the console

S Stops the server and all the server subcomponents (Trap handler,

Topology manager, Configuration manager, and Event manager)
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▼ To Stop the Sun Enterprise SyMON Server and

Agents

● Stop the Sun Enterprise SyMON agents and the server subcomponents by typing:

# /opt/SUNWsymon/sbin/es-stop -A
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CHAPTER 4

Using Sun Enterprise SyMON
Administrative Domains

A Sun Enterprise SyMON administrative domain is an arbitrary collection of

resources that can include a complete campus, individual buildings, hosts, networks,

subnets, links, and so on. The organization of a domain collection is in a hierarchy.

Note – In this document, “domain” refers to a Sun Enterprise SyMON

administrative domain, and should not be confused with other uses of the term

“domain” related to other Sun products or documentation.

This chapter covers the following topics:

■ To Set a Home Domain

■ To Select Domain Manager

■ To Create Domains

■ Populating Domains

■ To Select a Domain

■ To Delete a Domain

■ To Set a Remote Domain

■ To Set Security for a Domain

Sun Enterprise SyMON software can monitor a multitude of hosts. To enable you to

perform your monitoring tasks in an efficient manner, Sun Enterprise SyMON

software organizes hosts into groups. The biggest (highest level) grouping is a

domain. A domain is an arbitrary grouping of hosts, subnets, networks, buildings,

and so on.

You can create one or multiple domains, each with an unique name. Each domain

consists of one or more members, arranged in a hierarchy. For example, you may

decide that a domain consists of all the hosts in one building. Or, you may decide

that a domain consists of all the hosts in a campus.
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Note – Spend some time and think about how you want to organize your hosts into

different domains.

Decide if you need additional groups below the domain to organize your hosts. For

example, if there are several hundred hosts, it is impractical to place your hosts

individually in one domain.

You may decide to break the domain into a set of smaller groups; for example,

campuses. The Headquarters domain might consist of several campus locations

(FIGURE 4-1).

FIGURE 4-1 Example Domain

Each of these campus locations may be broken into smaller groups; for example,

buildings. Similarly, each building may be broken into smaller groups; for example,

networks, subnets, and groups. Finally, each group comprises individual hosts.

In this particular example, the hierarchical order, from highest level to lowest level,

is domain, campus, building, network, subnet, group, and individual host. For

detailed information on creating domains, see “To Create Domains” on page 58.
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Starting Sun Enterprise SyMON
Software

When starting the software for the first time, a dialog is displayed (FIGURE 4-2)

prompting you to set a home domain. The home domain is the domain that is

displayed whenever the console is started.

FIGURE 4-2 Set Home Domain Dialog

During installation, a default domain (named after your server host) is automatically

created for you.

● Proceed with one of the following:

■ Select the default domain and click on the Set Home button. Your default domain

is set as your home domain and is displayed. For more information, see “To Set a

Home Domain” on page 54.

■ Select the default domain and click on the Go To button. The main console

window is displayed with this default domain.

The default domain consists of one object, your server host.

■ If you want to explore the main console window, see Chapter 7.

■ If you want to explore monitoring features, see Chapter 8.
Chapter 4 Using Sun Enterprise SyMON Administrative Domains 53



■ If you want to create additional domains, see “To Create Domains” on page 58.

■ If you want to create additional objects in your domain, see “Populating

Domains” on page 58.

▼ To Set a Home Domain

1. Proceed with one of the following:

■ Click the Set Home button (FIGURE 4-2) in the Set Home Domain dialog.

■ Select File ➤ Set Home Domain in the Sun Enterprise SyMON main console

window (FIGURE 4-3).

FIGURE 4-3 Sun Enterprise SyMON File Menu

The Set Home Domain dialog (FIGURE 4-4) is displayed.

File menu
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FIGURE 4-4 Set Home Domain Dialog

2. Select the domain you want to set as your home domain.

The selected domain is highlighted.

3. Click the Set Home button.

You see the following message at the bottom of the Set Home Domain dialog.

When the home domain has been set, the message changes.

4. Click the Close button.

The main console window is updated and the home domain is displayed

(FIGURE 4-5).

At this time, you may want to populate your domain. See “Populating Domains” on

page 58 for more information.

Setting Home Domain...Please wait

Home domain successfully set.
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FIGURE 4-5 Home Domain

Creating Domains

The Sun Enterprise SyMON software enables you to create domains with the

Domain manager window.

▼ To Select Domain Manager

● In the main console window, select File ➤ Domain Manager (FIGURE 4-3).

The Domain Manager is displayed (FIGURE 4-6).
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FIGURE 4-6 Domain Manager

Note – In the Domain Manager, some of the buttons are grayed out until you select

a domain.

TABLE 4-1 Domain Manager Buttons

Button Description

Add Displays the Create Domain dialog.

Security Displays the Attribute Editor with the security tab selected for the

highlighted domain.

Delete Deletes the selected domain and all its members.

Go To Updates the main console window to display the selected domain.

You may also “go to” a domain by double-clicking on it.

Reference Inserts the selected domain into the current domain.

Set Home Domain Sets the selected domain as the domain that is always displayed

whenever the console is started. See “To Set a Home Domain” on

page 54 for more information.
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▼ To Create Domains

1. Select File ➤ Domain Manager (FIGURE 4-3) from the main console window.

The Domain Manager is displayed (FIGURE 4-6).

2. In the Domain Manager, click the left mouse button on Add.

The Create Domain dialog is displayed (FIGURE 4-7).

FIGURE 4-7 Create Domain Dialog

3. Type in the name of the new domain in the Domain Name field.

4. If you do not want your domain populated now, be sure the Populate Now check
box is turned off.

The default choice is for Sun Enterprise SyMON software to display a dialog

enabling you to start the Discovery Manager immediately after creating a domain.

For more information about the Discovery Manager, see Chapter 6.

5. Click the Create button.

6. Create additional domains or populate your domain manually.

If you do not have the right security permissions to create a domain, an error

message is displayed. See Chapter 15 for more information on security.

Populating Domains

Once you have created your domain(s), you can begin to populate these domains

(and their subordinate groups). There are three methods to add hosts and other

resources to a domain collection:

■ Populate with the Discovery Manager—see Chapter 6. Discovery Manager

searches the network for resources. This is the default method for populating a

newly created domain. The search can be time-consuming, but you can shorten

the search by setting limits.
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■ Populate with the Discovery Manager at scheduled intervals by using the

Scheduling feature—see “Starting the Discovery Requests Window” on page 98.

You can set the search to occur hourly, daily, weekly, or monthly. This feature

enables you to search periodically for new managed objects on the network.

■ Manually populate with the Create an Object menu—see Chapter 5. This method

enables you to add objects one at a time and is useful for adding a small number

of known resources. For example, if you have installed a new host, you can use

Create an Object to add the host to the local domain immediately.

Managing Domains

Once you have created domains, you can manage them.

Selecting Domains

You can list domains through the Domain Manager window (FIGURE 4-6) or the Sun

Enterprise SyMON main console window.

▼ To Select a Domain

1. Proceed with one of the following:

■ Select File ➤ Domain Manager in the main console window (FIGURE 4-3).

■ In the main console window, click the left mouse button on the SyMON

Administrative Domains pull-down menu (FIGURE 4-8).

The current list of domains is displayed.
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FIGURE 4-8 Sun Enterprise SyMON Main Console Window with a List of Current
Domains

2. Click the left mouse button on the domain you want to view.

The main console window is updated and displays the selected domain. The

SyMON Administrative Domains button changes to display the name of the domain

you have selected.

Deleting Domains

You must have the appropriate security permission to delete a domain. For more

information on Sun Enterprise SyMON security, see Chapter 15.

▼ To Delete a Domain

Caution – Deleting a domain also deletes all the members of that domain.

1. In the Domain Manager window, highlight the name of the domain you want to
delete.

2. Click the Delete button.

The Confirm Domain Deletion dialog (FIGURE 4-9 or FIGURE 4-10) is displayed.
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FIGURE 4-9 Confirm Domain Deletion Dialog

FIGURE 4-10 Confirm Domain Deletion Dialog for Current Domain
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3. Click Delete.

The Confirm Domain Deletion dialog displays the following message.

When the domain has been successfully deleted, the dialog is removed and the

Domain Manager updates the list of domains.

4. Click the Close button in the Domain Manager.

Monitoring Remote Domains

Remote domains are domains created in a different Sun Enterprise SyMON server

context. See Chapter 15 for a description of server context.

If you are interested in an object in a different server context, you can still monitor
the remote resource by referencing the remote domain in your local domain.

However, you are not able to manage the remote resource unless you log out of your

current Sun Enterprise SyMON server context and log into the remote server

context. You can manage monitored properties on a resource only if the agent on that

resource sends event management information to the server to which your console is

connected. By default, Sun Enterprise SyMON security gives you “read-only”

privileges for remote domains. For more information on security, see Chapter 15.

Note – You can reference a remote domain to monitor resources in that domain. You

cannot manage monitored properties on a remote resource.

For example, your current Sun Enterprise SyMON server context may be based in

the Headquarters domain. A second, remote Sun Enterprise SyMON server context

may be based in Regional Office 1. When workers are absent from Regional Office 1,

system administrators in Headquarters can monitor the regional office domains by

referencing these remote domains in the Headquarters server context. If an

emergency occurs, administrators in Headquarters can notify a Regional Office 1

administrator immediately.

Note – Remote domains enable you to monitor critical resources continuously.

Deleting domain...Please wait.
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Here is an example of how remote monitoring works. In the following figure,

Domain A is monitoring objects 1 and 2 (which are assigned to Domain A) as well as

remotely monitoring objects 3 and 4, which are assigned to Domain B. Note that

Domain A cannot monitor objects 3 or 4 without going through remote Domain B.

FIGURE 4-11 Remote Domain

Caution – Do not create a domain with a circular reference (to itself).

For example, do not create a domain (Domain A) which references another domain

(Domain B) which in turn, contains a reference to Domain A.)

FIGURE 4-12 Remote Domain - Circular Domain Reference

If it is necessary for the two domains to monitor each other, to avoid creating a

circular domain reference, create a domain member (for example, a group) under

domains A and B as shown below.

Domain A Domain B

Object 1 Object 2 Object 4Object 3

Domain A Domain B

Object 1 Object 2 Object 4Object 3
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FIGURE 4-13 Remote Domains - Setting Up for Successful Cross-Monitoring

Now when making a remote reference, Domain A can reference Group 2 under

Domain B, while Domain B can reference Group 1 under Domain A.

▼ To Set a Remote Domain

1. In the main console window, select File ➤ Remote Domain Manager (FIGURE 4-3).

The Remote Domain Manager dialog is displayed (FIGURE 4-14).

Domain A Domain B

Object 1 Object 2 Object 4Object 3

Group 1 Group 2
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FIGURE 4-14 Remote Domain Manager

2. Type the name of the remote server in the Host field. If applicable, also type the
appropriate number in the Port field.

By default, the Topology manager is installed on the server on port 164.

3. Click the List Domains button.

A list of domains on the remote server is displayed.

4. Click the domain you want to reference.

The selected domain is highlighted.

5. Click the Reference button.

The selected domain is created as a reference domain in the currently selected

domain in the main console window (FIGURE 4-15).
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FIGURE 4-15 Referencing a Remote Domain

Attribute Editor for a Domain

The domain Attribute Editor provides additional information about the selected

domain and the rules governing its behavior. Use the Attribute Editor to edit

security information for the domain.

Note – Each Attribute Editor displays one or more tab buttons, depending on the

type of Attribute Editor. The Attribute Editor that is displayed is dependent on the

selected object.

▼ To Set Security for a Domain

1. Proceed with one of the following:

■ Open the Attribute Editor for a domain by clicking the right mouse button on the

domain icon and highlight Attribute Editor from the pop-up menu in the

hierarchy view.
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■ Select File ➤ Domain Manager in the main console window. Then select a domain

and click the Security button.

2. If not already selected, click the Security tab (FIGURE 4-16).

3. Type the name(s) of user and administrator groups in the appropriate fields.

See Chapter 15 for more information.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 4-16 Attribute Editor for a Domain
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CHAPTER 5

Objects

This chapter describes how to create and monitor objects.

This chapter discusses how:

■ To Create a Node

■ To Create a Module Object

■ To Create a Group

■ To Create a Composite Object

■ To Create a Segment

■ To Connect Objects

■ To Copy an Object

■ To Copy a Group of Objects

■ To Modify an Object

■ To Cut and Paste Objects

■ To Delete Objects

Sun Enterprise SyMON objects represent parts (or nodes) of a network and include

hardware and software components such as hosts (workstations and servers),

printers, routers, modules, and so on. A segment of the network itself can even be an

object.

Note – For additional information, refer to your supplement. The supplement

contains important hardware-specific information about creating an object.

To monitor or manage an object, you create a node to represent it in a domain or

group. If the group does not yet exist, you must first create the group.

You can create and monitor or manage one or more domains containing nodes for

multiple objects (such as the workstations and other devices connected to the

server). For information about domains, see Chapter 4.
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Creating a Node

You create nodes through the Edit pull-down menu in the main console window.

▼ To Create a Node

Note – A domain must exist before you can create a node. To create a domain, see

“To Create Domains” on page 58.

1. In the hierarchy view of the main console window, select the domain in which
you want to create the new object.

Select the lowest level group of the domain where the new object should be created.

For example, if you want to create a node in a building that is in one of the

campuses of a domain, then select the building in the domain as the lowest level

group.

2. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).

The Create Topology Object window is displayed. By default the tab is set to Node

(FIGURE 5-1).
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FIGURE 5-1 Create Topology Object Window—Node Tab
Chapter 5 Objects 71



3. In the upper half of the Create Topology Object menu, set up the new node:

a. Click the Monitor Via button to see the pull-down menu, then select the
software or agent to monitor the new node.

There are seven categories of agents and monitors (TABLE 5-1). If an agent is not

available for your selected object, SNMP Ping usually works. If you do not select

an available agent or ping command, the creation fails.

TABLE 5-1 Types of Sun Enterprise SyMON Monitoring

Type Description Effect

Agent – Host Monitor and manage a host that has an

active agent that is installed and

running.

The status of the agent on the host can be

monitored. The Details window of the Sun

Enterprise SyMON agent host contains tabs

such as Info, Browser, Alarms, and so forth. The

Entity Polling Type in the Info tab is ahost .

Agent –

Module

Monitor and manage a module that has

an active Sun Enterprise SyMON agent

that is installed and running.

The status of the Sun Enterprise SyMON

Module on the agent host can be monitored. The

Details window contains Info and Browser tabs.

The Entity Polling Type in the Info tab is amod.

Agent -

Platform

For more information, see your

supplement.

SNMP Proxy Monitor and manage the device through

a Sun Enterprise SyMON agent that is

running a Sun Enterprise SyMON proxy

module for that device. (The proxy

module must have been previously

loaded into the agent by using the Load

Module dialog. See Chapter 12.)

Communication between the Sun

Enterprise SyMON Topology manager

and the agent is SNMPv2 usec.

Communication between the Sun

Enterprise SyMON agent and the remote

device is SNMPv1 or SNMPv2,

depending on the proxy module.

The Proxy Monitoring module data can be seen.

The Details window contains the Info and

Browser tabs. The Entity Polling Type in the

Info tab is aprox .
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b. If applicable, select a type from the pull-down menu in the Type field.

The list of choices varies widely according to the type of monitoring you selected

in the previous step.

Note – For information about creating an object for your specific platform, see the

supplement.

c. If applicable, scroll and select an object in the Create Topology Object window.

For some types of monitoring, the right side of the Create Topology Object

window displays the set of icons for the object you have selected. The icons are

displayed in the hierarchy and topology views in the main console window when

the node is created.

d. (Optional) Create a unique new name in the Node Label field.

SNMP Ping Monitor the device by using SNMP ping
command. The Sun Enterprise SyMON

Topology manager communicates with

the device using SNMPv1. (There are no

management capabilities provided for

devices monitored by the SNMP ping
command.)

The availability of the SNMP agent on the

device can be monitored. The Details window

contains only the Info tab. The Entity Polling

Type in the Info tab is snmp.

ICMP Ping Monitor the device by using the Internet

Control Message Protocol (ICMP) ping
command. (There are no management

capabilities provided for devices

monitored by the ICMP ping
command.)

The accessibility of the device can be monitored.

The Details window contains only the Info tab.

The Entity Polling Type in the Info tab is ping .

Non-Monitored Created node is for display only. Its

status is not monitored.

No aspects of the device are monitored. The

Details window contains only the Info tab. The

Entity Polling Type in the Info tab is dummy.

TABLE 5-2 Choices Available in the Type Pull-Down Menu

Monitor by Agent - Host Agent - Module SNMP Proxy SNMP Ping ICMP Ping Non-monitored

Type Workstation,

Server,

Local Module Router,

Concentrator,

Workstation,

Printer,

PC,

Server

Router,

Concentrator,

Workstation,

Printer,

PC,

Server

Router,

Concentrator,

Workstation,

PC,

Server

Printer,

Workstation,

Router,

Concentrator,

Server,

PC

TABLE 5-1 Types of Sun Enterprise SyMON Monitoring (Continued)

Type Description Effect
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e. (Optional) Type a description of the node.

4. In the lower half of the Create Topology Object window, type the requested
information.

The questions in the lower half of the window vary with the agent or monitor that

you selected in Step 4a, above. The Non-Monitored selection does not require further

information, but most agent or monitor selections ask you to enter:

■ Node host name

■ Node IP address

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

Other agent or monitor selections may also ask for one or more of the following:

■ Sun Enterprise SyMON agent port number (the default is 161)

■ Proxy host name and IP address

■ Read/write SNMP communities

■ Module name

5. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

■ If the request is completed successfully, the main console window is updated and

the new node is displayed.

■ If the creation fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have

permission to create this node, or that you must start a Sun Enterprise SyMON

agent on the node.

Note – If you are connected to one Sun Enterprise SyMON server context and create

a node on another Sun Enterprise SyMON server context, ownership of the new

node on the second server context defaults to the espublic identity instead of your

login identity. This situation is normal. The espublic identity is imposed for

security of transactions between Sun Enterprise SyMON server contexts. For more

information, see “Sun Enterprise SyMON Remote Server Access” on page 287.

If you want to make any changes to the new node, see “Modifying Objects” on

page 89.

Creating Node... Please Wait.
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Creating a Monitored Module Object

If you want to monitor one or more module objects on a number of hosts, you may

find it useful to create module objects for each host and place all of the modules in a

common location (that is, in the same group or domain). The procedure for creating

a module object is similar to that for creating a node.

▼ To Create a Module Object

1. In the hierarchy view of the main console window, select the domain in which
you want to create the new object.

2. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).

3. Select the Node tab in the Create Topology Object window.

4. Select SyMON Agent – Module in the Monitor Via field (FIGURE 5-2).
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FIGURE 5-2 Create Topology Object Window for SyMON Agent – Module

5. (Optional) Type a node label.

6. (Optional) Type a description.

7. Type a host name or IP address.

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

8. If necessary, change the port number.
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9. Click the List Modules button to display a list of modules that are currently
loaded on the host.

If the module that you want to use is not loaded, see “To Load a Module” on

page 212. If the module that you want to use is not enabled, see “To Enable a

Module” on page 224.

The module list is displayed (FIGURE 5-3).

FIGURE 5-3 Module List

10. Select the module that you want to monitor and click OK.

The module list closes.

11. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.
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Creating Groups

You can create two types of groups, General and IP-based. General groups are based

on geography (campus or building). IP-based groups are based on networks or

subnets.

▼ To Create a Group

1. In the hierarchy view of the main console window, click the domain in which you
want the new group.

Select (by clicking) a location in the domain where the new group should be created.

For example, if you want to create a group in a building that is in one of the

campuses of a domain, then click the building icon in the domain.

2. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).

FIGURE 5-4 Creating an Object

The Create Topology Object window is displayed.
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FIGURE 5-5 Creating a Group in the Create Topology Object Window

3. In the Create Topology Object window:

a. Click the Group tab (FIGURE 5-5).

b. Change the Type field, if desired (General or IP-Based).

c. Select the object type (Building, Campus, or General).

The right side of the window is updated with an icon corresponding to the object

type.

d. Create a new group Label.
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e. (Optional) Type a description in the optional Description field.

f. For an IP-based group, specify the IP address and the subnet mask.

Note – The creation of an IP-based group results in the creation of an empty

network or subnet “container” which you can populate using the Create Topology

Object window.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

If you selected OK or Apply, this message is displayed at the bottom of the Create

Topology Object window:

If the request ends successfully, the main console window is updated and the group

is displayed.

If the request fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have the

right permission to create this group.

If you want to make any changes to the new group, see “Modifying Objects” on

page 89.

5. Add components to your group:

■ Use the Create Topology Object window. See “To Create a Node” on page 70.

■ Copy and paste objects from other groups into the new group. See “Copying

Objects” on page 87.

Creating a Composite Object

You create composite objects through the Edit pull-down menu in the Create

Topology Object window.

Creating group... Please Wait.
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▼ To Create a Composite Object

1. In the hierarchy view of the main console window, select the Sun Enterprise
SyMON domain in which you want to create the new composite object.

Select the lowest level group of the domain where the new composite object should

be created.

2. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).

The Create Topology Object window is displayed. By default the tab is set to Node.

3. Click the Composite tab in the Create Topology Object window.

The window changes to display settings available for composite objects (FIGURE 5-6).
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FIGURE 5-6 Create Topology Object Window—Composite Tab

4. Select an object in the Create Topology Object window.

For some types of monitoring, the right side of the Create Topology Object window

displays the set of icons for the object you have selected. The icons are displayed in

the hierarchy and topology views in the main console window when the composite

object is created.

5. Create a unique new name in the Label field.

6. (Optional) Type a description of the node.
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7. In the lower half of the Create Topology Object window, type the requested
information.

■ SSP Hostname

■ SSP IP Address

■ Sun Enterprise SyMON agent port number (the default is 161)

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

8. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

■ If the request is completed successfully, the main console window is updated and

the new composite object is displayed.

■ If the creation fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have the

permission to create this object, or that you must start a Sun Enterprise SyMON

agent on the object.

Note – If you are connected to one Sun Enterprise SyMON server context and create

an object on another Sun Enterprise SyMON server context, ownership of the new

object on the second server context defaults to the espublic identity instead of

your login identity. This situation is normal. The espublic identity is imposed for

security of transactions between Sun Enterprise SyMON server contexts. For more

information, see “Sun Enterprise SyMON Remote Server Access” on page 287.

If you want to make any changes to the new object, see “Modifying Objects” on

page 89.

Creating Composite Object... Please Wait.
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Creating Segments

To complete your view of a domain, you can include segments of the networks

linking the nodes in the domain.

▼ To Create a Segment

1. In the main console window:

a. In the left window, select a location in the domain where the new segment
should be created.

The segment is created at the selected (highlighted) level.

For example, if you want to create a segment in a building that is in one of the

campuses of a domain, then select the building in the domain.

b. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).

The Create Topology Object window is displayed (FIGURE 5-1).

2. In the Create Topology Object window:

a. Click the Segment tab (FIGURE 5-7).
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FIGURE 5-7 Segment Tab in the Create Topology Object Window

b. Change the Type field, if desired (Bus or Ring).

c. Select the object type.

The list of choices (Ethernet or IPX) changes with your selection in the Type field.

At the right in the Create Topology Object window is a window that displays

large and small icons corresponding to the type of object you have selected. The

icons are displayed in the topology view in the main console window when the

segment is created.

d. Type a new segment label.
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e. (Optional) Type a description in the Description field.

f. Type the IP address for this segment.

g. Type a subnet mask for this segment.

3. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

If the request is completed successfully, the Create Topology Object window closes.

The main console window is updated and the view is displayed.

If the request fails, an error message is displayed in the Create Topology Object

window.

If you want to make any changes to the new segment, see “Modifying Objects” on

page 89.

Connecting Objects

You can connect objects in the topology view.

▼ To Connect Objects

1. Select two objects in the topology view.

To select two objects, select the first object in the topology view. Hold down the Shift

key and click the second object using the mouse button.

2. Select Edit ➤ Create a Connection.

A link is displayed between the objects.

Creating segment... Please Wait
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Copying Objects

To move an object from one location in the topology view to another, use the Edit

commands, Cut and Paste .1 To copy an object into other topology views (leaving

the original object in its current location), use Copy instead of Cut .

For example, you can create a domain that contains some of the objects that already

exist in another domain. To do this, create a new domain (see Chapter 4), then copy

existing objects into the new domain as described in the following procedure.

You can also copy a group (an object that contains other objects). In this case, the

software does not create an independent, completely new group. Rather, it creates a

symbolic link to the existing group. Thus every copy is a different “view” of the same
group.

Note – You can select multiple objects by using the mouse button while holding

down the Shift key.

For more information on the main console window, see Chapter 7.

Note – The copy, cut, and paste functions are available in the topology view. The

copy and cut functions are also available in a pop-up window by clicking your right

mouse button on the object.

▼ To Copy an Object

This procedure is for a single object. To copy a group, see “To Copy a Group of

Objects” on page 88.

1. In the main console window, select the existing object in the topology view.

2. At the top of the main console window, select Edit ➤ Copy in the pull-down
menu.

This message is displayed at the bottom of the main console window:

1. Sun Enterprise SyMON 2.0.1 software does not support drag and release as an operation for moving objects.

Copy successful
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3. Open the destination group or domain.

The destination group is displayed in the topology view.

4. At the top of the main console window, select Edit ➤ Paste.

The pasted object is displayed in the destination group or domain, and this message

is displayed at the bottom of the main console window:

▼ To Copy a Group of Objects

To copy objects that are in one group and paste the copies into another group:

1. In the topology view, select the objects to be copied.

To copy all objects in the topology view, select Edit ➤ Select All in the main console

window menu bar.

To copy two or more objects selectively:

a. Click the first object to select it.

b. On the keyboard hold down the Shift key and click one or more additional
objects.

2. Select Edit ➤ Copy in the main console window menu bar.

When the objects are copied, this message is displayed at the bottom of the main

console window:

3. In the hierarchy view, select (highlight) the new group or domain where the group
is to be copied.

4. Select Edit ➤ Paste Into in the main console window menu bar.

Alternatively, you can click with your left mouse button on the destination domain

and select Paste Into from the pop-up menu.

Caution – If you select Edit ➤ Paste (instead of Edit ➤ Paste Into), the objects may

be pasted into the wrong group. If this occurs, highlight the duplicate objects and

select Edit ➤ Delete Object/Connection.

Paste successful

Copy Successful
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Caution – When you copy a group in the Sun Enterprise SyMON software, the new

copy (a symbolic link) is labelled with italic font. The italic font is a reminder that

this is a link. If you add or remove objects from this group, the original group and all

copies of the group are affected.

Note – An object in the cut (pre-move) state remains visible—and selected with

dashed lines—until it has been successfully pasted. If you change your mind and no

longer want to paste the object, you can remove it from the cut state by clicking on it

a second time.

Modifying Objects

Once you have created or copied an object, you can change the object through the

Modify Object window. The changes affect only the description of the object (in the

Sun Enterprise SyMON server database) and do not modify the object itself.

▼ To Modify an Object

1. Select the object in the main console window.

2. Select Edit ➤ Modify in the main console window.

The Modify Object window is displayed (FIGURE 5-8). (The appearance of the

window varies widely, depending on whether the object is a group, node, composite

object, or segment.) The following example shows how to modify a node.
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FIGURE 5-8 Modify Object Window—Example for a Node

3. Edit the characteristics as needed.

If you are modifying a group object, the available characteristics are:

■ Type: General or IP-Based

■ Object: Building, Campus, or General

■ Group Label

■ Description

■ IP Address (for IP-Based only)

■ Subnet Mask (for IP-Based only)

For a node, the available characteristics are:
90 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



■ Monitor Via: SyMON Agent - Host, SyMON Agent - Module,

SyMON Agent - Platform, SNMP Proxy, SNMP Ping, ICMP Ping, or

Non-Monitored

■ Node Label

■ Description

■ (Additional characteristics such as host name, IP address, or port may be listed,

depending on the type of node.)

For a segment, the available characteristics are:

■ Type: Bus or Ring

■ Object: Ethernet or IPX

■ Segment Label

■ Description

■ IP Address

■ Subnet Mask

For a composite object, the available characteristics are:

■ Object

■ Label

■ Description

■ SSP host name

■ SSP IP address

■ Port

See your supplement for more information.

4. Click OK to save your changes, or Cancel to leave the characteristics unchanged.
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Cutting and Pasting Objects

Objects can be cut (to be moved) or deleted (permanently) from the topology view in

the main console window. An object that is cut is temporarily saved in memory and

can be immediately pasted into one or more areas1. An object that is deleted cannot

be recalled. For instructions on deleting objects, see “Deleting Objects” on page 94.

For more information about the main console window, see Chapter 7.

Cut and paste functions work the same for all kinds of objects (hosts, modules, and

groups).

Caution – Do not use the cut function to delete objects. This function should only

be used to move objects. To delete an object, use Edit ➤ Delete in the main console

window. See “Deleting Objects” on page 94.

▼ To Cut and Paste Objects

1. Select an existing object in the topology view.

If you have not selected an object, the Cut and Delete functions are grayed out.

2. Select Edit ➤ Cut (FIGURE 5-9) in the main console window.

A dashed line is displayed around the selected object. (The object does not

immediately disappear. This allows objects, such as processes which should not be

interrupted, to continue running until they are pasted into a new location.) The

object remains visible until it has been successfully pasted.

Note – You can cancel a Cut operation by clicking on the object a second time.

1. Sun Enterprise SyMON 2.0.1 software does not support drag and release as an operation for moving objects.
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FIGURE 5-9 Cut, Copy, and Paste Options

When the Cut operation succeeds, this message is displayed at the bottom of the

main console window:

3. Navigate to the destination location in the topology view.

4. Select Edit ➤ Paste. The object is displayed in this location and is removed from
the previous location.

Cut successful
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Deleting Objects

The Edit ➤ Delete command removes an object completely. To move an object to

another location, see “To Copy an Object” on page 87 or “To Cut and Paste Objects”

on page 92.

For more information on the main console window, see Chapter 7.

▼ To Delete Objects

Note – To delete a domain, use the delete command in the Domain Manager

window; see “Deleting Domains” on page 60.

1. Select an existing object in the topology view.

If you have not selected an object, the Delete function is grayed out.

2. Select Edit ➤ Delete Object/Connection from the top of the main console window
(FIGURE 5-10).

You are prompted to confirm or cancel the deletion.

If the Delete operation succeeds, the object is removed, and this message is

displayed at the bottom of the main console window:

Delete successful
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FIGURE 5-10 Delete Option
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CHAPTER 6

Discovery Manager

You can use the Discovery Manager to populate automatically domains that you

have created. For example, automatically populating domains is very useful if you

have a large network. To add members manually with the Create Topology Object

window, see Chapter 5.

The following topics are covered in this chapter:

■ To Start the Discovery Requests Window

■ To Initiate a Discovery Request

■ To Customize a Discovery Request

■ To Modify a Discovery Request

■ To Start, Stop, or Delete a Discovery Request

The Discovery Manager can find or “discover” hosts, routers, networks, and subnets

(see “Overview of IP Addressing” on page 375) in a local server context. The

Discovery Manager cannot discover objects where a Sun Enterprise SyMON agent is

configured to a different server context (see “Sun Enterprise SyMON Server

Context” on page 287).

The Discovery Manager can also find and group topology objects which are related;

either to a single hardware platform/chassis or a group of cooperating hardware

platform/chassis. This discovery and grouping allows convenient management of

the related objects and is described in the add-on supplement for those machine

architectures which have this grouping requirement.

Note – For additional information, refer to your supplement. The supplement

contains important platform-specific information about discovering objects.

You can create one or more discovery requests. Each request runs as a separate

process and populates the domain with the objects that it has discovered.

You can also schedule requests to run periodically and look for new hosts.
97



Starting the Discovery Requests Window

To begin a Discovery Request, start the Discovery Requests Window.

▼ To Start the Discovery Requests Window

Start the Discovery Requests window in one of two ways:

■ When you create a domain in the Create Domain dialog (FIGURE 4-7) the Populate

Now option is selected by default.

If you click Create in the Create Domain dialog while the Populate Now option is

selected, a dialog window enables you to start the discovery process immediately.

For more information on creating domains, see Chapter 4.

■ Select the domain in the SyMON Administrative Domains pull-down menu. then

select Tools ➤ Discover in the main console window (FIGURE 6-1).

FIGURE 6-1 Tools Pull-down Menu

The Discovery Requests window is displayed (FIGURE 6-2).

Pull-down menu
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FIGURE 6-2 Discovery Requests Window
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The Discovery Requests window displays information containing the fields in

TABLE 6-1.

The Discovery Requests window has the buttons listed in TABLE 6-2.

TABLE 6-1 Discovery Requests Window Fields

Field Description

Name A unique name which you create for the request

Scheduled “Yes” if the request is scheduled, “No” if not scheduled

Status Reflects the current state of the discovery request. The states may

be:

1. New. A new request was added but has never been processed.

2. Queued. A request has been sent to the server but processing has

not yet started.

3. Running. The request is currently being processed.

4. Succeeded. The request has been successfully processed.

5. Failed. Processing of the request has failed.

6. Stopped. The user has stopped the process.

7. 0 Host found. The request did not find any hosts that passed the

filter limits.

TABLE 6-2 Discovery Requests Window Buttons

Button Description

Add Click this button to create a new Discovery Request through the

New Discovery Request window (FIGURE 6-2).

Modify Select a Discovery Request and click this button to make changes.

Duplicate Select a Discovery Request and click this button to create a copy of

the request.

Delete Select a Discovery Request and click this button to delete the

request.

Start Select a Discovery Request that is not running and is not scheduled

to run at a different time, and click this button to start the request.

Stop Select a Discovery Request that is running and click this button to

stop the request.

Log Select a Discovery Request and click this button to see a log of the

results generated from the selected discovery request runs.
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Initiating a Discovery Request

You can discover hosts by using the ping command or by using routing tables.

Note – Currently the Discovery feature is supported only for domains and not for

any subordinate groups. You can add requests only for a domain.

Note – Read Appendix F before initiating a discovery request using routing tables.

Appendix F explains the basic concepts of routing, network classes, and netmasks.

Note – For additional information, refer to your supplement. The supplement

contains important platform-specific information about discovering objects.

▼ To Initiate a Discovery Request

1. Click the Add button in the Discovery Requests window.

The New Discover Request window is displayed (FIGURE 6-3). The Discover tab is

highlighted by default.

Tip – You can copy an existing discovery request by highlighting the existing

request and clicking the Duplicate button. To edit the settings for the new discovery

request, see “Modifying a Discovery Request” on page 111.
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FIGURE 6-3 New Discover Request Window

2. (Optional) Type a new name for your discovery request in the Request Name
field.

Multiple requests are listed in the Discovery Requests window, enabling you to

select a request and edit the related search pattern.
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3. In the Discover Using field, select the method that should be used for discovering
the network (Ping or Routing Table).

■ If you selected Ping, type the start and end IP addresses and netmask (FIGURE 6-3).

The discovery process uses the Ping command and searches for hosts and routers

in the specified IP address range. It then places the hosts in the appropriate

networks and subnets based on the netmask.

■ If you selected Routing Table, type the number of hops (the number of routers a

packet goes through before reaching its destination).

The discovery process starts from the Topology manager/ Sun Enterprise SyMON

server host and goes through the specified number of hops to report subnets and

hosts n hops away. The number of hops limits the “distance” of destination hosts

from the host on which the Topology manager or Sun Enterprise SyMON server is

running.

Note – Routing Table discovery requests require that you run an SNMP agent at

port 161. This can be a Sun Enterprise SyMON agent, snmpdx , or any SNMP agent

provided by your network management package.

For more information on routing tables, see Appendix F.

4. Click the OK button to start the discovery process, or go to the other tabs in this
window to customize your discovery request. See “Customizing Your Discovery
Request” on page 104.

When you start the discovery process:

■ The discovery process discovers all nodes that are running the Sun Enterprise

SyMON 2.0.1 agent, when the nodes are all located in the same Sun Enterprise

SyMON server context. The discovery process does not include agent nodes that

belong to another Sun Enterprise SyMON server context. That is, nodes that are

running Sun Enterprise SyMON agents in a remote Sun Enterprise SyMON server

context are ignored.

■ Nodes that are not running a Sun Enterprise SyMON agent are listed as ping

hosts.

■ The discover process discovers all nodes running an SNMP agent, where the

nodes are not connected to any Sun Enterprise SyMON server. The information

gathered for SNMP agents is very limited.

Note – Each discovery request is assigned a Request ID. This ID is an unique Sun

Enterprise SyMON internal identifier of the request. Therefore, the Request IDs are

not in sequential order. The Request ID displays in the Request Details portion of the

Discovery Requests Window.
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Note – If a host is extremely busy, a discovery process that is gathering data for that

host may time out. If a timeout occurs for a host that is a Sun Enterprise SyMON

agent, the host is reported as a ping host. If this happens, you may want to increase

the SNMP timeout period. See ““Customizing Your Discovery Request” on

page 104” for more information.

5. If a Sun Enterprise SyMON server or agent is incorrectly reported to be a ping
host, create a new icon by re-running discovery with larger timeout and retry
values.

Customizing Your Discovery Request

You can customize your new discovery request by clicking on one of the four tabs on

the New Discover Request window. The tabs are labelled Discover, Preferences,

Filters, and Scheduling. TABLE 6-3 summarizes the tabs and the options for these tabs.

(If you want to change an existing Discovery Request, see “Modifying a Discovery

Request” on page 111).

TABLE 6-3 Summary of Discovery Variables

Variable Definition

Discover

Request Name Descriptive name for this request, for example, “My Lab.” This name is

optional.

Discover Using Ping: Sweeps all addresses within the range specified by Start IP Address

and End IP Address. Alternatively, you can supply the value of the

netmask and let the Discovery Manager calculate the end address, using

Start IP Address.

Routing Table: Discovery Manager consults the routing table of the Sun

Enterprise SyMON server and determines its address, subnet address, and

router(s). It proceeds from there to discover more routers, networks, and

subnets.

Start IP Address

End IP Address

These parameters apply to ping discovery requests. They specify the

address range within which the Discovery Manager tries to find hosts and

routers.
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Netmask This parameter applies to ping discovery requests. It is used to segment

networks into subnets. If you supply the netmask but not the end IP

address, the subnet address is calculated, and the end address is set to the

last address within that subnet.

To find out if your network is subnetted and the value of the netmask,

check the /etc/netmasks file or the name service maps if you are using

NIS (network information service) or DNS (domain name service).

Port Port 161 is the default setting for Sun Enterprise SyMON objects. The

Discovery Manager also tries an alternate port that you can specify in the

Also Check Port field. If neither port responds, the Discovery Manager

concludes that the object is not running a Sun Enterprise SyMON agent.

Preferences

Logging

Log discover request progress? Setting this flag enables logging for that request. The discovery process

places the log files in the /var/opt/SUNWsymon/cfg/discover
directory. There is one log file per user-domain. Currently, this directory is

used for debugging only.

Ping

Timeout (sec.) Amount of time (in seconds) that the Discovery Manager should wait for a

response to a ping request before timing out.

Retries Number of times the Discovery Manager should send a ping request

before giving up.

SNMP

Timeout (sec.) Amount of time that the Discovery Manager should wait for a response to

a SNMP request before timing out.

Retries Number of times the Discovery Manager should attempt a SNMP request.

Community String One or more strings separated by the pipe (|) character. The default value

is public.

General

Maximum Hosts Maximum number of hosts that should be discovered.

Maximum Time (sec.) Maximum amount of time (in seconds) of the discovery process in real

time.

TABLE 6-3 Summary of Discovery Variables (Continued)

Variable Definition
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▼ To Customize a Discovery Request

You can specify limits for the New Discover Request window through the

Preferences and Filters tabs. You can also schedule the new discovery request to run

periodically through the Scheduling tab.

1. Click the Preferences tab.

The New Discover Request Preferences window is displayed (FIGURE 6-4).

Filters

Criteria

Select Filter Criteria

Host Names

Operating System

Platform Type

Filter by host name, operating system, or platform type. Filtering uses the

grep command to search for the supplied value.

Filters This field remains blank until you select a filter criteria. The contents of

this field vary according to your selection(s). You can choose to include or

exclude values in the filtering process. For host names, you specify names

and wildcard characters. For operating systems and platform types, you

select from pull-down menus.

Scheduling

Scheduling

Discover new hosts periodically? If selected, then the specified discovery request is scheduled to run at the

specified start time and frequency.

Settings

Start Time (hh:mm) Specify the time (between 00:00 and 23:59) when discovery should be

started.

Frequency In the pull-down menu, select Hourly, Daily, Weekly, or Monthly.

Day of Week In the pull-down menu, select the day when discovery should run.

Day of Month (1..28) Specify the (numerical) day of the month when discovery should run. You

cannot enter a day unless you have selected Monthly as the frequency.

TABLE 6-3 Summary of Discovery Variables (Continued)

Variable Definition
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FIGURE 6-4 New Discover Request Preferences Window

2. Type your selections in the Logging, PING, SNMP, and General fields.

TABLE 6-3 lists the variables in the New Discover Request Preferences window.
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3. Click the Filters tab.

The New Discover Request Filters window is displayed (FIGURE 6-5).

FIGURE 6-5 New Discover Request Filters Window
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4. Click one or more boxes for host names, operating system, or platform type.

By default, the Filters area is blank. As you select each box, the Filters area adds new

fields. These fields enable you to include or exclude items in the discover search, and

to specify the host names, operating systems, and platform types to be included or

excluded.

Note – If you use a filter, the discovery finds only hosts running the Sun Enterprise

SyMON agent.

5. Click the Scheduling tab.

The New Discover Request Scheduling window is displayed (FIGURE 6-6).
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FIGURE 6-6 New Discover Request Scheduling Window

6. If you want to schedule automatic discoveries, click the button for “Periodically
discover new hosts?” and customize the settings in the Settings area of the
window.
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7. When you have finished your edits, click OK to save the new discovery request, or
click Cancel to cancel your changes.

If you click OK and you have not selected Periodically discover new hosts in the

Scheduling tab, a pop-up dialog is displayed, offering several choices for running

the new discovery request.

■ To save the discovery request and begin running it periodically at the scheduled

times, click Yes.

■ To save the discovery request, but not schedule it to run, click No.

■ To cancel the new discovery request without saving it, click Cancel.

8. Click Close to exit the window.

Modifying a Discovery Request

If you have previously created a periodic discovery request, you can change the

search patterns for that discovery request through the Discovery Requests window

(FIGURE 6-2).

▼ To Modify a Discovery Request

1. Select Tools ➤ Discover in the main console window (FIGURE 6-1).

The Discovery Requests window is displayed.

2. Find and select the name of the discovery request you want to modify.

3. Click the Modify button.

The Edit Discover Request window is displayed. As confirmation, the top bar of the

window displays the ID of the request and the Description field displays the name

of the request.

4. Select the Discover, Preferences, Filters, and Scheduling tabs and in turn, change
settings as needed.

5. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Cancel to cancel your request.

If you click OK, a pop-up dialog is displayed, offering several choices for running

the modified discovery request.

6. Exit from the window:
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■ To start the discovery request and run it immediately, click Yes.

■ To schedule the discovery request, but not run it immediately, click No.

■ To cancel the running of the discovery request entirely, click Cancel.

Starting, Stopping, or Deleting a
Discovery Request

If you have previously created a discovery request, you can start, stop, or delete it

through the Discovery Requests window (FIGURE 6-2).

▼ To Start, Stop, or Delete a Discovery Request

1. Select Tools ➤ Discover in the main console window (FIGURE 6-1).

The Discovery Requests window is displayed.

2. Select the name of the discovery request you want to modify.

3. Click the Start, Stop, or Delete button to start, stop, or delete a request,
respectively.
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CHAPTER 7

Sun Enterprise SyMON Software
Main Console Window

The Sun Enterprise SyMON software main console window (FIGURE 7-1) has the

following regions:

■ Main Console Window

■ Domain View

■ Hierarchy View

■ Topology View

■ Menu Bar

■ Navigation Buttons

■ SyMON Administrative Domains Pull-Down Menu

■ Help Button

■ Domain Status Summary

Main Console Window

The main console window (FIGURE 7-1) is the primary user interface. It provides:

■ Visual representations of the managed objects (for example, hosts and networks)

■ Ability to manipulate attributes and properties associated with the managed

objects (for example, create alarm threshold conditions).

The features shown in FIGURE 7-1 are described in this chapter.
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FIGURE 7-1 Main Console Window

Domain View

Once you have created a domain and have populated it with objects (groups and

hosts, and so forth), you can see the domain and its objects in the hierarchy (tree)

view and the topology (regional) view of this domain.

The domain view enables you to build collections of objects that support your

monitoring and management tasks. You can group your host sets by buildings,

subnets, or other group objects. You can selectively view all objects (such as hosts,

routers, and servers) in the domain, or selected objects (such as the servers) that

support a specific function that interests you.

Menu bar

Domain view
(hierarchy)

Topology view

Navigation Domain status summary
About

SyMON
administrative
domains
(pull-down menu)

Search

Help
(copyright information)

buttons
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The Domain view shows you the objects contained in a domain; the domain itself,

and any groups and hosts contained in that domain.

FIGURE 7-2 illustrates an example of a domain. In this example, Headquarters

represents a domain that consists of all the host machines in the headquarters office.

The host machines are found in one geographic (campus) site. The campus has two

buildings, and each building contains a network, subnet, group, and host machines.

You may choose to create a similar type of domain, and you can group your

machines by subnet, rather than by building. You should create a domain and its

subordinate groups in a hierarchy that best supports your monitoring activities.

For more information on domains, see Chapter 4.

The main console window (FIGURE 7-2) displays two views of a domain and its

members. The left side of the domain view is the hierarchy (tree) view and the right

side is the topology view.

■ Hierarchy tree

The hierarchy tree view displays the relationship between a domain and its

members. Some objects in the hierarchy view contain other objects which can be a

group of objects or a single object. Some objects are both.

In FIGURE 7-2, Building B is an object contained in the domain named

Headquarters, but is also a group itself. Building B contains the network

194.150.151.52, the subnet mpk12-238-n, GroupA, and hosts machineA and

machineB.

For more information, see “Hierarchy View” on page 116.

■ Topology view

The topology view displays the member(s) of an object selected in the hierarchical

tree.

In FIGURE 7-2, the selected object in the hierarchy tree is MachineA.

For more information, see “Topology View” on page 118.
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FIGURE 7-2 Main Console Window With Hierarchy and Topology Views

Hierarchy View

Two types of windows contain hierarchy views:

■ Domain view in the main console window (FIGURE 7-1)

■ Browser view in the Details window (FIGURE 14-2)

The domain hierarchy view displays the domain and its members.

Hierarchy view (hierarchical tree)
Topology view
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The Browser hierarchy view displays the host and its modules. This view is part of

the Browser Details window (Chapter 8).

Both the domain hierarchy view and the Browser hierarchy view behave in the same

manner. In both windows, the hierarchy view is on the left side of the window.

The mouse actions in the hierarchy view are summarized in TABLE 7-1.

▼ To Obtain Specific Information About the Hierarchy View

If an object has a light-colored circle next to it, there are additional levels of

information that are hidden. You can obtain more information about the object by

examining its subordinate objects. To obtain specific information about subordinate

objects, complete the step in one of the following methods.

Method 1

● Click on the circle next to the object to “unroll” the tree branch.

The circle changes to a darker color, and the subordinate objects are displayed.

Method 2

● Double-click with the left mouse button on the object icon or the label.

TABLE 7-1 Mouse Actions in the Hierarchy View

Mouse Action Result

Click with left or right mouse button on the circle next

to the object

“Expands” (opens) details or “collapses” (closes)

details of the selected object.

Double-click with the left mouse button on an object

icon

For a host object, starts the Details window or moves

the Details window to the foreground if it is already

open. For a domain or group object, unrolls or rolls

details of the selected object. Also, the topology view

is updated with the members of the selected object.

Click with the left mouse button on object icon Displays the members of the selected object in the

topology view. However, if the object icon is a host

(in the main console window), then the Details

window is displayed.

Click with the right mouse button and hold on the

object label

Pop-up menu is displayed. See “Pop-up Menu” on

page 119 for more information.
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▼ To Obtain General Information About the Hierarchy View

If an object has a dark-colored circle next to it, lower levels of the hierarchy are

currently displayed (in most cases). You can obtain information about the container

object by “rolling up” (hiding) the lower levels. To obtain general information about

a container object, complete the step in one of the following methods.

Method 1

● Click on the circle next to the object to “roll up” the tree branch.

The circle changes to a lighter color, and the group (container) object is displayed.

Method 2

● Double-click with the left mouse button on the object icon or the label.

Topology View

The topology view displays the members of the object selected in the hierarchy view.

There are two types of windows that contain topology views:

■ Domain view in the main console window (FIGURE 7-1).

■ Browser contents view in the Details window (Chapter 8).

Both the domain and browser contents views behave in the same manner.

The mouse actions in the topology view are summarized in TABLE 7-2.

TABLE 7-2 Mouse Actions in the Topology View

Mouse Action Result

Double-click with the left mouse

button on the icon

Opens details about the selected object. However, if the object is a

host (in the main console window), then the Details window is

displayed.

Click with the left mouse button on the

icon

Selects icon.

Click with the right mouse button and

hold on the icon

Pop-up menu is displayed. See “Pop-up Menu” on page 119 for

more information.
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Tool Tip Balloon

As you move the mouse over various areas in the main console window, tool tip
balloons are displayed momentarily. A tool tip is a description of the selected object

or a description of a property and value column of any data property table

(Chapter 9). Property tables provide information about the monitored property and

are described in Appendix C and Appendix D.

▼ To See a Tool Tip Balloon

● Place your mouse over an object.

After a brief delay, a tool tip is displayed that provides a short description of that

object (FIGURE 7-3).

FIGURE 7-3 Tool Tip Balloon

Pop-up Menu

Pop-up menus are available for all objects in the hierarchy and topology views. The

contents of a menu vary according to the capability of the object selected.

Tool tip
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▼ To Access a Pop-Up Menu

1. Click the right mouse button on the object.

The pop-up menu is displayed.

2. Click the left button to select a menu item (TABLE 7-3).

The following table lists common items in the approximate order in which they are

displayed in the pop-up menus. Some items are not displayed in all menus.

Note – Depending on the object you selected, all the pop-up menu items listed in

TABLE 7-3 may not be displayed.

Menu Bar

The menu bar is at the top of the main console window (FIGURE 7-4).

TABLE 7-3 Common Pop-Up Menu Items

Menu Item Description

Cut Cuts the selected object. The cut object is enclosed in a dashed box

until it is pasted into a new location. To cancel the cut operation,

click on the object.

Copy Copies the selected object.

Rename Displays the Rename Object window.

Modify Displays the Modify Object window.

Attribute Editor Displays the Attribute Editor. For information about editing a

domain, see Chapter 4. For information about editing a host, see

Chapter 10. For information about editing a module, see Chapter 12.

For information about editing security, see Chapter 15.

Load Module Displays the Load Module dialog. For more information on the

Load Module dialog, see “To Load a Module” on page 212.

Details Displays the Details window. For more information on the Details

window, see Chapter 14.
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FIGURE 7-4 Menu Bar

Select (highlight) an object by clicking it in the hierarchy or topology view, then click

a menu name (File, Edit, View, Go, or Tools). If a menu name is grayed out, that

option is not available for the object that you have selected.

▼ To Use the Main Console Window Menu Bar

The menus are of the pull-down style.

1. Click an entry in the menu bar to display a pull-down menu.

2. Click an entry in the pull-down menu to initiate that action.

The menus in the menu bar are described below.

Menu bar
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File Menu Options

Edit Menu Options

TABLE 7-4 Options for the File Menu

Option Description

Domain Manager The Domain manager enables you to create your domain(s).

For more information on Domain Manager, see Chapter 4.

Remote Domain Manager For more information on Remote Domain Manager, see

Chapter 4.

Set Home Domain Sets your home domain.

SyMON-Console Messages Opens the SyMON-Console Messages window. The window

displays messages generated by the Sun Enterprise SyMON

application, but does not include general UNIX messages.

Exit Exits the current console session and all related Sun

Enterprise SyMON windows. A pop-up dialog asks you to

confirm the exit request.

TABLE 7-5 Options for the Edit Menu

Option Description

Create an Object Creates a group, a composite object, a node, or a network

segment in the domain that is currently highlighted in the

console window. See Chapter 5.

Create a Connection Connects two objects in the topology view. You may choose the

type of connection to be General, RS-232, T1, or T3. The

connection is represented by a line between the objects.

Delete Object/Connection Deletes the highlighted object or connection. A dialog asks you

to confirm the deletion request.

Rename Enables you to rename the highlighted object. Displays a dialog

for you to enter the new name.

Modify Brings up the Modify Object menu. For more information on

the Modify Object menu, see “Modifying Objects” on page 89.

Cut Displays a dashed line around the selected object. The object is

not removed until you paste it into a new location.

Copy Copies the selected object into a temporary buffer.
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View Menu Options

Paste Pastes the cut or copied object into the domain or group that is

currently displayed in the hierarchy or the topology view.

Paste Into Pastes the cut or copied object into the selected domain or

group.

Select All Selects all objects in the topology view.

TABLE 7-6 Options for View

Option Description

Topology Layouts Enables you to change the style of display in the topology view. The

styles are:

Network,

Grid (square grid pattern),

List (single vertical list),

Bus,

Star (equidistant lines connected to a center),

Spoked Ring (equidistant lines in a circle).

Set Topology

Background

Displays the Set Topology Background window. You can add a

background image to a topology view by selecting from a list of

graphics files. (The list may not be in alphabetical order.) You can

also use this window to remove a background image by clicking the

Unset button.

TABLE 7-5 Options for the Edit Menu (Continued)

Option Description
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Go Menu Options

Tools Menu Options

TABLE 7-7 Go Menu Items

Menu Item Action

Back Takes you to the previous console view.

Forward Takes you to the next console view (if applicable).

Home Takes you to the top of your home domain in the hierarchy view.

Up Takes you up one level in the hierarchy view.

History Lists recent locations that you have viewed in the current console

session. Select an entry to return to that location.

Search Opens the Topology Search window to search for the object label

that you specify. If one or more objects are found, the full path or

paths are displayed.

TABLE 7-8 Tools Menu Items

Menu Item Action

Details Enables you to see detailed information (if available) for a selected

object. For more information about the Browser Details window, see

Chapter 8. For more information about the Details Alarm window,

see Chapter 13. For more information about the remaining

categories in the Details window, see Chapter 14.

Attribute Editor Displays the Attribute Editor. For information about editing a

domain, see Chapter 4. For information about editing a host, see

Chapter 10. For information about editing a module, see Chapter 12.

For information about editing security, see Chapter 15.

Graph Displays the Open Graph window. You can select from a list of

saved graphs. For information on the graphing function, see

Chapter 9.

Discover Enables you to search for objects in a geographical location. For

information about the Discovery Requests window, see Chapter 6.

Load Module Enables you to load a Sun Enterprise SyMON module for a selected

object. For information about the Load Module window, see

Chapter 12.
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Navigation Buttons

As you move through different domains and through different levels within the

domains, the domain views are stored in memory. The navigation buttons

(FIGURE 7-5) in the main console window help you move back and forth between

these views.

FIGURE 7-5 Navigation Buttons

Note – The navigation buttons perform the same function as the Go menu items.

SyMON Administrative Domains
Pull-Down Menu

The SyMON Administrative Domains pull-down menu is shown in FIGURE 7-6. This

menu displays the current list of domains and enables you to switch from one

domain to another. Clicking on the domain updates and displays the selected

domain.

The default domain is the domain that is always displayed whenever the main

console is started.

TABLE 7-9 Navigation Buttons

Button Description

Forward Button The forward button is represented by an arrow pointing right

(FIGURE 7-5). Clicking this button displays the next screen.

Back Button The back button is represented by an arrow facing left (FIGURE 7-5).

Clicking this button displays the previous screen.

Home Button The home button is represented by a house (FIGURE 7-5). Clicking

on this button returns you to the highest level of the domain.
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FIGURE 7-6 Administrative Domains Pull-Down Menu

▼ To View the Current List of Domains

1. In the main console window, click the SyMON Administrative Domains button.

The pull-down menu with the current list of domains is displayed.

2. Click the domain that you want to view.

The main console window is updated and displays the selected domain. The

SyMON Administrative Domains button changes to display the name of the domain

you have selected.

Help Button

Clicking the Help button (FIGURE 7-7) displays the online Sun Enterprise SyMON 2.0.1
Software User’s Guide.
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FIGURE 7-7 Help Button

Domain Status Summary

The domain status summary displays the number of managed objects that have

unacknowledged open alarms, by level of severity, in the selected Administrative

Domain. (FIGURE 7-8).

Note – If a host has multiple alarms at several different severity levels, the host is

represented at only one severity level (the highest severity level for that host).

For more information on the domain status summary, see “Seeing Alarms in Domain

Status Summary” on page 241.

FIGURE 7-8 Domain Status Summary

Help button
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CHAPTER 8

Browser

This chapter covers the following topics:

■ To Start the Details Window

■ To Set Security for a Host or Module

Details View

The details view is a subset of the Domain view. The highest hierarchical object in a

details view is the host machine or module (if you have created a module object).

For more information, see “To Create a Module Object” on page 75. Unlike the

domain view, the details view enables you to see modules and the various

monitored properties and statistics contained in the modules.

Using the Details Window

You can start the Details window from the main console window.

The Details window provides you with detailed information about that individual

host. This window has several tab buttons, that may include the following:

■ Info

■ Browser

■ Alarms

■ Processes

■ Log View

■ Configuration
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Note – The tab buttons that are displayed in the Details window are dependent on

the type of object selected. In addition, the Configuration tab is missing if the

Config-Reader module is not supported on your system. For additional information

on the tabs for your specific hardware object, see your supplement.

Each tab button, as described in the following table, updates the window with a new

panel consisting of information represented by that tab button.

For more information on these buttons, see Chapter 14.

▼ To Start the Details Window

● Proceed with one of the following:

■ Click the right mouse button on the selected object and highlight Details from the

pop-up menu in the hierarchy view (FIGURE 8-1) or the topology view.

■ With your left mouse button, double-click on the selected host icon in the

hierarchy view or the topology view.

TABLE 8-1 Details Window—Common Tab Buttons

Tab Button Description

Info Provides general information about the host including host name,

IP address, polling type, and so on. This information is collected at

the time the object is created.

Browser Enables you to navigate through the hierarchy and contents views

of the host, set alarm thresholds, and view and graph monitored

data properties. This is the default view when the Details window

opens.

Alarms Displays the alarms for this host. Enables you to acknowledge or

delete alarms.

Processes Displays the processes running on the host. (You must load the

Solaris Process Details module to see the processes.)

Log View Displays informational messages, including error messages, about

your host. Enables you to search, monitor, and examine system and

EntDiag log messages.

Configuration Displays configuration information about your host for selected

hardware platforms. Configuration information may include the

physical and logical view of your host. If the hardware platform is

not supported by the Config-Reader module, this tab button is

missing in the Details window.
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■ In the main console window, select the object then select Tools ➤ Details

(FIGURE 8-2).

Be sure to select a managed object, not a domain, as the Details window is not

available for domains.

The Details window (with the browser tab pre-selected) is displayed.

FIGURE 8-1 Opening the Details Window from the Pop-Up Menu
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FIGURE 8-2 Opening the Details Window from the Tools Menu

▼ To Exit the Details Window

● Click the Close button located at the bottom of the Details window.
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Browser Tab

The host contains four subordinate groups: hardware, operating system, local

applications, and remote systems. The Sun Enterprise SyMON modules belong to

one of these four categories.

Sun Enterprise SyMON software monitors hosts by using modules. Modules are

software components that monitor data pertaining to the health indicators and

resources of systems, applications, and network devices.

FIGURE 8-3 is an example of the host view for MachineB . The left side of the host

view is the hierarchy (tree) view and the right side is the contents view. The host

hierarchy view displays the relationship between the host and its modules. In this

example, the loaded operating system modules are the MIB-II Instrumentation and

the Kernel Reader modules.

By using the Browser Details window, you can set alarm thresholds and view and

graph monitored data properties for your host.
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1

FIGURE 8-3 Browser Details Window

The Browser tab (FIGURE 8-3) contains the hierarchy and contents view for a host.

Hierarchy view

Contents view
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FIGURE 8-4 Light-Colored Circles “Unroll” to Provide Additional Levels of Detail

Tip – You may be able to see more information by holding the mouse pointer over

the object for several seconds. A pop-up balloon (tool tip) is displayed, showing

additional information about the object. These tool tips are also displayed for data

property table cells and are useful if information in a table cell is too long to display

completely.

Circle
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Tip – If the hierarchy view has a light-colored circle (FIGURE 8-4), you can click the

circle or double-click the icon next to the circle to “unroll” and display more levels of

detail.

Each host contains categories for Hardware, Operating System, Local Applications,

and Remote Systems. For more information on modules, see Appendix C and

Appendix D.

Hardware

The Hardware category consists of the Config-Reader module, which monitors the

host configuration, including information and status for power supplies, keyswitch,

fans, remote console, the system in general, and so on.

There are different Config-Reader modules for different hardware platforms. If your

system is supported by a Config-Reader module, it is automatically loaded during

installation.

For more information on the Config-Reader module for your hardware platform,

refer to your supplement.

Operating System

The Operating System category includes modules that monitor the operating

environment of the host:

■ Directory Size Monitoring

■ File Monitoring

■ Kernel Reader

■ MIB-II Instrumentation

■ NFS File Systems

■ NFS Statistics

■ Solaris Process Details

Local Applications

The Local Applications category includes modules that monitor the local

applications on the host:

■ Agent Statistics

■ Data Logging Registry

■ Dynamic Reconfiguration
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■ File Scanning

■ Health Monitor

■ Print Spooler

■ Process Monitoring

Remote Systems

The Remote Systems category includes modules that monitor remote systems:

■ MIB-II Proxy Monitoring module

■ HP JetDirect module (monitors HP printers equipped with a JetDirect card)

Browser Buttons

The Browser Details window includes a row of buttons at the top of the panel.

TABLE 8-2 Browser Buttons

Menu Item Definition

Module FIGURE 8-5

Load Module Enables you to add a module to the host. The host must be selected

or this option is grayed out. For more information, see “To Load a

Module” on page 212.

Edit Module Enables you to edit module parameters. The module must be

selected or this option is grayed out. For more information, see “To

Edit Module Parameters” on page 222.

Enable Module Enables you to enable a module. The module must be selected or

this option is grayed out. For more information, see “To Enable a

Module” on page 224.

Disable Module Enables you to disable a module. The module must be selected or

this option is grayed out. For more information, see “To Disable a

Module” on page 224.

Unload Module Enables you to unload a module from the host. The module must be

selected or this option is grayed out. For more information, see “To

Unload a Module” on page 225.

Options FIGURE 8-6

Copy Enables you to copy a module. You may paste the copied module in

the topology or hierarchy view of the main console. This enables

you to monitor the module properties without having the Details

window open. For more information, see “To Create a Module

Object” on page 75.
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Note – The browser buttons are grayed out when the command is not appropriate

for the selected object.

Copy To Graph

Clipboard

Enables you to add another data property (with the same units) to

an existing graph. Used with Add From Graph Clipboard menu

item in graphing window. See “To Graph Two Data Properties” on

page 156.

Add Row Adds a row to a data property table. See “To Add a Row” on

page 146.

Enable Row Enables a row (that has been disabled) in a data property table.

Disable Row Disables a row in a data property table.

Edit Row Enables you to edit information for a row in a data property table.

Delete Row Deletes a row in a data property table.

Attributes Displays the attribute editor for the selected object. The Attribute

Editor provides additional information about the selected object

and the rules governing its behavior. Use the Attribute Editor to

edit information about the object.

Graph Graphs the selected monitored data property.

Probe Enables you to run selected commands on the monitored data

property.

Refresh Now Refreshes the information in the displayed data property table.

TABLE 8-2 Browser Buttons (Continued)

Menu Item Definition
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FIGURE 8-5 Module Menu Options in Details Window

FIGURE 8-6 Options Menu Options in Details Window
Chapter 8 Browser 139



Host Security

In the Details window, Sun Enterprise SyMON software offers security at two levels:

the host itself and at the module level. You may also set security at the host level

only. In this case, anyone with the appropriate security can load modules, set alarm

thresholds, acknowledge alarms, and so on.

You may also set security permissions at the module level. In this case, only those

users with the appropriate module permissions can perform actions on the module.

Module security can be used as a “subset” of host security.

For example, at the host level, you can set security permissions so that users A, B,

and C can load modules and create alarm thresholds. User A loads the Health

Monitor module and creates customized alarm thresholds. However, users B and C

can change user A’s work unless security permissions have also been set at the

Health Monitor module level, enabling only user A to set alarm thresholds.

Note – In the case where security is set at both levels, the security permissions at

the module level take precedence over the security permissions at the host level.

Consequently, only user A can create alarm thresholds for the Health Monitor

module.

For more information on security, see Chapter 15.
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FIGURE 8-7 Attribute Editor for a Host or Module

▼ To Set Security for a Host or Module

1. Open the Attribute Editor for a host or module by proceeding with one of the
following:
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■ Click the right mouse button on the host or module and highlight Attribute

Editor from the pop-up menu.

■ Click the Attributes button.

2. Click the Security tab (FIGURE 8-7).

3. Type the name(s) of user and administrator groups in the appropriate fields.

For more information on the security fields, see Chapter 15.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request and close the window.
142 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



CHAPTER 9

Monitoring and Graphing Data
Properties

This chapter covers the following topics:

■ To Display a Data Property

■ To Add a Row

■ To Refresh Displayed Data

■ To Probe a Property

■ To Graph A Monitored Data Property

■ To Graph Two Data Properties

■ To Save Graphing Parameters

■ To Open a Graph

■ To Apply a Graph Template

Monitoring Data Properties

Using your mouse, you can navigate through the hierarchy (tree) view in the Details

window to view the monitored properties.

The lowest-level object in the host hierarchy is the monitored property. The software

provides both tabular and graphical information about a monitored property.

Once the data has been displayed, you can refresh the data. In addition, you can

graph up to five data properties simultaneously. These actions are described in the

following sections.
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▼ To Display a Data Property

Note – The following example uses the Kernel Reader module.

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Kernel Reader icon in the contents view or single click in the
light-colored circle next to the Kernel Reader icon in the hierarchy view.

The Kernel Reader statistics are displayed.

3. Double-click on the System Load Statistics icon in either the hierarchy or the
contents view (FIGURE 9-1).

The monitored properties are displayed in a property table.
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FIGURE 9-1 System Load Statistics
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Working with Rows

For selected modules, the software enables you to add, delete, enable, or disable

rows for the data property tables (TABLE 9-1). When these modules are initially

loaded, the data property tables are empty. You must “add a row” to monitor the

data property.

For more information on the file monitoring module, see Appendix C. For more

information on the file scanning and process monitoring modules, see Appendix D.

▼ To Add a Row

The following example procedure uses the File Monitoring module. If this module is

not loaded, see “To Load a Module” on page 212.

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the File Monitoring icon in the contents view or single click in
the light-colored circle next to the File Monitoring icon in the hierarchy view.

The File Monitoring Status folder is displayed.

3. Double-click on the File Monitoring Status folder in either the hierarchy or the
contents view.

An empty property table is displayed.

TABLE 9-1 Sun Enterprise SyMON Modules That Require You to Add Rows

Module Name Description

File Monitoring Each added row defines the monitored “file”.

File Scanning Each added row defines the “pattern” which must be matched

within the monitored file.

Process Monitoring Each added row defines the “pattern” which must be matched from

all the processes that are running on the agent object.
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FIGURE 9-2 File Monitoring Table

4. Proceed with one of the following:

■ Click the right mouse button in the table row and select the Add Row command

from the pop-up menu (FIGURE 9-2).

■ In the Details window, select Options ➤ Add Row.

The Row Adder window is displayed (FIGURE 9-3).

5. Type the appropriate information in the text fields.
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FIGURE 9-3 Row Adder Window for the File Monitoring Module

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the window to the default parameters.

■ Click Cancel to cancel your request.

The added row is displayed in the contents view (FIGURE 9-4).
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FIGURE 9-4 Updated File Monitoring Table

Note – The Row Adder window that is displayed is dependent on the selected

module. FIGURE 9-5 and FIGURE 9-6 illustrate examples of the Row Adder window for

the File Scanning and Process Monitoring modules, respectively.
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FIGURE 9-5 Row Adder Window for the File Scanning Module
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FIGURE 9-6 Row Adder Window for Process Monitoring Module

▼ To Refresh Displayed Data

● Proceed with one of the following:

■ Click the right mouse button in the data property table row and select Refresh

from the pop-up menu (FIGURE 9-7).
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■ Click the Refresh Now button.

In this example, the System Load Statistics table is updated with the latest

information.

Note – You may also set up a refresh interval and the Sun Enterprise SyMON

software automatically updates your monitored data at your designated time

interval. For information on accomplishing this task, see “Refresh Tab in the

Attribute Editor” on page 178.

FIGURE 9-7 Monitored Data Property Pop-up Menu

Probing Properties

On selected properties, the software enables you to use pre-determined UNIX

commands including list files, the vmstat command, and so on. The Probe button is

not grayed out when probe commands are applicable.

The following procedure explains how to probe a property in the Directory Size

Monitoring module. If you have not done so already, load this module by following

the procedure “To Load a Module” on page 212.
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▼ To Probe a Property

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Directory Size Monitoring icon in the contents view or single
click in the light-colored circle next to the Directory Size Monitoring icon in the
hierarchy view.

The Directory Monitoring Status folder is displayed.

3. Double-click on the Directory Monitoring Status folder icon in either the
hierarchy or the contents view.

The monitored data properties are displayed in a property table.

4. Proceed with one of the following:

■ Click the right mouse button in the Directory Monitoring table row and select the

List Files or Recursively List Files command from the pop-up menu (FIGURE 9-8).

■ Click the Probe button (FIGURE 9-9), select the appropriate command, and click the

OK or Cancel button.
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FIGURE 9-8 Probe Commands in the Pop-up Menu
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FIGURE 9-9 Probe Select Dialog

Graphing Properties

The software enables you to graph most monitored data properties (FIGURE 9-10).

▼ To Graph A Monitored Data Property

● Proceed with one of the following:

■ Click the right mouse button in any table cell containing a data property you

want to graph, and select Graph from the pop-up menu (FIGURE 9-7).
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■ Select (highlight) the desired data property, and then click the Graph button at the

top of the Details window.

The graphing window is opened and the values of the property are plotted as a

function of time. The plotting is dynamic and continues even if the graphing

window is iconified on the desktop. Plotting stops, however, if the window is closed.

Note – Placing your cursor and clicking with the right mouse button in a property

row or column displays the pop-up menu for that property.

FIGURE 9-10 Graph of System Load Statistics Average Over the Last Five Minutes

▼ To Graph Two Data Properties

1. Click the right mouse button in the data property table cell.

In this example, the Load Averages Over the Last 1 Minute table cell is selected.

2. Proceed with one of the following:

■ Click the right mouse button in the table cell and select the Copy to Graph

Clipboard command from the pop-up menu (FIGURE 9-11).
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■ In the Details window, select Options ➤ Copy to Graph Clipboard.

Note – The Copy to Graph Clipboard command works only when the units of the

data item are the same. Also, Copy to Graph Clipboard places the data on a

clipboard. The data is not actually placed on the graph until you complete the

following step.

3. Go to the graphing window in which you want the additional property to be
plotted. Select Graph ➤ Add From Graph Clipboard (FIGURE 9-12).

The second data property is added (FIGURE 9-13).

FIGURE 9-11 Copying Load Averages Over the Last One Minute to the Graph

Note – You may graph up to 5 datasets at one time on a single graph.
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FIGURE 9-12 Adding Load Averages Over the Last One Minute to the Graph
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FIGURE 9-13 Load Averages Over the Last One and Five Minutes

▼ To Save Graphing Parameters

1. Select Graph ➤ Save Graph Request As or Select Graph ➤ Save Template in the
Graphing window.

The Save Graph Request function (FIGURE 9-14) enables you to save the host name

and the data property or properties that have been graphed. Once saved, a graph of

this property on this host can be pulled up quickly from inside the graphing

window (as shown here) or from the main console window under the Tools menu. A

newly opened graph starts plotting fresh data.

The Save Template function (FIGURE 9-15) enables you to save any custom features

you have added to your graph including axis labeling, headers, footers, legend, and

so on. (For more information see “Graphing Menus” on page 162.)

2. Type the name in the Enter Graph Name or Enter Template Name fields.

3. Click the Save button to save your graph request (template) or click the Cancel
button to cancel your request.
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FIGURE 9-14 Save Graph Request Dialog

FIGURE 9-15 Save Template Dialog

▼ To Open a Graph

1. Select Graph ➤ Open Saved Graph in the Graphing window.

The Open Graph dialog is displayed (FIGURE 9-16).
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FIGURE 9-16 Open Graph Dialog

2. Select (highlight) a saved graph from the list.

3. Click the OK button to open the graph or the Cancel button to cancel your
request.

▼ To Apply a Graph Template

1. Select Graph ➤ Apply Template in the Graphing window.

The Apply Template dialog is displayed (FIGURE 9-17). This dialog enables you to

apply saved custom features to the current graph.

FIGURE 9-17 Apply Template Dialog

2. Select (highlight) a saved template from the list.

3. Click the OK button to apply the template to the current graph or the Cancel
button to cancel your request.
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Graphing Menus

There are five Graphing window menu items:

■ Graph

■ Edit

■ View

■ Tools

■ Help

Graph Menu Items

TABLE 9-2 Graph Menu Items

Menu Item Description

Save Graph Request

as

Saves the host name and data property (properties) that are plotted.

Open Saved Graph Opens a previously saved graph.

Delete Deletes a previously saved graph.

Save Template Saves any custom changes you make on the graph.

Apply Template Applies a saved template to the current graph.

Delete Template Deletes a previously saved graph template.

Add From Graph

Clipboard

Adds an additional dataset to an existing graph. Choose this menu

item after selecting a property to “copy to graph clipboard.”

Close Closes the graphing window.
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FIGURE 9-18 Graph Menu Items

The graph utility enables you to customize the look and feel of your graphs through

the edit menu items (TABLE 9-3).

Note – Header, Footer, Axes, and Legend changes are not visible unless the view

option corresponding to that part of the graph is toggled on (TABLE 9-4).
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Edit Menu Items

FIGURE 9-19 Edit Menu Items

TABLE 9-3 Edit Menu Items

Menu Item Description

Chart Type Changes graph type to line, area, or bar graph.

Main Titles Changes the text, font, font style, point size, and orientation of the

header, footer, legend, x-axis or y-axis title. In addition, this dialog

enables you to select and customize the border around the title.

Axes Edits the range and the spacing of the x- and y-axes. This menu

item is suggested for advanced users only (FIGURE 9-20 and

FIGURE 9-21).

Border Determines the border type (including a no border option).
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Note – Editing axes requires some care in choosing the correct values. If you should

choose values for Min and Max that are impossible to plot, the dialog, in most cases,

gives you an error message describing the problem. However, if you simply choose

values that are possible, but result in the plotted points no longer being visible, you

are not warned with an error message.

FIGURE 9-20 and FIGURE 9-21 show the axes dialog for the x-axis and y-axis,

respectively.

FIGURE 9-20 X-Axis Editing Dialog

The software chooses appropriate default x-axis values using “Autoscaling”. If you

want to change the values, then you must turn off autoscaling by unchecking the

checkbox.

You may then change:

■ Number of minutes to be plotted

■ Positioning of ticks

■ Positioning of grid lines

Note – Ticks are the small lines that mark off intervals on an axis.
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FIGURE 9-21 Y-Axis Editing Dialog

The software chooses appropriate default y-axis values using “Autoscaling”. If you

want to change the values, then you must turn off autoscaling by unchecking the

checkbox.

You may then change:

■ Minimum and maximum values shown on the y-axis

■ Major tick positions (the interval at which numerical labels are shown)

■ Minor tick positions (showing smaller intervals)

■ Grid spacing
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View Menu Items

FIGURE 9-22 View Menu Items

TABLE 9-4 View Menu Items

Menu Item Description

Live Data Displays the monitored property (properties) data points.

Show Header Displays the header text.

Show Footer Displays the footer text.

Show Axis Titles Displays the x-and y-axes titles.

Show Axes Displays the x-and y-axes.

Show Grids Displays a grid pattern in the graphing window.

Show Legend Displays the legend text.

Rotate Graph Rotates the graph by 90, 180, or 270 degrees.

Flip Flips the graph over (x-axis flips the x-axis, y-axis flips the y-axis).

Reset View Resets rotate and flip options to the default (graph upright) setting.
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Tools Menu Items

FIGURE 9-23 Tools Menu Items

TABLE 9-5 Tools Menu Items

Menu Item Description

Zoom Toggle to turn on the zoom option, which focuses on a selected area

of the graph. Hold down the Shift key while dragging out a

rectangle with the mouse.

Translate Toggle to turn on the translate option, which moves the graphing

window side to side or back and forth. Hold down the Control key

while moving the mouse left-right or up-down.

Restore Removes the effects of the zoom and translate options; undo option.
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CHAPTER 10

Attribute Editor

This chapter covers the following topics:

■ To Open the Attribute Editor

■ To Create an Alarm

■ To Send an Email

■ To Set a Refresh Interval

■ To Set a History Interval

Attribute Editor for a Data Property

The Attribute Editor for a data property provides additional information about the

property and enables you to customize various monitoring criteria. You can use the

attribute editor to set:

■ Alarm thresholds

■ Actions when alarm conditions occur

■ The refresh interval

■ A logging schedule for historical data points

The Attribute Editor consists of a series of one or more tab buttons at the top of the

window that enables you to switch between different panels. The tab buttons for the

System Load Statistics data property are:

■ Info

■ Alarms

■ Actions

■ Refresh

■ History
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Note – Each Attribute Editor displays one or more of these tab buttons, depending

on the type of Attribute Editor. The Attribute Editor that is displayed is dependent

on the selected object.

▼ To Open the Attribute Editor

1. Click the right mouse button and select a data property table cell (FIGURE 10-1).

2. Proceed with one of the following:

■ Click the right mouse button in a table row and select Attribute Editor from the

pop-up menu.

■ Click the Attributes button.

FIGURE 10-1 Selected Data Property
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Information Tab in the Attribute Editor

The Information panel (FIGURE 10-2) provides you with additional information about

the selected object.

FIGURE 10-2 Attribute Editor Info Tab for a Monitored Property
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Alarms Tab in the Attribute Editor

The Alarms panel (FIGURE 10-3) enables you to set alarm thresholds (TABLE 10-1) for

simple alarms only.

Simple alarms are based on thresholds. A monitored data property is greater than,

less than, not equal to, or equal to a single threshold value. By contrast, complex

alarms are based on a set of conditions becoming true. For more information on

alarm rules, see Appendix E.

FIGURE 10-3 Attribute Editor Alarms Tab for a Monitored Property
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TABLE 10-1 shows common simple alarm limits for monitored properties. The alarm

limits are also displayed in the Parameter Description field (FIGURE 10-3). You may

set thresholds for one or more of these alarm limits for selected data properties.

The software offers you the following flexibility in setting your alarms:

■ Determine the thresholds that trigger an alarm of a particular severity

■ Determine when alarms are sounded (for example, only on weekdays)

Note – You need the appropriate security permission to set an alarm threshold. See

Chapter 15 for more information.

TABLE 10-1 Common Simple Alarm Limits in Sun Enterprise SyMON Software

Alarm Limit Description

Critical Threshold (>) Critical (red) alarm occurs if value exceeds limit entered in this field.

Alert Threshold (>) Alert (yellow) alarm occurs if value exceeds limit entered in this field.

Caution Threshold (>) Caution (blue) alarm occurs if value exceeds limit entered in this field.

Critical Threshold (<) Critical (red) alarm occurs if value is below the limit entered in this field.

Alert Threshold (<) Alert (yellow) alarm occurs if value is below the limit entered in this

field.

Caution Threshold (<) Caution (blue) alarm occurs if value is below the limit entered in this

field.

Alarm Window Alarm occurs only during this time period. For example, if you type

day_of_week=fri , an alarm occurs only if the alarm condition exists on

a Friday. If an alarm condition exists on Tuesday, no alarm is registered.
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▼ To Create an Alarm

The following example illustrates how to create a simple alarm. This example creates

an alarm threshold in the Kernel Reader module.

1. Click the Browser tab button in the Details window.

2. Click the light-colored circle next to the Operating System icon in the hierarchy
tree view.

The Operating System modules are displayed.

3. Click the light-colored circle next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 1 Minute.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click on the Alarms tab button.

The alarm rows are displayed.

8. Type a value in the Critical Threshold (>) field which is less than the current
value.

Entering this value enables you to create a critical alarm.

9. Complete one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

After some time, the Load Average Over the Last 1 Minute data field in the table

turns red. In addition, red alarm icons are displayed on the following folders and

icons: Operating System, Kernel Reader, and System Load Statistics (unless your

system has an open, unacknowledged severity 1 black alarm).

10. Click the Alarms tab button in the Details window.

The alarm you created should be reflected in the alarms table. See Chapter 13 for

more information on this subject.

11. Acknowledge this alarm.

For more information, see “To Acknowledge and Delete Alarms” on page 249.
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12. Create additional alarm thresholds and familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that

another Sun Enterprise SyMON software user cannot change your alarm thresholds.

For more information on security, see Chapter 15.

Note – You do not need to fill in alarm information for all alarm thresholds. For

example, you may choose to create only a critical alarm threshold.

The preceding example illustrates creating a situation where an alarm is registered if

a value exceeds the alarm limit. TABLE 10-1 lists other common alarm limits in the

software.

Actions Tab in the Attribute Editor

The Actions tab in the Attribute Editor (FIGURE 10-4) enables you to instruct the

software to perform a predetermined action if an alarm occurs.

Note – Acceptable actions include scripts that are stored in the /var/opt/
SUNWsymon/bin directory. These scripts execute with root permissions.

For example, you can enter the name of a script in the critical action field so that an

email is sent to a system administrator whenever a critical alarm is generated for the

Load Average Over the Last Five Minutes data property.

In FIGURE 10-4, you can set separate actions for different alarm conditions or one for

any alarm condition (action on any change).
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FIGURE 10-4 Attribute Editor Actions Tab for a Monitored Property
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▼ To Send an Email

The following example procedure describes how to send an email to a user when a

critical alarm occurs.

1. Click the Browser tab button in the Details window.

2. Click the light-colored circle next to the Operating System icon in the hierarchy
tree view.

The Operating System modules are displayed.

3. Click the light-colored circle next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Actions tab button.

The action rows are displayed.

8. Type email username in the Critical Action field.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

The following email is sent to the user whenever a critical alarm occurs.

Date: Wed, 28 Oct 1998 15:25:39 -0800
From: root@MachineB (0000-Admin(0000))
Mime-Version: 1.0

SyMON alarm action notification ... {Critical: machineB Kernel
Reader Used KB > 1000Kilo Bytes}
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Refresh Tab in the Attribute Editor

The Refresh panel (FIGURE 10-5) enables you to set the refresh interval for this object.

The refresh interval is the interval between the times when the Sun Enterprise

SyMON agent samples the monitored property.

FIGURE 10-5 Attribute Editor Refresh Tab for a Monitored Property
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▼ To Set a Refresh Interval

The following example illustrates how to set a refresh interval in the System Load

Statistics module.

1. Click the Browser tab button in the Details window.

2. Click the light-colored circle next to the Operating System icon in the hierarchy
tree view.

The Operating System modules are displayed.

3. Click the light-colored circle next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Refresh tab button.

The refresh panel is displayed.

8. Type a value (in seconds) in the Refresh Interval field or click the Advanced
button.

In this example, type 300 in the entry field. The refresh interval is five minutes. For

more information on the Advanced button, see “Using the Time Editor” on page 185.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

Whenever the System Load Statistics table is displayed, the values in the table are

refreshed every five minutes.
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History Tab in the Attribute Editor

The history tab in the Attribute Editor enables you to save older data for a

monitored property. In FIGURE 10-6, a history of data points is recorded every 120

seconds (sample interval). This information may either be stored in a disk file or in

the memory cache.

There are two types of disk files: circular (maximum of 1000 lines) and text. These

files are located in the /var/opt/SUNWsymon/log directory.

If you select memory cache, you must also indicate how many data points should be

saved in the Max Size (sample) field.

Note – You may view this data in a graph by opening the graph for this monitored

property. If you have selected memory cache, the graph is displayed with the

historical data.
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FIGURE 10-6 Attribute Editor History Tab for a Monitored Property
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▼ To Set a History Interval

1. Click the Browser tab button in the Details window.

2. Click the light-colored circle next to the Operating System icon in the hierarchy
tree view.

The Operating System modules are displayed.

3. Click the light-colored circle next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click the System Load Statistics icon.

The System Load Statistics properties table is displayed.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the History tab button.

The history panel is displayed.

8. Type a value (in seconds) in the Sample Interval field or click on the Advanced
button.

In this example, type 120 in the entry field. A history data point is collected every

two minutes. For more information on the Advanced button, see “Using the Time

Editor” on page 185.

9. Click in the check box next to Save History as Disk File or Save History in
Memory Cache.

10. If you decided to save history as a disk file, determine the file type (circular or
text) and type the file name in the Text File Name field (text file only).

A circular disk file is automatically saved under the name history.log . If you do

not choose a file name for your text file, it is automatically saved under the name

agent_default.history .

11. If you decided to save history in memory cache, type the number of history data
points in the Max Size (sample) field.

For example, if you set this field to 1000, only the most current 1000 data points are

stored in the memory cache. Any older data points are discarded. These data points

may be graphed. See “To Graph A Monitored Data Property” on page 155 for more

information.

12. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.
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■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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CHAPTER 11

Time Editor

This chapter covers the following topics:

■ To Create a Time Expression Using the Cyclic and Comparison Tabs

■ To Create a Time Expression Using the Absolute and Cron Tabs

■ To Create an Alarm Schedule Using the Comparison Tab

Using the Time Editor

Use the Time Editor (FIGURE 11-1) to schedule monitoring activities. For example, you

may want a particular module to be operational only during business hours. Or you

may want to record the history of a monitored property only during peak activity.

You can use the Time Editor to set the schedule for a module, for alarms, for a

refresh interval, and for history data collection.

Note – The schedule (set by the Time Editor) for a module overrides the schedule

for alarms, refresh intervals, and history. If the module is not “on,” the data

properties are not monitored and the alarms, refresh, and history schedules are

meaningless.
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FIGURE 11-1 Time Editor

There are four basic types of Time Expressions:

■ Cyclic – Periodic events

■ Absolute – Starting at a particular time

■ Comparison – Allowing events at specific times

■ Cron – Allowing events at specified times using cron input format

These Time Expressions can be used separately or in combination.

Note – All four Time Expressions are valid for history sample and refresh intervals.

However, only the comparison tab is valid for alarm and module schedules.

Combining Time Expressions

The following examples illustrate combining Time Expressions to set a history

interval.

Note – Sampling for the history interval does not occur unless the module is also on

(according to the module schedule).
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▼ To Create a Time Expression Using the Cyclic

and Comparison Tabs

Note – This procedure is also valid for a refresh interval.

1. Click on the Advanced button in the History tab of the Attribute Editor for a data
property.

See “To Set a History Interval” on page 182 for more information.

The Time Editor is displayed (FIGURE 11-1).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Time window is displayed with the Cyclic tab selected.

4. Determine the frequency for the history interval (FIGURE 11-2).

In this example, the history interval is set for every hour. That is, the software checks

the System Load Average Over the Last 5 Minutes every hour.

a. Highlight the number field and click the up or down arrows until the number 1
is displayed.

b. Highlight the units field and click the up or down arrows until hours is
displayed.
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FIGURE 11-2 Setting a Cyclic Time of One Hour

5. Click the Apply button.

■ Cycle(1 hours) is displayed in the Time Editor (FIGURE 11-3).
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FIGURE 11-3 Time Editor With Cyclic Time of One Hour

6. Click the Insert button.

The Time window is displayed with the Cyclic tab selected.

7. Click the Comparison tab.

The Time window is displayed with the Comparison tab selected.

8. Determine the start of the Time Range (Monday).

The time range determines the time period when the software checks the system

load average every hour. The software does not check the system load average

outside the time period specified by this window. In this example, the time range is

from Monday to Friday, inclusive.

a. Select Day of week from the left pull-down menu.

b. Select >= from the middle pull-down menu.

c. Select Monday from the right pull-down menu.

The time expression is displayed in the Current Time Expression field

(FIGURE 11-4).
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FIGURE 11-4 Setting the Start Range to Monday

9. Click the Apply button.

The Time Editor is updated. The Current Time Expression now reads

Day_of_week>=Monday. However, the Time Editor also enables you to select the Or

expression (FIGURE 11-5).
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FIGURE 11-5 Time Editor Is Updated With a Start Range of Monday

10. Determine the end of the Time Range by clicking the Insert button.

11. Click on the Comparison tab of the Time window.

The Time window is displayed with the Comparison tab selected.

12. Determine the end of the Time Range (Friday).

a. Select Day of week from the left pull-down menu.

b. Select <= from the middle pull-down menu.

c. Select Friday from the right pull-down menu.

The Time expression is displayed in the Current Time Expression field

(FIGURE 11-6).
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FIGURE 11-6 Setting the End Range to Friday

13. Click the Apply button.

The Time Editor is updated. The Time Expression fields now read Cycle(1 hours)

and Day_of_week>=Monday and Day_of_week<=Friday (FIGURE 11-7).
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FIGURE 11-7 Time Editor Showing a Cycle Time of One Hour From Monday to Friday

14. Click the Apply button.

The Sample Interval field in the Attribute Editor is updated. The software will check

the system load average (over five minutes) at every hour, from 12:00 AM Monday

to 12:00 AM Saturday morning.
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FIGURE 11-8 Updated History Attribute Editor Showing a Cycle Time of One Hour From
Monday to Friday
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▼ To Create a Time Expression Using the Absolute

and Cron Tabs

Note – This procedure is also valid for a refresh interval.

1. Click on the Advanced button in the History tab of the Attribute Editor for a data
property.

See “To Set a History Interval” on page 182 for more information.

The Time Editor is displayed (FIGURE 11-1).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Time window is displayed with the Cyclic tab selected.

4. Click the Absolute tab.

The Time window is displayed with the Absolute tab selected.

5. Determine the starting time and date (FIGURE 11-9).

a. Highlight the hour, minute, and if desired, the seconds fields and click the up
or down arrow until the correct time is displayed.

b. Highlight the month, date, and year fields and click the up or down arrow until
the correct date is displayed.

The starting date and time are displayed in the Current Time Expression field.

Note – Time is displayed using the 24-hour clock.
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FIGURE 11-9 Starting Time of 12:00:00 PM on August 20, 1999

6. Click the Apply button.

The starting date and time are displayed in the Time Editor (FIGURE 11-10).
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FIGURE 11-10 Time Editor With Starting Time of 12:00:00 PM August 20, 1999

7. Click the Insert button.

8. Click the Cron tab.

The Time window is displayed with the Cron tab selected.

9. Select the time when the history interval is active.

The software does not check the system load average outside the time specified by

this window. In this example, the condition is at 3:00 AM every Monday through

Friday.

a. Select 0 from the Minute pull-down menu.

b. Select 3rd from the hour pull-down menu.

These first two pull-down menus set the time at 3:00 AM.

c. Select Every from the Day of month pull-down menu.

d. Select Every from the Month pull-down menu.

These two pull-down menus set the date for every day.

e. Select Monday from the final pull-down menu.

The Current Time Expression field reads Cron(03**1). This expression states that

the history window is only active at 3:00 AM every Monday (FIGURE 11-11).
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FIGURE 11-11 Cron Tab Selected With 3:00 AM Every Monday

10. Click the Apply button.

The Time Editor is updated. The Time Expression now states Cron(03**1)

(FIGURE 11-12).
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FIGURE 11-12 Time Editor Selected With Starting Date/Time 12:00:00 PM, August 20, 1999,
and History Interval Start Time of 3:00 AM Every Monday
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11. Place the cursor in the Cron field on the Time Editor screen. Backspace using the
left arrow key until the cursor is between the ending parenthesis and the number
1. Type -5, so that the value in this field now reads Cron(03**1-5).

This expression states that the history interval is only active at 3:00 AM every

Monday through Friday (FIGURE 11-13).

FIGURE 11-13 Time Editor With Starting Date/Time of 12:00:00 PM, August 20, 1999 and
History Interval of 3:00 AM Every Monday Through Friday

12. Click the Apply button.

The Time Editor is updated. In this example, the history window is active at 3:00 AM

every Monday through Friday after the starting date and time of 12:00 PM August

20, 1999 (FIGURE 11-14).

Edit this field to
select a range
of days for the
refresh interval
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FIGURE 11-14 History Interval With Starting Time of 12:00 PM August 20, 1999 and 3:00
AM Every Monday Through Friday
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▼ To Create an Alarm Schedule Using the

Comparison Tab

Note – This procedure is also valid for a module schedule.

1. Click on the Advanced button in the Alarms tab of the Attribute Editor for a data
property.

See “To Create an Alarm” on page 174 for more information.

The Time Editor is displayed (FIGURE 11-1).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Time window is displayed with the Comparison tab selected.

4. Determine the start of the Time Range (9:00 AM).

The time range determines the time period when the software checks the system

load average. The software does not check the system load average outside the time

period specified by this window. In this example, the time range is from 9:00 AM to

5:00 PM every day.

a. Select Hour from the left pull-down menu.

b. Select >= from the middle pull-down menu.

c. Select 9 from the right pull-down menu.

The Time expression Hour>=9 is displayed in the Current Time Expression field

(FIGURE 11-15).
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FIGURE 11-15 Comparison Tab With Greater Than or Equal to 9:00 AM

5. Click the Apply button.

The Time Editor is updated. The Current Time Expression now reads Hour>=9. In

this example, both conditions should occur in the alarm window time range.

However, the Time Editor also enables you to select the Or expression (FIGURE 11-16).
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FIGURE 11-16 Time Editor With Greater Than or Equal to 9:00 AM

6. Determine the end of the Time Range by clicking the Insert button.

The Time window is displayed with the Comparison tab selected.

7. Determine the end of the Time Range (Friday).

a. Select Hour from the left pull-down menu.

b. Select <= from the middle pull-down menu.

c. Select 17 from the right pull-down menu.

The Time expression Hour<=17 is displayed in the Current Time Expression field

(FIGURE 11-17).
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FIGURE 11-17 Comparison Tab With Less Than or Equal to 5:00 PM

8. Click the Apply button.

The Time Editor is updated. The Time expression now reads Hour>=9 And

Hour<=17 (FIGURE 11-18).
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FIGURE 11-18 Time Editor With Time Interval Between 9:00 AM and 5:00 PM

9. Click the Apply button.

The alarm window field in the Attribute Editor is updated. The software will check

the system load average (over five minutes) from 9:00 AM Monday to 5:00 PM

Friday (FIGURE 11-19).
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FIGURE 11-19 Alarms Attribute Editor With Alarm Window From 9:00 AM to 5:00 PM
Every Day
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CHAPTER 12

Managing Modules

This chapter briefly describes the Sun Enterprise SyMON modules and explains how

to manage them.

The following topics are covered:

■ Default Modules

■ To Load a Module

■ To Edit Module Parameters

■ To Disable a Module

■ To Enable a Module

■ To Unload a Module

■ To Set a Module Schedule

■ To Set Security Permissions for a Module

Sun Enterprise SyMON Modules

Sun Enterprise SyMON modules are responsible for collecting data from specific

monitored resources. These modules can be dynamically loaded, enabled, disabled,

and unloaded into a Sun Enterprise SyMON agent.

■ Loading a module adds the module icon to the Browser Details window, defines

the managed object and data properties, and starts data acquisition. The data

properties for the managed object are displayed in the Details window. The data

display is periodically refreshed.

■ Enabling a module restarts data acquisition if the module has been previously

disabled. The data display for the managed object is periodically refreshed in the

Details window.

■ Disabling a module temporarily stops data acquisition for the managed object

until the module is enabled. While a module is disabled, the data is not refreshed.
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■ Unloading a module stops data acquisition for the managed object. The managed

object and data properties are undefined and the module icon is removed from

the Browser Details window.

Default Modules

Some or all of the following modules are loaded by default when you install the

software.

■ Agent Statistics

■ File Scanning

■ MIB-II Instrumentation

■ Kernel Reader

■ Config-Reader (for supported hardware platforms)

Module List

TABLE 12-1 lists generic modules that you can load and use. The list of modules that

is displayed for your system is dependent on the type of platform you have. See

your supplement for more information on platform-specific modules, including the

Config-Reader and Dynamic Reconfiguration module. For information on the other

Sun Enterprise SyMON modules, see Appendix C and Appendix D.

TABLE 12-1 Sun Enterprise SyMON Modules

Module Description

Agent Statistics Provides information about the health of the agent installed on a

host by monitoring the objects, processes and execution of processes

by the agent.

Config-Reader Provides the hardware configuration of the host. Both the physical

view and the logical view require that this module be loaded.

Data Logging

Registry

Provides information about data logging in agents including log

destination, module name, logging interval, and buffer length.

Multiple copies of this module can be loaded.

Directory Size

Monitoring

Enables you to isolate and monitor the size of any directory and its

subdirectories on a host where a Sun Enterprise SyMON agent is

installed. Multiple copies of this module can be loaded.

Dynamic

Reconfiguration

Enables Sun Enterprise SyMON software users to perform dynamic

reconfiguration operations on DR-enabled monitored hosts.
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For more information on modules, see Appendix C.

File Monitoring Monitors selected files on a host. Monitored parameters include file

size and timestamps. Multiple copies of this module can be loaded.

This module requires you to add rows in the data property table.

For more information, see “To Add a Row” on page 146.

File Scanning Scans files on a host for specified patterns. Multiple copies of this

module can be loaded. This module requires you to add rows in the

data property table. For more information, see “To Add a Row” on

page 146.

HP JetDirect Monitors the status of HP printers equipped with a JetDirect card.

Multiple copies of this module can be loaded.

Health Monitor Enables you to monitor various resources usage in your host such

as CPU, disk, NFS, and SMNP.

Kernel Reader Provides kernel statistics, such as CPU details, system call, faults,

streams, disk information, and page information.

MIB-II

Instrumentation

Provides the system, interfaces, IP, ICMP (internet control message

protocol), TCP (transmission control protocol), and UDP (user

datagram protocol) MIB-II (management information base) group

information of the monitored host.

MIB-II Proxy

Monitoring

Provides proxy management of hosts that are running non-Sun

Enterprise SyMON MIB-II SNMP agents. Multiple copies of this

module can be loaded.

NFS File Systems Provides information about the NFS file systems on monitored

hosts by monitoring the amount of disk space occupied by mounted

or unmounted file systems and the amount of used and available

space as well as the file system’s remaining total capacity.

NFS Statistics Monitors the number of NFS calls and RPC (remote procedure calls)

received by the server as well as the status of the transaction

activity on the monitored host. Multiple copies of this module can

be loaded.

Print Spooler Monitors the status of the printer daemon and print queue on the

monitored host as well as the printer devices installed on it.

Process Monitoring Monitors one or more processes on the host. Specifies monitored

processes by matching patterns. Multiple copies of this module can

be loaded. This module requires you to add rows in the data

property table. For more information, see “To Add a Row” on

page 146.

Solaris Process

Details

Displays detailed information of Solaris processes running on a host

where the Sun Enterprise SyMON agent has been installed. The

Process Details window requires that this module be loaded.

TABLE 12-1 Sun Enterprise SyMON Modules (Continued)

Module Description
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Note – The Config-Reader and Dynamic Reconfiguration modules are supported

only on specific hardware platforms. For more information, refer to your

supplement.

Note – Depending on your system hardware, additional modules may be

supported. For more information, refer to the Sun Enterprise SyMON web site:

http://www.sun.com/symon .

Loading Modules

To load a module, follow these steps.

▼ To Load a Module

1. Select the host machine on which the module will be loaded by clicking on the
host machine icon.

Note – If you haven’t selected a host before attempting to load a module, the Load

Module option in the Tools pull-down menu is gray and cannot be used.

2. Open the Load Module dialog by doing one of the following:

■ Click the right mouse button on the selected host icon and highlight Load Module

from the pop-up menu in the hierarchy view (FIGURE 12-1) or the topology view

(FIGURE 12-2).

■ In the main console window, select Tools ➤ Load Module (FIGURE 12-3).

■ In the Details window, select host name and then Module ➤ Load Module

(FIGURE 12-4).
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FIGURE 12-1 Load Module Pop-Up Menu in Hierarchy View
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FIGURE 12-2 Load Module Pop-Up Menu in Topology View

FIGURE 12-3 Tools Menu in Main Console Window
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FIGURE 12-4 Load Module Menu in Details Window

The Load Module dialog is displayed (FIGURE 12-5).
Chapter 12 Managing Modules 215



FIGURE 12-5 Load Module Dialog

The Load Module dialog lists all Sun Enterprise SyMON modules. If a number

appears next to the module name, for example as shown above for the File Scanning

Module, the number indicates the number of existing instances of that module on

your host. An instance is a single word or alpha-character string that is used

internally within the Sun Enterprise SyMON agent to identify uniquely a particular

module or a row within a module.

Note – Some modules can have multiple instances loaded on a host.

Note – You must specify a unique name for each instance when multiple instances

of the same module are loaded.

3. Click the name of the module you want to load.
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4. Click the OK button.

The Module Loader dialog is displayed. The contents of the dialog varies with the

module that is selected. FIGURE 12-6 and FIGURE 12-7 show possible examples of the

dialog.

FIGURE 12-6 Module Loader Dialog For Directory Size Monitoring
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FIGURE 12-7 Module Loader Dialog for Process Monitoring

5. If necessary, type the relevant information into any editable name fields.

For example, the Directory Size Monitoring module requires you to enter the name

of the instance, a description, and the target directory name. (An instance is a single

word or alpha-character string that is used internally within the Sun Enterprise

SyMON agent to identify uniquely a particular module or a row within a module.)

If you do not type in information for a necessary field, the software responds with

an error message and the module is not loaded.

6. Complete this procedure with one of the following actions:
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■ Click OK to accept the changes you have made and close this dialog.

■ Click Reset to undo your changes.

■ Click Cancel to cancel your request.

Note – You can also double-click a module name in the Load Module dialog to load

that module.
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Editing Modules

The Sun Enterprise SyMON software enables you to edit modules by changing

module parameters and enabling or disabling modules.

FIGURE 12-8 Edit Module Pop-Up Menu in Hierarchy View
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FIGURE 12-9 Edit Module Pop-Up Menu in Contents View
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FIGURE 12-10 Edit Module Menu in Details Window

▼ To Edit Module Parameters

1. Select the selected module.

2. Proceed with one of the following:

■ Click the right mouse button and highlight Edit Module from the pop-up menu in

the hierarchy view (FIGURE 12-8) or the Contents view (FIGURE 12-9).

■ In the Details window, select Module ➤ Edit Module (FIGURE 12-10).

The Module Parameters Editor is displayed.

3. Type the relevant information into the editable fields.

FIGURE 12-11 shows an example. The actual display varies with the module that is

selected.
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FIGURE 12-11 Module Parameter Editor

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Reset to reset the module to the default parameters.

■ Click Cancel to cancel your request.
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▼ To Disable a Module

● Click the right mouse button on the selected module and highlight Disable
Module from the pop-up menu in the hierarchy (FIGURE 12-8) or Contents view
(FIGURE 12-9).

OR

● In the Details window, select Module ➤ Disable Module (FIGURE 12-10).

When the module has been disabled (turned off), the following message is displayed

at the bottom of the Details window (FIGURE 12-12).

FIGURE 12-12 MIB-II Instrumentation Module Is Disabled

If the disabled module is the Solaris Process Details module, the following message

is displayed at the bottom of the Details window.

▼ To Enable a Module

● Click the right mouse button on the selected module and highlight Enable
Module from the pop-up menu in the hierarchy (FIGURE 12-8) or Contents view
(FIGURE 12-9).

OR

Module successfully disabled.

Solaris Process Details module disabled. Process data may not be
current.

This icon indicates the module is disabled
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● In the Details window, select Module ➤ Enable Module (FIGURE 12-10).

When the module has been enabled (turned on), the following message is displayed

at the bottom of the Details window.

▼ To Unload a Module

1. Proceed with one of the following:

■ Click the right mouse button on the selected module and select Unload Module

from the pop-up menu in the hierarchy view (FIGURE 12-8) or the contents view

(FIGURE 12-9).

■ In the Details window, select Module ➤ Unload Module (FIGURE 12-10).

The Confirm Module Unload dialog is displayed (FIGURE 12-13).

FIGURE 12-13 Unload Module Dialog

2. Click the Unload button to remove the module or the Cancel button to cancel this
request.

Module successfully enabled.
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Monitoring Modules

Tip – If you want to monitor one type of module on a number of hosts, you can

create module objects for each host and place all of the objects in a common location

(that is, in the same group or domain). To create a module object, see “To Create a

Module Object” on page 75.

Attribute Editor for a Module

The Attribute Editor for a module provides additional information about the module

and enables you to customize various monitoring criteria. You can use the module

Attribute Editor to set:

■ Module schedules

■ Security permissions

Note – The Attribute Editor consists of a series of one or more tab buttons at the top

of the window that enables you to switch between different panels. The buttons that

are displayed are dependent on the selected object.

Setting a Module Schedule

You may determine when a module should be active and when it should be inactive

by setting a schedule. For example, you can schedule a module to run between

8:00 AM and 5:00 PM every day. At all other times, the module is inactive, whether

or not an alarm condition exists.

▼ To Set a Module Schedule

1. Open the Attribute Editor for a module by proceeding with one of the following:

■ Click the right mouse button on the selected module icon and highlight Attribute

Editor from the pop-up menu in the hierarchy view (FIGURE 12-1) or the topology

view (FIGURE 12-2).
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■ In the Details window, click the Attributes button.

2. Click the Schedule tab (FIGURE 12-14).

3. Click the Advanced button and set the module schedule.

See “Using the Time Editor” on page 185 for details.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 12-14 Setting a Module Schedule
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Setting Security Permissions for a Module

You can set security permissions for an individual module.

The security permissions for a module override the default security permissions for

its parent object or host. For example, if a user has administrator privileges for a

module, but only general privileges for the host, the user still retains administrator

privileges for the module. For further information on privileges, see Chapter 15.

▼ To Set Security Permissions for a Module

1. Open the Attribute Editor for a module by proceeding with one of the following:

■ Click the right mouse button on the selected host icon and highlight Attribute

Editor from the pop-up menu in the hierarchy view (FIGURE 12-1) or the topology

view (FIGURE 12-2).

■ In the Details window, click the Attributes button.

2. Click the Security tab (FIGURE 12-15).

3. Type the name(s) of user and administrator groups in the appropriate fields.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 12-15 Setting Module Security in the Attribute Editor
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CHAPTER 13

Alarms

This chapter provides details on alarms.

The Sun Enterprise SyMON software monitors your hardware and software and

notifies you, through alarms, when abnormal conditions occur. These alarms are

triggered by conditions falling outside of predetermined ranges, or by Sun

Enterprise SyMON rules. Default alarm conditions and rules are included in the

modules. In addition, you may also set up your own alarm thresholds. For a list of

Sun Enterprise SyMON rules, see Appendix E.

This chapter explains alarms with the following topics:

■ Sun Enterprise SyMON Alarms

■ Types of Alarms

■ Notifying Users That a Host or Agent is Down

■ To Set Up User Notification for Down Host or Agent

■ Creating Alarms

■ Viewing Alarm Information

■ Colored Alarm Icons

■ Seeing Alarms in Domain Status Summary

■ To Access Alarms from the Main Console Window

■ Information on Alarms

■ To Access Alarms from the Alarms Tab in the Details Window

■ Alarm Categories

■ Alarm States

■ To View Alarm Categories

■ To Sort Alarms

■ To Reset the Alarm Table

■ Acknowledging and Deleting Alarms

■ To Acknowledge and Delete Alarms

■ Creating Alarm Conditions

■ To Create Alarm Conditions To Monitor Hosts
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Note – The messages displayed in the Alarms tab of the Details window are always

in English. They are not translated in other languages.

Sun Enterprise SyMON Alarms

The software displays alarm information for managed objects. To access information

on alarms for an object, access the Alarms Details window. This window displays

alarms for a particular object.

Note – The Sun Enterprise SyMON agent is configured so that only one server

receives alarm information from that agent.

You can acknowledge, delete, and manage the alarms on an object in a domain by

using the Alarms Details window. For more information, see “To Access Alarms

from the Alarms Tab in the Details Window” on page 244.

Types of Alarms

Managed object status is displayed in the Domain Status Summary from the main

console window (FIGURE 13-1).

FIGURE 13-1 Domain Status Summary in the Main Console Window

Domain Status Summary buttons
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The numbers next to the alarm icons indicate the number of managed objects whose

highest severity open, unacknowledged alarm is represented by the icon. For

example, the number 1 next to the yellow alarm icon indicates that there is a

managed object whose highest severity alarm is yellow (alert). The severity of

alarms are designated by icons. The different icons represent different severities

(FIGURE 13-2).

FIGURE 13-2 Alarm Severities

Down Alarms

A down alarm (severity 1 in FIGURE 13-2) indicates that a service-affecting condition

has occurred and an immediate corrective action is required. An example of this

condition is when a resource defined by a managed object has gone out of service

and that resource is required; for example, a module has gone down (exited).

Down alarms are represented by black alarm icons with a down arrow.
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Critical Alarms

A critical alarm (severity 2 in FIGURE 13-2) indicates that a service-affecting condition

has developed and an urgent corrective action is required. An example of this

condition is when a severe degradation in the capability of an object has occurred

and the object needs to be restored to full capability.

Critical alarms are represented by red alarm icons.

Alert Alarms

An alert alarm (severity 3 in FIGURE 13-2) indicates that a non-service-affecting

condition has developed and a corrective action should be taken in order to prevent

a more serious fault.

Alert alarms are represented by yellow alarm icons.

Caution Alarms

A caution alarm (severity 4 in FIGURE 13-2) indicates the detection of a potential or an

impending service-affecting fault, before any significant effects have occurred.

Action should be taken to diagnose further (if necessary) and correct the problem in

order to prevent it from becoming a more serious service-affecting fault.

Caution alarms are represented by blue alarm icons.

Off/Disabled Alarms

A disabled alarm (severity 5 in FIGURE 13-2) indicates that a resource for a managed

object has been disabled; for example, a module is disabled.

Disabled alarms are represented by white alarm icons with an ‘X’.

Note – Objects with black star icons, that may look like a “splat” on your screen, are

objects with irrational states, not to be confused with alarms, where the status of the

object is unknown or undetermined.

If the black star or splat icon shows up in the main console window, it indicates that

the object is in an irrational state. This means that there has been a data acquisition

failure on that object. The failure does not come out of a rule so there is no alarm

associated with it.

An example of this is presented in FIGURE 13-3.
234 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



FIGURE 13-3 Objects with Irrational States Identified by Black Star or “Splat” Icon

Note – When you view the data property table for the object, a row colored pink is

another indication that you have an irrational state for the object.

Notifying Users That a Host or Agent is
Down

You can configure the Sun Enterprise SyMON software to send you an email

notification if a host or agent is down. You can notify:

■ yourself only

■ several people, or

■ all email recipients linked to the group to which the host or agent belongs

Black splat
icons
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▼ To Set Up User Notification for Down Host or

Agent

1. In the main console window, select the host or group of hosts that you want to
receive notification about if the host or agent is down.

2. Click the right mouse button to display the pop-up menu, and select Alarm Action
(FIGURE 13-4).

FIGURE 13-4 Pop-Up Menu in Hierarchy View

The Alarm Action version of the Attribute Editor is displayed (FIGURE 13-5).

3. Enter the email address and username to be notified for the host down, and agent
down condition.

To notify more than one person, use the format email username1, username2,
and so on.
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4. To include any email users who are linked to the down host or agent group, click
“yes” in the Include Group Actions - Host Down or Agent Down fields. When you
have made all the changes, click Apply.

For example, MachineA is selected as the object for which notification is to be

received in FIGURE 13-4. MachineA belongs to the group mpk12. Any user monitoring

a machine in group mpk12 would be included in a group notification for MachineA.
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FIGURE 13-5 Attribute Editor - Alarm Action

5. Click OK to close the Attribute Editor - Alarm Action screen.
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Creating Alarms

The software offers the following flexibility in setting your alarms:

■ Determine the thresholds that trigger an alarm of a particular severity

■ Determine when alarms are sounded (for example, only on weekdays)

For more information on creating alarms, see “To Create an Alarm” on page 174.

Viewing Alarm Information

Sun Enterprise SyMON software uses four methods (FIGURE 13-6) to alert you that an

unacknowledged open alarm condition exists:

■ Relevant row or column is colored in the property table (contents view)

■ Colored icons in the hierarchy (tree) view

■ Colored icons in the topology view

■ Alarms in Domain Status Summary

Colored Alarm Icons

The type of alarm icon determines the severity of the alarm. For example, a red

alarm icon indicates a critical condition has developed and corrective action is

required right away. By contrast, a blue alarm icon indicates a potential or an

impending service-affecting fault.

In FIGURE 13-6, there is an unacknowledged, open critical alarm in the Swap Statistics

properties table, in the Used KB row. The row is shaded red, which corresponds to

the color of a critical alarm.

The following illustration presents alarms in the Details window.
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FIGURE 13-6 Alarms in the Details Window

The colored alarm icons are propagated up the hierarchy tree view, from the

individual module up to the host. For example, in FIGURE 13-6, there is an

unacknowledged, open error condition (critical alarm) in the Swap Statistics icon.

You see this same red alarm icon on the Swap Statistics icon, on the Kernel Reader

icon module, on the Operating System icon, and the host icon.

In addition, you also see a red alarm icon on the corresponding host, group (if any),

or domain in the main console window unless an unacknowledged open black alarm

(of higher severity) exists.

Note – Unacknowledged alarms take precedence over acknowledged alarms. If

there are two or more types of alarms in the hierarchy, the color of the more severe

unacknowledged alarm is propagated up the tree. For example, if there is a yellow

unacknowledged alarm in CPU usage, and a red unacknowledged alarm in Disk

Statistics, only the red colored alarm icon is propagated. However, if there is a

yellow unacknowledged alarm in CPU usage, and a red acknowledged alarm in Disk

Statistics, only the yellow colored alarm icon is propagated.
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FIGURE 13-7 Alarms in the Contents View

Seeing Alarms in Domain Status Summary

The Domain Status Summary button panel displays the number of managed objects

in the domain that have at least one unacknowledged open alarm of that severity.

Note – If there are two or more types of alarms in the host, the color of the more

severe unacknowledged open alarm is displayed in the Domain Status Summary.

If the most severe alarm on one host is critical (red) and the most severe alarm on

another host is alert (yellow), then you see the number 1 next to both the red-colored

alarm icon and the yellow-colored alarm icon.

FIGURE 13-8 Domain Status Summary Buttons
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▼ To Access Alarms from the Main Console

Window

1. Click on one of the Domain Status Summary buttons in the main console window.
(FIGURE 13-8).

A list of objects which have at least one open, unacknowledged alarm, whose

highest severity is that of the icon on the button, is displayed in the Domain Status

Details window (FIGURE 13-9).

For example, if you click on the button with the yellow alarm icon (alert alarms), the

Domain Status Details window displays a list of objects whose highest severity,

unacknowledged, open alarms are yellow (alert). The number of objects displayed is

equal to the number on the button (within approximately a five second delay

period).

2. Complete this procedure with one of the following actions:

■ Double click on the row in the table.

■ Single click on the row to select it, and then click the Details button.

The Alarms Details window is displayed (FIGURE 13-10).
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FIGURE 13-9 Domain Status Details Window

Information on Alarms

The Alarms tab in the Details window presents a table that contains the statistical

summary of all alarm data for a given managed object.

Note – If the object is a platform, see your supplement for more information.
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▼ To Access Alarms from the Alarms Tab in the

Details Window

1. Click with your right mouse button on the selected host icon in the main console
window and highlight Details from the pop-up menu.

The Details window is displayed.

2. Click on the Alarms tab button.

The Alarms Details window is displayed (FIGURE 13-10).

FIGURE 13-10 Alarms Tab Data from the Details Window
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Alarm Categories

The Alarms tab presents different categories of detailed alarm information. Some of

this information is always displayed in the alarms table (TABLE 13-1) while additional

information is displayed when an alarm row is highlighted (TABLE 13-2).

Note – Acknowledged alarms are indicated with a green check in the Severity

column.

Alarm States

There are also two different alarm states:

■ Open

■ Closed

An Open alarm is one in which the condition which caused the alarm still exists. A

Closed alarm means the condition no longer exists. Open alarms are “ringing” while

closed alarms are “silent” (FIGURE 13-11).

TABLE 13-1 Alarm Categories Displayed in Table

Category Description

Severity Graphic indicator whose color indicates the severity of the alarm;

black is most severe and white is least severe

Start time Time the alarm first occurred

State Open or closed

Message Abbreviated message that indicates the type of alarm

TABLE 13-2 Additional Alarm Information Displayed When a Single Row is Selected

Category Description

Condition began on Date/Time the alarm condition has started

Condition ended on Date/Time the alarm condition has been fixed

Acknowledged on Date/Time the alarm was acknowledged by a particular user

Rule Name that identifies the rule file which caused the alarm (for

example, a rule number). For non-rule based alarms, the name

rCompare is used.
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FIGURE 13-11 Open and Closed Alarms

▼ To View Alarm Categories

The Alarm Details window has an option that enables you to filter on an alarm

category and show a subset of the alarms.

1. Click on the Show button below the Table actions field.

The Show Specific Alarms window (FIGURE 13-11) is displayed.

2. Click on the appropriate tab to filter your alarm request.

The selected tab is darkened.

Note – If you want to see all the alarms in the alarms table, simply click the Show

All button.

3. Click on the Severity tab (FIGURE 13-2).

The Severity tab enables you to show alarms of the selected severity.

4. Click on the check box next to a severity to show alarms of that severity.

The selected severity has a check in the check box next to its name.
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Note – You may select one or more types of severity to show in the alarms table.

5. Click on the State tab (FIGURE 13-11).

The State tab enables you to show open and closed alarms.

6. Click on Open or Closed to show these types of alarms.

The selected state has a check in the check box next to its name.

Note – You may select open, closed, or both to show in the alarms table.

7. Click on the Acknowledge tab.

The Acknowledge tab enables you to show acknowledged and unacknowledged

alarms.

8. Click on Acknowledged or Unacknowledged to show these types of alarms.

The selected state has a check in the check box next to its name.

Note – You may select acknowledged, unacknowledged, or both to show in the

alarms table.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

▼ To Sort Alarms

You can sort the alarm rows in the table (FIGURE 13-12).
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FIGURE 13-12 Sort Alarm Table

1. Click on the Sort button below the Table actions field.

The Sort Alarm Table window is displayed.

2. Select your sort feature by clicking in the circle next to your selection.

You may sort by starting time (from the newest alarm to the oldest alarm), by

severity (from the most severe to the least severe), or by state (with open alarms

listed first, followed by closed alarms).

The selected sort feature has a darkened circle next to its name.

3. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

▼ To Reset the Alarm Table

● Click the Reset button.

The alarm table is dynamically updated as new alarms are displayed and some

existing ones close. These updates are displayed, regardless of what is selected as the

Show button viewing options. As these conditions occur over time, the table may no

longer reflect the current Show settings. Clicking the Reset button will update the

table to reflect the current Show settings once again.
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Acknowledging and Deleting Alarms

You may update information about alarms in the Alarms Details window.

▼ To Acknowledge and Delete Alarms

1. Select the alarms you want to update by clicking the selected row(s) in the table.

Clicking the selected row(s) displays additional information associated with that

alarm. The additional information consists of the starting time of the alarm, the

ending time of the alarm, the acknowledgment time and the user who

acknowledged the alarm, and the rule.

Note – You may select several rows at once by holding down your mouse button

and moving the mouse over the selected rows. If, after you selected several rows,

you want to skip a few rows and select other rows, simply hold down the Control

key and select the additional rows.

2. Click the appropriate button under the Alarm actions field.

You may perform the actions listed in TABLE 13-3.

Note – You can delete open alarms, but the potential exists for alarm information in

the Alarms windows to differ from alarm information in the hierarchy view and the

topology view. That is, the alarms are deleted from the alarms table, but the alarm

icons may still be present in the hierarchy and topology views. An example of when

this action may be required would be in the case of an unloaded module. Orphaned

alarms may remain in view and may need to be manually deleted.

TABLE 13-3 User Actions That Can Be Performed on Alarms

User Action Description

Acknowledge User and time of acknowledgment is registered. When an alarm is

acknowledged, the alarm icon in the Severity column has a green

check mark beside it.

Delete Deletes all the selected alarms from the table. The deleted alarm(s)

is saved into an archive file on the server.

Delete all Deletes all the closed alarms from the table. The deleted alarm(s) is

saved into an archive file on the server.
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Caution – You should only delete open alarms when there is no other method to

remove these alarms.

Creating Alarm Conditions

Sun Enterprise SyMON software enables you to create alarm conditions that help

you to monitor the hosts in your domain. The main purpose of this section is to help

you create alarm conditions and familiarize yourself with their operation. This will

help you control alarm conditions.

▼ To Create Alarm Conditions To Monitor Hosts

1. Navigate through the Operating System modules until you see the User Statistics
icon (part of the Kernel Reader module).

2. Select Attribute Editor from the pop-up menu.

The Attribute Editor enables you to edit information about this property.

3. Create an alarm condition by following the procedure in “To Create an Alarm” on
page 174.

4. Click on the Alarms tab button in the Details window.

The alarm you created should be reflected in the Alarms table.

5. Acknowledge, then delete this alarm if the alarm is closed.

6. Create additional alarm conditions and familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that

another Sun Enterprise SyMON user cannot change your alarm thresholds. For

information on accomplishing this task, see Chapter 15.
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CHAPTER 14

Details

The Sun Enterprise SyMON Details window provides detailed information about a

selected object.

The following topics are covered in this chapter unless noted otherwise:

■ Starting the Details Window

■ Info Tab

■ Browser Tab (covered in Chapter 8)

■ Alarms Tab (covered in Chapter 13)

■ Processes Tab

■ Configuring the Process Display

■ Process Statistics Window

■ Process Summary Field

■ Log View Tab

■ Filtering Your Messages

■ Finding Specific Log Messages

■ Configuration Tab

■ Resources

■ Physical View

■ Logical View

The Details window displays several tab buttons. The commonly seen buttons are

shown in TABLE 14-1.

Clicking a tab button updates the window with the panel for that tab.
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Note – The tab buttons that are displayed in the Details window are dependent on

the type of object selected. For example, the Configuration tab is missing if the

Config-Reader module is not supported on your system. For additional information

on the tabs for your specific hardware object, see your supplement.

TABLE 14-1 Common Details Window Tab Buttons

Tab Button Description

Info Provides general information such as host name, IP address, and

polling type.

Browser Enables you to navigate through the hierarchy and contents views

of the hardware, operating system, local applications, and remote

systems (for navigation purposes). (The Browser is covered

separately in Chapter 8.)

Alarms Displays alarm status messages and the alarm controls for the host

or node. Enables you to acknowledge or delete alarms. (Alarms are

covered separately in Chapter 13.)

Processes Displays information about processes running in the host.

Log View Displays entries from host log files (such as system message logs).

Configuration Displays configuration information (resources, physical view,

logical view, and dynamic reconfiguration status and controls), if

available, for a host.
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Starting the Details Window

You can start the Details window from the main console window.

▼ To Start the Details Window

1. Double click the left mouse button on an object icon in either the hierarchy view
or the topology view.

Be sure to select an object, not a domain, as the Details window is not available for

domains.

The Details window is displayed (FIGURE 14-1).
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FIGURE 14-1 Details Window for a Selected Object

2. Click a tab to view detailed information for that category.

Tip – Some tabs have the ability to display many levels of detail. Double-click icons

in the Details window to see additional levels of information. A category may have

many subcategories.

Tip – If information in a table cell is too long to be displayed in full, you may be

able to see more information by holding the mouse pointer in the cell for several

seconds. A pop-up balloon (tool tip) is displayed, showing the complete text

contained in that cell.
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Tip – If the hierarchy view has a light-colored circle next to an icon (FIGURE 14-2),

you can click the circle or double-click the icon next to the circle to expand the

hierarchy view (“unroll” and display more levels of detail).

FIGURE 14-2 Light-Colored Circles “Unroll” to Provide Additional Levels of Detail

▼ To Close the Details Window.

● Click the Close button located at the bottom of the window.

Circle
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Info Tab

Clicking the Info tab displays the Properties table.

The general properties are listed in the following table.

Browser Tab

The Browser tab displays hierarchy and contents views of the hardware, operating

system, local applications, and remote systems.

See Chapter 8 for detailed information on using the Browser tab.

TABLE 14-2 General Properties in the Info Tab of the Details Window

Property Description

Entity Desc Label that you selected when you created the node.

Entity Full Desc Optional description you entered when you created the node.

Hostname Machine name.

IP Address IP address.

Netmask Netmask associated with the host.

Operating System Operating system type and version.

Entity Family Hardware architecture.

Entity Trap Destination Host IP address of Sun Enterprise SyMON server which

receives this host’s trap information.

Entity Event Destination Host IP address of Sun Enterprise SyMON server which

receives this host’s events information.

Entity Polling Type Agent or SNMP.

Target Hostname Host name of the target.

Target IP Address IP address of the target.
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Alarms Tab

The Alarms Details window displays the alarms for the host.

See Chapter 13 for detailed information on using Sun Enterprise SyMON alarms.

Processes Tab

The Processes tab process viewer (FIGURE 14-3) enables you to view and select

detailed information about processes running on the selected host or node. The

displays are continually updated.

Note – The Solaris Process Details module must be loaded to use the process

viewer. For instructions, see “To Load a Module” on page 212.

Note – If the Solaris Process Details module is not loaded when you first click the

Processes tab, then you must load the module, and close then reopen the Details

window to see the processes. Thereafter, the Solaris Process Details module is

unloaded or loaded dynamically. That is, you no longer need to close and reopen the

Details window to see the processes whenever this module is unloaded or loaded.
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FIGURE 14-3 Processes Tab
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Configuring the Process Display

▼ Selecting Columns for Viewing

1. Click the View Columns button above the Process table to display the View
Columns pull-down menu.

A pull-down menu is displayed (FIGURE 14-4) that enables you to add or remove

columns from the table.

FIGURE 14-4 View Columns Menu
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2. Highlight one or more process properties that you want to display.

The check box next to each selected property is displayed with a check mark

(FIGURE 14-4) and the right side of the Process Viewer window is updated. The new

column or columns are added to the display, to the right of the existing columns.

The total number of processes displayed is listed in the Process Summary field at the

bottom of the Details window.

TABLE 14-3 lists the properties that are available for the Processes view.

TABLE 14-3 Process Viewer Properties

Property Description

PID Process Identifier.

PPID Process ID of the parent.

UID Effective user ID number.

User Effective user login name.

EUser Effective user ID.

Group ID Group ID of the user.

EGroup Effective group ID of the user.

Session ID Process ID of the session leader.

PGroup Process ID of the process group leader.

Tty Controlling terminal for the process. A question mark (?) is printed

when there is no controlling terminal.

Start time Starting time of the process, in hours, minutes, and seconds. (The

start time for a process that is more than 24 hours old is given in

months and days.)

Time Cumulative execution time for the process.

State State of the process.

Wait Channel Address of an event for which the process is sleeping. If blank, the

process is running.

Class Scheduling class of the process.

Address Memory address of the process.

Size Size (in pages) in main memory for the image of the swappable

process.

Priority Priority of the process.

Nice Decimal value of the system scheduling priority of the process.
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Sorting Columns

You can sort the processes (rows) by the properties (column headers) in ascending or

descending order. For example, you can sort the CPU% column starting with either

the smallest or the largest value first.

▼ To Sort Columns in Ascending Order

● Click the property (table column header).

The processes (rows) are updated in ascending order for that property.

▼ To Sort Columns in Descending Order

● Click the property (table column header) while holding down the Shift key.

The processes (rows) are updated in descending order for that property.

Moving Columns

You can rearrange the order of columns.

▼ To Reorder Columns in the Table

1. Select a column by clicking and holding down the mouse button on the table
column header.

2. Drag the column to the desired position.

CPU% Ratio of CPU time used recently to CPU time available in the same

period, expressed as a percentage.

Memory% Ratio of the process’s resident set size to the physical memory on

the machine, expressed as a percentage.

Command Command name.

CommandLine Full command name and its arguments, up to a limit of 80

characters.

TABLE 14-3 Process Viewer Properties (Continued)

Property Description
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Process Statistics Window

The Output For Process ID window displays statistics for your choice of either

pmap, pstack, pfiles, or pldd for any highlighted process in the Process View

window.

Process Summary Field

The Process Summary field lists statistics for all processes, active or inactive.

TABLE 14-4 Process Statistics

Statistic Description

pmap Prints the address space map of each process.

pstack Prints a stack trace for each lightweight process (lwp) in each

process.

pfiles Reports fstat(2) and fcntl(2) information for all open files in

each process.

pldd Prints dynamic libraries for the process.
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Log View Tab

The log viewer (FIGURE 14-5) enables you to view system log messages and logged

error messages from the Sun Enterprise Diagnostics (EntDiag) software.
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FIGURE 14-5 Logview Tab
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Log File Type Button

You can view two types of messages:

■ System log messages stored in the /var/adm directory

■ EntDiag error messages

File names in the /var/adm directory start with the word “messages”. If the

EntDiag software is installed, it logs error messages by default to the

/var/opt/SUNWentdiag/logs/entdiag.err file.

▼ To View the Log File Messages

● Click the down arrow under the Log file type field and highlight either Syslog or
EntDiag.

The selected type of messages is displayed in the log viewer table.

Note – Click the Reload button to refresh the display and add the latest log

messages.

Filtering Your Messages

You can apply filters to display only those messages that match the date range and

text pattern that you specify.

▼ To Filter Your Log Request

1. Click the Filter button in the log viewer (FIGURE 14-5).

The Message Filter Options dialog is displayed (FIGURE 14-6).
Chapter 14 Details 265



FIGURE 14-6 Message Filter Options Dialog

Note – If you do not want any filters applied to your log messages, click the “No

Filters” button.

2. Using the down arrows, select the starting date by highlighting the month, day,
and year for the first log message you want to view.

3. Select the starting time by using the down arrows.

Highlight the hour and minute for the first log message you want to view.

4. Select the ending date.

Highlight the month, day, and year for the last log message you want to view.

5. Select the ending time.

Highlight the hour and minute for the last log message you want to view.

6. Type the text pattern to be matched in the field marked “Text pattern to match.”
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Note – Select a text pattern that is unique to the type of message in which you are

interested.

7. Click the Advanced button if you want to refine further your filter request.
Otherwise, skip to Step 10.

The advanced Message Filter Options dialog is displayed (FIGURE 14-7).

FIGURE 14-7 Advanced Message Filter Options Dialog

8. To perform a forward or backward search through the log file, select Forward or
Backward.
Chapter 14 Details 267



9. (Optional) Type the maximum number of log messages that should be matched in
the field marked Maximum matches to report.

If you leave the field empty or if you enter zero (0), all matching messages are

reported.

10. Complete this procedure with one of the following actions:

■ Click OK to filter and reload your log messages and close this window.

■ Click Apply to filter and reload your log messages without closing this window.

■ Click Reset to reset to the default parameters.

■ Click Cancel to cancel your request.

Reload Button

Click the Reload button to refresh and reload filtered messages.

Monitor Button

Monitoring enables you to view new log messages as they occur. The new messages

are displayed in the lower half of the split pane window. With your mouse button,

you can adjust the dividing bar between the upper half and the lower half of the

split pane window to view more of one half than the other. Each new message that

arrives is highlighted.

▼ To Monitor Log Messages

1. Click the Monitor button in the log viewer (FIGURE 14-5).

The Monitor Filter Options dialog is displayed (FIGURE 14-8).
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FIGURE 14-8 Monitor Filter Options Dialog

2. Click the appropriate circle to enable or disable log file monitoring.

The darkened circle indicates your choice.

3. To display only currently monitored log messages, click the check box to clear old
monitored messages.

The check box is displayed with a check mark.

4. Type the text pattern to be matched in the field marked Text pattern to match.

You can use a UNIX regular expression. For information about regular expressions,

refer to the regex(1F) man page.

Note – Select a text pattern that is unique to the type of message in which you are

interested.

5. Complete this procedure with one of the following actions:

■ Click OK to monitor your log messages and close this window.

■ Click Apply to monitor your log messages without closing this window.

■ Click Cancel to cancel your request.

Finding Specific Log Messages

Once a set of filter messages has been loaded into the upper half of the split pane

window, you can search for a specific character sequence within that set of messages.
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Note – No meta characters, including the wildcard asterisk (* ) character, are

supported in the log view find feature.

▼ To Find a Log Message

1. Type the specific character sequence (part of the log message) in the Find field
(FIGURE 14-5).

2. Click Return or the down or up arrow to search the log messages for that
sequence.

The first matching message is highlighted.

3. Click Return or the down or up arrow to continue your search and find additional
occurrences of the matching sequence.

Configuration Tab

Note – The Configuration tab is missing if this feature is not supported on your

system.

The Configuration Details window (FIGURE 14-9) provides three choices for system

information:

■ Resources (default view)

■ Physical View

■ Logical View

Note – For additional information on the Configuration tab for your specific

hardware object, see your supplement.
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FIGURE 14-9 Configuration Details Window

▼ To View a Configuration

Note – If you load or unload the Config-Reader or Dynamic Reconfiguration

modules while the Details window is open you must close, then reopen the Details

window to see the results.

● Click once to highlight the configuration in which you are interested.

The right side of the window is updated and the selected feature is displayed.
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Resources

The Sun Enterprise SyMON software displays a table of hardware resources of the

selected host (FIGURE 14-9). Here are some typical values displayed in the table.

Your table may appear different. The resources vary, depending on the type of object

displayed in the detail view.

TABLE 14-5 Resources

Resource Description

Total Disks Total number of disks connected to the host

Total Memory Total amount of memory connected to the host

Total Processors Total number of processors connected to the host

Total Tape Devices Total number of tape devices connected to the host
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Physical View

When you select the Physical view, the software displays a photo-realistic picture of

the selected host (FIGURE 14-10), if available. Pictures are not available for some

system types.

Note – This feature is usable only if the host is monitored by a Sun Enterprise

SyMON agent.

FIGURE 14-10 Configuration Physical View
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View Points

If a picture of the system is available, it is displayed. For some systems, you can

select alternate front, rear, and side views by selecting entries in the View Points

pull-down menu. Pictures are not available for some system types.

For some systems, pictures of components such as CPU boards and I/O boards may

also be available. As you move the mouse pointer over various parts of the system

picture, the mouse pointer changes from an arrow to a hand icon when a detailed

picture is available for an individual component. The individual component is

highlighted, and the path name of the component is displayed in the Component

field at the bottom of the window. Click a highlighted component to display the

detailed picture of the component (FIGURE 14-11).

FIGURE 14-11 Component Physical View
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The arrow buttons below the picture enable you to switch between system and

component views.

Physical View When a Sun StorEdge Device is Connected

If a Sun StorEdge™ A5000, A5100, or A5200 is connected to the clicked component,

a pop-up menu displays, which lists the devices that are connected. The Sun

StorEdge A5000-series devices are displayed on this menu as sena(0), sena(1), and so

on, as shown in the following figure.

FIGURE 14-12 Pop-up sena Menu
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You can select and view any of these storage devices from the pop-up sena menu.

The following example shows the front view for the A5000 called sena(0). The device

details display in the right section of the physical view window.

FIGURE 14-13 sena (0) Physical View with Details

Dynamic Reconfiguration

The Dynamic Reconfiguration button is displayed in the physical and logical views

only for certain platforms. Refer to your hardware supplement for more information.
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Show Details

Clicking the Show Details button (see FIGURE 14-10) displays the Property/Value

view (FIGURE 14-14), which displays text describing the component that is selected in

the View Points view. The button toggles between Show Details and Hide Details.

Clicking the Hide Details button turns off the Property/Value view.

Note – After you show details for a component, you may click Refresh to update the

information immediately. Otherwise, the information does not change from when

you first opened the physical view.

Note – The Total Disks field in the Show Details properties only displays the

number of internal disks. This number does not include the disks that are part of

enclosures.

FIGURE 14-14 Property/Value View
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Logical View

The software displays a Logical view configuration of a host (FIGURE 14-15) if the host

is monitored by a Sun Enterprise SyMON agent. (Logical views are not available for

ping hosts.)

FIGURE 14-15 Configuration Logical View

Search

Clicking the Search button displays the Search window (FIGURE 14-16). Use the

Search window to search for components in the Logical View window.
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FIGURE 14-16 Search Window

Tip – The Search function is case-sensitive. The error message “Node not found” is

displayed at the bottom of the Details window if the search does not locate the

component in your system.

Tip – The Search function stops at the first instance found. For example, if you enter

the word board , Search always stops at board(0) . To find board #2, enter enough

of the board name. For example, board(2) or just ard(2) are sufficient to identify

the specific target uniquely.

Dynamic Reconfiguration

The Dynamic Reconfiguration feature in the Logical View is the same as is described

in the previous section, “Physical View” on page 273.

Show Details

The Show Details feature in the Logical View is the same as is described in the

previous section, “Physical View” on page 273.
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CHAPTER 15

Sun Enterprise SyMON Security

Security in Sun Enterprise SyMON software is based on Java™ security classes and

SNMPv2 usec (SNMP version 2, user-based security model) security standards. This

chapter discusses security features, users and groups, and their privileges.

The software offers the following layers of security:

■ Only valid Sun Enterprise SyMON users can use the software.

■ The software enables you to set security permissions or access control categories

and provides control at the domain, group, host, and module levels.

■ It authenticates user login and access control for individual managed properties.

This chapter contains the following information:

■ Access Control (ACL) Categories

■ Sun Enterprise SyMON Users

■ Sun Enterprise SyMON Groups

■ Admin, Operator, and General Functions

■ Specifying Access Control (ACL)

■ Admin, Operator, and General Access

■ Sun Enterprise SyMON Remote Server Access

■ Using Access Control (ACL)

■ To Add Sun Enterprise SyMON Users

■ To Access ACL on a Module

■ To Add a User-Defined Group to an ACL

■ To Delete Sun Enterprise SyMON Users

■ Default Privileges

■ Topology Manager Default Privileges

■ Other Sun Enterprise SyMON Component and Module Default Privileges

■ Overriding the Default Privileges

■ To Override Default Privileges
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Access Control (ACL) Categories

The software offers the following Access Control (ACL) categories:

■ Admin, like the superuser (root ) in UNIX

■ Operator, as an operator who runs and monitors the system

■ General, like guest access with read-only viewing privileges

To understand ACL categories, we first need to understand Sun Enterprise SyMON

software users and groups. The following sections explain users and groups.

Sun Enterprise SyMON Users

Sun Enterprise SyMON users are valid UNIX users on the server host. As such, the

system administrator has to add valid users into the following file;

/var/opt/SUNWsymon/cfg/esusers.

If a user’s name is not in this file, that user cannot log into the Sun Enterprise

SyMON software unless the user logs in as espublic or esmaster since these two

user names are part of this file. (See the following section for more information.)

Public and Private Users

During the Sun Enterprise SyMON server setup, the file /var/opt/SUNWsymon/
cfg/esusers is created and the following users are added to the file automatically:

■ espublic
espublic is comparable to logging into a UNIX system as guest . It enables

users to have “general” privileges. For example, when a user tries to access

information from a session running in a different Sun Enterprise SyMON server

from their own, they are given access as espublic and are able to view the

information as a guest only.

■ esmaster
esmaster is comparable to being superuser in UNIX. It automatically gives

“admin” access privileges to users logging into the software.

The administrator has to add the additional list of user IDs for all other users who

need to log into Sun Enterprise SyMON software. All users in this file have

“general” access privileges, by default, unless they are given additional privileges

using the procedures described in “Using Access Control (ACL)” on page 289.
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Note – The user names espublic and esmaster are not configurable during

installation. They must specifically be defined as espublic and esmaster .

General Users

Any user who is part of the esusers file is known as a “general” user. Sun

Enterprise SyMON general users can, by default, perform the following functions:

■ Log into the software

■ View the domains, hosts, and modules that are created

■ View the events

■ Trigger manual refreshes

■ Run ad hoc commands

■ Graph data

Sun Enterprise SyMON Superuser

Implicitly, the Sun Enterprise SyMON superuser belongs to all the groups described

in the following sections. Sun Enterprise SyMON superuser has “admin” privileges

as described in “Sun Enterprise SyMON ADMinistrators or esadm” on page 284.

Sun Enterprise SyMON Groups

The following groups are created by default on the server host during the Sun

Enterprise SyMON server setup:

■ esops
■ esadm
■ esdomadm

In addition, all the Sun Enterprise SyMON users belong to a hypothetical group,

called ANYGROUP.

The above groups must be defined on the machine where the Sun Enterprise

SyMON Configuration manager is running. They do not need to be defined on other

machines. These groups are described in greater detail in the sections that follow.

Note – The preceding groups are defined in the /etc/group file. Note that

although Sun Enterprise SyMON esmaster and espublic users are configured as

members of the preceding groups, they are not explicitly mentioned in the /etc/
group file.
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Sun Enterprise SyMON OPeratorS or esops

Sun Enterprise SyMON software users belonging to the group esops are usually

referred to as operator users who run, monitor, and to some extent, configure some

parameters on the managed systems. As you can see in the following list, esops can

perform operations, including some that are allowed for general users:

■ Disable or enable modules

■ Set module active time window

■ Set alarm limits

■ Set rule parameters

■ Run alarm actions

■ Run adhoc commands

■ Set refresh interval

■ Acknowledge, delete, or fix events

■ Enable or disable history logging

■ Set logging history parameters

Sun Enterprise SyMON ADMinistrators or esadm

Software users belonging to the group esadm can perform “admin” operations,

which are a superset of the operations that can be performed by operator users as

described in “Sun Enterprise SyMON OPeratorS or esops ” on page 284. In addition

to all the operations that “operator” users (esops ) can perform, these “admin” users

(esadms) can perform the following operations:

■ Load or unload modules

■ Set ACL users and groups

■ View domains, hosts, or modules

Sun Enterprise SyMON DOMain ADMinistrators or
esdomadm

The users belonging to the group esdomadm can perform the following “domain

administrator” operations:

■ Create domains

■ Create groups within domains

■ Add objects to groups or domains

■ View domains, hosts, or modules

Note – Other than the privileges listed above, a user belonging to “esdomadm” is

just a “general” user, unless configured otherwise.
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Admin, Operator, and General Functions

TABLE 15-1 contains the different types of functions users can do by default.

This table is general in nature and applies to all modules. Individual modules may

also have specific restrictions, which are under the control of the module.

In Sun Enterprise SyMON software, the above categories maintain inclusive
relationships or privileges. This means that, by default, a user who has esadm
privileges can do anything that a user who has esops privileges can. But an

TABLE 15-1 Domain Admin, Admin, Operator, and General Functions

Function Domain Admin Admin Operator General

Load modules x

Unload modules x

Create domains x

Create groups within domains x x

Add objects to groups or

domains

x x

View domains, hosts or

modules

x x x x

Set ACL users or groups x

Disable or enable modules x x

Set module active time

window

x x

Set alarm limits x x

Set rule parameters x x

Run alarm actions x x

Run adhoc commands x x

Set refresh interval x x

Manually trigger a refresh x x x

Enable or disable history

logging

x x

Set logging history parameters x x

Acknowledge, delete, or fix

events

x x

View events x x x
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administrator has the option to change the default permissions so that a user who

has esops privileges can do more than a esadm user. Inclusive relationships means

that these three groups, esops , esadm, and esdomadm, do not have any code

enforcement behind them which makes one group more powerful than the other.

For more information on how to override default privileges, see “Overriding the

Default Privileges” on page 296.

Specifying Access Control (ACL)

The administrators (esadm group) can specify ACL features for users and groups for

the following:

■ Domains

■ Groups within domains

■ Hosts

■ Modules

Admin, Operator, and General Access

An ACL specification consists of establishing or defining one or more of the

following:

■ Administrator users and administrator groups

A list of users and groups who can perform administrator operations. By default,

they are esadm or esdomadm, wherever applicable.

■ Operator users and operator groups

A list of users and groups who can perform operator operations. By default, they

are esops .

■ General users and general groups

A list of users and groups who can perform general operations. By default, this is

a hypothetical group called ANYGROUP.

■ Communities for administrators (SNMP)

A list of SNMP communities that can perform admin operations using SNMP

protocol.

■ Communities for operators (SNMP)

A list of SNMP communities that can perform operator operations using SNMP

protocol.

■ Communities for general (SNMP)

A list of SNMP communities that can perform general operations using SNMP

protocol.
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Sun Enterprise SyMON Remote Server Access

Users can access and view data from sessions running on remote Sun Enterprise

SyMON servers. When a user tries to gain access to such information, that user is

provided access as espublic (guest) with read-only privileges. The behavior of Sun

Enterprise SyMON sessions running on different servers is defined in terms of each

session’s server context. See “Sun Enterprise SyMON Server Context” on page 287

for more information.

As a user, you can access and set up a different server context for a variety of

reasons:

■ To provide for separate security access privileges so that each server context

could have different users and administrators and yet be accessible to each other

■ To allow for physical separation between elements, as in the context of a wide

area network (WAN)

■ To increase performance since this would allow many hosts to be handled by one

set of central components

By linking to a different server context, you can view the top level status of the

objects in the other server context.

Sun Enterprise SyMON Server Context

A server context is defined as agents running on many hosts, all sharing a single set

of the following central components:

■ Sun Enterprise SyMON server

■ Topology manager

■ Event manager

■ Trap handler

■ Configuration manager

A server context is defined as a collection of Sun Enterprise SyMON agents and the

particular server layer to which the console is connected. Agents within the same

server context can talk to each other. Agents in remote server contexts can talk using

read-only privileges.

Every Sun Enterprise SyMON component or agent is configured at installation to

know the location of its Trap handlers and Event managers. Sun Enterprise SyMON

software identifies the Trap handlers and the Event managers by their IP or port

addresses. This means that if you want to determine if you are within your server

context or are accessing information from another server context, you need to know

the respective IP or port addresses of the servers that you access. Different server

contexts have different port numbers.
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A remote server context refers to a collection of agents and a particular server layer

with which the remote agents are associated.

FIGURE 15-1 Remote Server Context

An agent gets its security configuration from the server layer. For example:

■ Agents within the same server context can talk to each other.

■ Agents in remote server contexts can talk remotely using read-only privileges.

■ Requests to agents in remote servers are performed as the Sun Enterprise SyMON

espublic user. This allows successful requests across servers, as long as Sun

Enterprise SyMON sessions on both servers have the same password for user

espublic .

■ Each Sun Enterprise SyMON server maintains a list of agent IP or port address, to

distinguish objects in its own context from objects on a different Sun Enterprise

SyMON server.

Limitations While Crossing Servers

Some security restrictions apply when a user tries to communicate across server

contexts.

In the current Sun Enterprise SyMON environment, you can access information from

another server with a few limitations:

Console

 Server

Agent Agent Agent

Server

Server context 1 Server context 2
288 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



■ If you try to access a different or remote server context, the server give you access

with espublic user privileges. Thus you can access data but cannot modify or

use the objects within the different server. You are restricted only to viewing the

remote server objects. Therefore, the following consequences apply:

■ You can access other server contexts as long as the espublic user password is

the same in all contexts.

■ You can view data in another context as user espublic , but you cannot

perform control actions, such as setting alarm thresholds, and other similar

functions.

■ Edit functions work differently in a remote server. For example, you can copy and
paste between contexts but cannot cut and paste between contexts.

Note – From a graphical user interface perspective, it is important to note that it

may not be obvious that you are accessing a different server context. To identify if

you are accessing a different server, check the server’s IP port number or address in

the Info tab of the Details window.

Using Access Control (ACL)

The following sections describe how to perform the following key ACL functions:

■ To Add Sun Enterprise SyMON Users

■ To Access ACL on a Module

■ To Add a User-Defined Group to an ACL

■ To Grant a User esadm, esops , or esdomadm Privileges

■ To Delete Sun Enterprise SyMON Users

▼ To Add Sun Enterprise SyMON Users

1. Become superuser (on the Sun Enterprise SyMON server host).

2. Edit the file /var/opt/SUNWsymon/cfg/esusers . Make sure that the user name
is that of a valid UNIX user.

3. Add the user name on a new line.

4. Save the file and exit the editor.
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Note – By adding a user to the users list, the user has default privileges. See

“Default Privileges” on page 295 and “Overriding the Default Privileges” on

page 296 for more information.

▼ To Access ACL on a Module

1. Proceed with one of the following:

■ Click the right mouse button on the selected object and highlight Attribute Editor

from the pop-up menu.

■ Select Tools ➤ Attribute Editor in the main console window.

The Attribute Editor is displayed. The buttons at the bottom of the window are

grayed out, with the exception of the Cancel and Help buttons. The remaining

buttons become active if you modify any field in the window.

2. Select the Security tab within the Attribute Editor window (FIGURE 15-2).

3. Change the values as required.

For example, you may enter data as follows:
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FIGURE 15-2 Example of Security Fields in the Attribute Editor

Note – Use spaces between multiple entries as illustrated in the entries for

“Operator” under “Users.”
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The preceding example of the Attribute Editor with the Security tab selected

contains the following field entries:

Note – For more information on security privileges, see “Access Control (ACL)

Categories” on page 282.

TABLE 15-2 Security Attributes

Attribute Description

Administrator Users A list of users. jiten is a user who can perform administrator

operations

Operator Users A list of operators. john and others are users who can perform

operator operations. Note that their entries are separated by one or

more spaces

General Users A list of general users. Here, nick and richie are users who can

perform general operations

Administrator

Groups

All the users belonging to esadm and administrators can perform

administrator operations. By default, they are esadm or esdomadm,

as applicable

Operator Groups All users belonging to esops can perform operator operations

General User Groups ANYGROUPis a hypothetical group that can perform general

operations. All Sun Enterprise SyMON users belong to this

hypothetical group

Communities for

Administrators

This field is empty denoting that there is no SNMP community that

can perform admin operations using the SNMP protocol

Communities for

Operators

This field is empty denoting that there is no SNMP community that

can perform operator operations using the SNMP protocol

Communities for

General Users

public is an SNMP community that can perform general

operations using the SNMP protocol
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▼ To Add a User-Defined Group to an ACL

1. Become superuser.

2. Create a group:

3. Add users to the newly created group:

a. Edit the /etc/group file.

b. Add users to the group.

c. Save the file and exit the editor.

4. Add the new group to the ACL of interest.

See “To Access ACL on a Module” on page 290 for more information.

▼ To Grant a User esadm, esops , or esdomadm
Privileges

1. Become superuser.

2. Make sure that the user is a valid Sun Enterprise SyMON user.

You may do this by adding the user to the /var/opt/SUNWsymon/cfg/esusers
file.

3. Edit the /etc/group file.

4. Add the user to one of the following lines as applicable: esadm, esops , or
esdomadm.

5. Save the file and exit the editor.

# /usr/sbin/groupadd groupname
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▼ To Delete Sun Enterprise SyMON Users

1. Become superuser on the Sun Enterprise SyMON server host.

2. Edit the file /var/opt/SUNWsymon/cfg/esusers .

3. Delete the line corresponding to the user name you want to delete.

4. Save the file and exit the editor.

5. Delete the user names from additional groups.

After a user is deleted from the list of Sun Enterprise SyMON users, the user can no

longer log into the Sun Enterprise SyMON server. Make sure to delete that user from

all the ACLs.
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Default Privileges

Domains are manipulated by the Topology manager. This section illustrates the

default privileges for the Topology manager and for other agents and modules.

Topology Manager Default Privileges

The default privileges for Topology manager (where domains are maintained) are

listed in the following table.

TABLE 15-3 Default Privileges for Topology Manager

Topology Manager Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public

List of Admin Groups esdomadm

List of Operator Groups esops

List of General Groups ANYGROUP
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Other Sun Enterprise SyMON Component and

Module Default Privileges

The default privileges for all other components and modules are listed in the

following table.

The keyword ANYGROUPis not a true UNIX group, but is a special keyword that

means that “any user who can log into Sun Enterprise SyMON software is given general
access to the objects.”

Overriding the Default Privileges

In Sun Enterprise SyMON software, only administrators can override default

privileges using the Attribute Editor to modify the ACL lists for that particular

object.

The following section illustrates how to override default list privileges.

TABLE 15-4 Sun Enterprise SyMON Component and Module Default Privileges

Components/Modules Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin Groups esadm

List of Operator Groups esops

List of General Groups ANYGROUP

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public
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▼ To Override Default Privileges

● Create the following override files in the /var/opt/SUNWsymon/cfg directory:

■ agent-acls-d.dat

■ topology-acls-d.dat

■ event-acls-d.dat

■ cfgserver-acls-d.dat

■ trap-acls-d.dat

The following example creates an admin group wheel for the agent instead of the

esadm. By default, it makes user 1, margot, and user 2, helen , admin users for

that agent.

Note that the lists of names are separated by spaces, such as, helen and margot .

The lines beginning with a pound sign (#) are comment lines and you may ignore

them. They are presented here for reference purposes only.

Note – Remember to create similar files for each component or machine.

For platform-specific information about security, see your supplement.

#   File:    agent-acls-d.dat
#   Version: %I% %E% %U%
#
#   Copyright (c) 1993-1997 Halcyon Inc.
#
#   e.g.
#       adminUsers =
#       operatorUsers =
#       generalUsers =
#       adminCommunities =
#       operatorCommunities =
#       generalCommunities =
#       adminGroups =
#       operatorGroups =
#       generalGroups =
#
       adminUsers = helen margot
       adminGroups = wheel
       operatorGroups = esops
       generalGroups = ANYGROUP
       generalCommunities = public
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APPENDIX A

Getting Started With Sun Enterprise
SyMON Software

TABLE A-1 is an example of how you can use the Sun Enterprise SyMON software.

This table includes a summary of some typical tasks and the order in which they

should be done. Each task is referenced to another section in the manual, which

provides detailed, step-by-step directions.

The tasks and the order in which they are included in this table is based on the

assumption that you will explore and learn the software before setting up your

actual monitoring environment.

TABLE A-1 Example Use of Sun Enterprise SyMON Software

Task For More Information, Go to

Create a domain. “To Create Domains” on page 58

Populate the domain by creating objects. Chapter 5

Populate the domain with the Discovery manager. Chapter 6

Familiarize yourself with the console window. Chapter 7

Navigate through Sun Enterprise SyMON software using the

hierarchy (tree view).

“Hierarchy View” on page 116

Navigate through Sun Enterprise SyMON software using the

topology view.

“Topology View” on page 118

Open the Details window. “To Start the Details Window” on page 130

Load other modules. “To Load a Module” on page 212

Disable some modules “To Disable a Module” on page 224

Unload some modules. “To Unload a Module” on page 225

Monitor your system using the modules. Appendix C and Appendix D

Explore the different modules. “Browser Tab” on page 133
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Note – For additional information specific to your hardware, see your supplement.

Explore the processes view. “Processes Tab” on page 257

Explore the log view. “Log View Tab” on page 263

Explore the physical view. “Configuration Tab” on page 270

Explore the logical view. “Configuration Tab” on page 270

View a property table. “Monitoring Data Properties” on page 143

View a graph of a property table. “To Graph A Monitored Data Property” on

page 155

Create an alarm. “To Create an Alarm” on page 174

Watch the alarm go up the hierarchy (tree) view. “To Create an Alarm” on page 174

View the alarm through the Details window. “Viewing Alarm Information” on page 239

View the alarm through the domain status summary. “To Access Alarms from the Main Console

Window” on page 242

Sort the alarms and become familiar with the Alarms window. “Information on Alarms” on page 243

Acknowledge the alarm. “Acknowledging and Deleting Alarms” on

page 249

Delete the alarm. “Acknowledging and Deleting Alarms” on

page 249

Create alarm conditions. “To Create an Alarm” on page 174

Set the refresh interval. “Refresh Tab in the Attribute Editor” on

page 178

Set security. Chapter 15

TABLE A-1 Example Use of Sun Enterprise SyMON Software (Continued)

Task For More Information, Go to
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APPENDIX B

Miscellaneous Sun Enterprise
SyMON Procedures

This appendix documents the following procedures:

■ To Regenerate the Security Keys

■ To Configure a Legacy SNMP Agent as a Subagent of a Sun Enterprise SyMON

Agent

■ To Determine if a Port Is Used

■ To Reconfigure Sun Enterprise SyMON Software to Use Nondefault Port

Addresses

■ To Reconfigure Sun Enterprise SyMON SNMP Port Addresses

■ To Reconfigure Sun Enterprise SyMON RMI Port Address

■ To Create a Server Component as a Monitored Object

■ To Increase the Critical Threshold for the Virtual Size Data Property.

■ To Change the Default Values for Smart Delete in the Event Manager

■ To Use ccat to Read Sun Enterprise SyMON Log Files

■ To Use ctail to Read Sun Enterprise SyMON Log Files

■ To Resolve a Hanging Main Console Window

■ To Connect to Console Client Machines with DHPC

Regenerating Security Keys

The Sun Enterprise SyMON setup generates the security keys for Sun Enterprise

SyMON components using the following default settings:

■ Valid Sun Enterprise SyMON users are espublic and esmaster
■ Sun Enterprise SyMON superuser is esmaster
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Note – The software uses an 8-character string as a seed to make the generated key

unique. During setup, you have the option to use the default Sun Enterprise SyMON

seed or to use one that you create. The same seed must be used for all server and

agent setups in a given server context. For more information on server context, see

Chapter 15.

Sun Enterprise SyMON setup does not create UNIX accounts for the special users

espublic and esmaster . You should not need to log into the Sun Enterprise

SyMON console using these user IDs because they are reserved for internal

communication between processes. However, some troubleshooting activities may

require you to log in using one of these user IDs. If so, you have to create it and

assign a password using the normal UNIX commands useradd and passwd .

The esmaster user ID bypasses normal permission checks, so use it with care. For

normal operation, use an existing login account. Setup provides an opportunity to

specify an existing user as a Sun Enterprise SyMON administrator. This user ID is

added to the esadm and esdomadm groups as well as the esusers file. For more

information on security and the Sun Enterprise SyMON superuser, see Chapter 15.

The security keys for the components need to be regenerated if one or more of the

following is true:

■ UDP ports of any of the Sun Enterprise SyMON agents are changed.

■ Host names or IP addresses of the Sun Enterprise SyMON agent host change.

Note – Changing the host name or the IP address of the Sun Enterprise SyMON

server is not supported.
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▼ To Regenerate the Security Keys

Note – In these examples, shared_secret stands for a secret string of up to eight

characters that is common to all machines in a server context. It is required as an

argument to the script base-usm-seed.sh . A default (maplesyr ) is provided by

the software, but you can specify your own password if desired. This secret string or

password is used to generate keys for communication between processes.

-u public is needed to respond to external SNMP requests with public
communities.

1. Log in as root .

2. Depending on your installation, type one of the following.

■ If you installed only the agent layer, type:

■ If you installed only the server layer, type:

■ If you installed both the agent and server layers on one host, type:

3. Restart the Sun Enterprise SyMON server.

See “To Start the Sun Enterprise SyMON Software” on page 43.

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c agent -u public

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c topology -u public
# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c trap event
cfgserver servers

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -u public
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Configuring a Legacy SNMP Agent as a
Subagent of a Sun Enterprise SyMON
Agent

A legacy SNMP agent is a SNMP agent that is not part of the Sun Enterprise SyMON

agent framework. In real world situations, you may need to configure one or more

legacy agents as subagents of a Sun Enterprise SyMON agent.

Any legacy SNMP agent can be configured as a subagent of a Sun Enterprise

SyMON Agent provided that:

■ The legacy agent can run on a port other than 161.

■ The legacy agent configuration supports running that agent as a non-daemon

process.

■ You have the legacy agent MIB definition file.

▼ To Configure a Legacy SNMP Agent as a

Subagent of a Sun Enterprise SyMON Agent

1. Log in as root.

2. If the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x does not exist,
copy it from the /opt/SUNWsymon/base/cfg directory:

3. In the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x , find the block
that is similar to CODE EXAMPLE B-1.

# cp /opt/SUNWsymon/base/cfg/subagent-registry-d.x /var/opt/SUNWsymon/cfg/

CODE EXAMPLE B-1 Before Editing Registry file

# sa2 = {
#    type             = legacy
#    persist          = false
#    snmpPort         = "20001"
#    errorAction      = restart
#    startCommand     = "/usr/lib/snmp/mibiisa -p %port"
#    stopCommand      = "kill -9 %pid"
#    pollInterval     = 60
#    pollHoldoff      = 60
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4. Remove the comment symbol at the beginning of the line (#) so that the code
looks like CODE EXAMPLE B-2:

5. Modify the lines as follows:

a. Change sa2 to the unique subagent name for the agent.

b. type is legacy .

c. persist is false if the subagent is stopped when the Sun Enterprise SyMON
agent exits. If this value is true , then the Sun Enterprise SyMON agent does
not stop the subagent when the Sun Enterprise SyMON agent exits.

d. snmpPort is the UDP port number on which you want to run the subagent.

e. errorAction can be restart , ignore , or kill . If the restart option is
used, then the Sun Enterprise SyMON agent tries to restart if it encounters an
error when communicating with the subagent. The other options result in the
respective behaviors.

f. startCommand is the mandatory command to start the subagent. This
command should contain %port , which is replaced by the value given in
snmpPort .

#    oidTrees         = 1.3.6.1.2.1
#    snmpVersion      = SNMPv1
#    securityLevel    = noauth
#    securityName     = espublic
# }

CODE EXAMPLE B-2 After Removing the Comment Symbol in the Registry file

sa2 = {
    type             = legacy
    persist          = false
    snmpPort         = "20001"
    errorAction      = restart
    startCommand     = "/usr/lib/snmp/mibiisa -p %port"
    stopCommand      = "kill -9 %pid"
    pollInterval     = 60
    pollHoldoff      = 60
    managedTrees     = "mib-2 sun"
#    oidTrees        = 1.3.6.1.2.1
    snmpVersion      = SNMPv1
    securityLevel    = noauth
    securityName     = espublic
 }

CODE EXAMPLE B-1 Before Editing Registry file (Continued)
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g. stopCommand is the command to stop the process. %pid can be used to
represent the process ID (PID) of the subagent process.

h. pollInterval defines the time (in seconds) in which the Sun Enterprise
SyMON agent polls the subagent.

i. pollHoldoff is the time (in seconds) after which the first poll is done on the
subagent after the latter is started by the Sun Enterprise SyMON agent.

j. oidTrees gives the space-separated list of SNMP OIDs managed by the
subagent.

k. snmpVersion can take values SNMPv1and SNMPv2.

l. securityLevel can be priv , auth , or noauth.

m. securityName is the SNMPv1 community name or SNMPv2 security name to
use.

For more details, refer to the descriptions in the subagent-registry-d.x file.

6. Stop then restart the agent:

Configuring Sun Enterprise SyMON
Software to Use Different Port Addresses

This section describes how to configure Sun Enterprise SyMON software when there

is potential conflict for port addresses.

▼ To Determine if a Port Is Used

● To determine if a specific port number is used in your system, type:

# /opt/SUNWsymon/sbin/es-stop -a
# /opt/SUNWsymon/sbin/es-start -a

# /bin/netstat -an|grep port_number
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The Sun Enterprise SyMON server communicates with the Sun Enterprise SyMON

agents and the other server components (Topology manager, Configuration manager,

Event manager, and Trap handler) using SNMP. By contrast, the server

communicates with the Sun Enterprise SyMON consoles using remote method

invocation (RMI).

Several components require the use of network ports, as shown in the following

table.

Note – The SNMP port definitions for Sun Enterprise SyMON components are

found in two files: the /var/opt/SUNWsymon/cfg/domain-config.x file, which

exists in every machine running any Sun Enterprise SyMON component, and the

/var/opt/SUNWsymon/cfg/server-config.x file, which exists on machines

that have the Sun Enterprise SyMON server component installed.

In the domain-config.x file, there is one configuration block for each of the

SNMP-based Sun Enterprise SyMON agents. In each configuration block there is (at

least) one line which defines the port address for the corresponding agent. The

default port definition for the Sun Enterprise SyMON server is in the

server-config.x file.

Setup scripts automatically configure the components by using the default port

addresses. However, if any of the default ports are being used, then you must take

action to avoid such conflicts in network port addresses.

▼ To Reconfigure Sun Enterprise SyMON Software

to Use Nondefault Port Addresses

1. Run the es-setup script to create the domain-config.x and server-config.x
(server configuration setup) files.

TABLE B-1 Sun Enterprise SyMON Default Port Addresses

Layer Component Default Port Number

Agent agent 161

Server Trap handler 162

Server Event manager 163

Server Topology manager 164

Server Configuration manager 165

Server server 2099
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2. Edit these files with the new port numbers.

See the next section and “To Reconfigure Sun Enterprise SyMON RMI Port Address”

on page 308 for more information.

▼ To Reconfigure Sun Enterprise SyMON SNMP

Port Addresses

1. Log in as root.

2. Edit the domain-config.x file and change the address port to an unused port.

This example illustrates changing the agent default port address from 161 to 1161 .

Before:

After:

3. Save the file.

Note – Hosts with Sun Enterprise SyMON agents using port addresses other than

161 can be added to the domain manually by using the Create Topology Object

window or can be discovered automatically by specifying the port number in the

discovery parameters. (For more information on the Create Topology Object

window, see Chapter 5. For more information on how hosts are discovered

automatically, see Chapter 6). Since you can only specify one port number in

addition to port 161, it is best to select an alternate port number and use that number

for all agent installations.

▼ To Reconfigure Sun Enterprise SyMON RMI Port

Address

1. Log in as root.

agent = {
      snmpPort = 161

agent = {
      snmpPort = 1161
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2. Edit the /var/opt/SUNWsymon/cfg/server-config.x file.

3. Search for the block which starts with rmiReceptor .

For example:

4. Uncomment the line that reads property:rmiPort = 2099 by deleting the
pound (#) character.

5. Change the address port to a new unused port number.

For example:

This example illustrates changing the server default port address from 2099 to

1199 .

6. Save the file.

rmiReceptor = {
    [ use RECEPTORS.RMI ]

#    property:rmiPort = 2099
#    property:rmiHost = localhost

    # 0 means user authentication is disabled
    # 1 means user authentication is enabled
    # property:securityFlag = 1

    # -1 means no limit
    # 0 means make a guess at a limit (base on # of fd's)
    # >0 specifies the exact limit
#
}

property:rmiPort = 1199
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Monitoring Topology Manager and
Event Manager

There are five components in the server layer:

■ Sun Enterprise SyMON server

■ Topology manager

■ Trap handler

■ Configuration manager

■ Event manager

With the exception of the server, the other four components are Sun Enterprise

SyMON agents loaded with specialized modules.

You may want to monitor the Topology manager, Trap handler, Configuration

manager, and Event manager to determine their status. See the next section for more

information.

The Configuration manager and the Trap handler are configured so that you do not

need to perform any maintenance procedures. In addition, the default configurations

of both the Topology manager and the Event manager work for most user

environments. However, you can modify the default configurations for specialized

environments.

The default configuration for the Topology manager and the Event manager (and all

other Sun Enterprise SyMON agents) is defined by the Agent Statistics module. See

“Agent Statistics Module” on page 355 for more information about this module.

This module includes features that guard against errors that may bring down the

host. The default action is for the software to terminate the Topology manager

process if predefined thresholds are exceeded.
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▼ To Create a Server Component as a Monitored

Object

1. In the main console window, select Edit ➤ Create an Object.

The Create Topology Object window is displayed. By default the tab is set to Group.

For more information, see “To Create a Node” on page 70.

2. Click the Node tab.

The window changes to display settings available for nodes.

3. Click the Monitor Via button to see the pull-down menu, then select SyMON
Agent - Host.

4. Type the name of the server component in the Node Label field.

5. (Optional) Enter a description of the node.

6. Enter the name of the Sun Enterprise SyMON server in the Hostname field.

7. Type the port number for the server component in the Port field (FIGURE B-1).

See the table entitled “Sun Enterprise SyMON Default Port Addresses” on page 307

for the default port values for each of the server components.

8. Complete this procedure with one of the following actions:

■ Click OK to create the server component object and close this window.

■ Click Apply to create the server component object without closing this window.

■ Click Cancel to cancel your request.
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FIGURE B-1 Creating a Server Component as a Monitored Object
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Topology Manager

The Topology manager enables the main console window to present logical objects

in a topology view. It also provides the ability to create a logical object (such as a

group) whose status summarizes the statuses of managed objects residing on

multiple hosts.

Managed objects include networks, hosts, hardware components, and software

components. The total number of objects and the contents of these objects determine

the system resource requirement (for example, Virtual Size) for the Topology

manager. This requirement must be less than the defaults set for the Topology

manager.

If the Virtual Size of the Topology manager exceeds the default value, then the

Topology manager exits with the error message, “error excessive virtual memory

use.” To solve this error, you need to increase the default virtual size by completing

the following procedure after you have carefully evaluated the situation.

▼ To Increase the Critical Threshold for the Virtual

Size Data Property.

1. Create the Topology manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 311.

2. Open the Details window by proceeding with one of the following:

■ Click the right mouse button on the Topology manager object icon and highlight

Details from the pop-up menu in the hierarchy view or the topology view.

■ Double-click the left mouse button on the Topology manager icon in the hierarchy

view or the topology view.

■ Select the Topology manager icon in the main console window, then select Tools

➤ Details.

3. In the Browser Details window, double-click on the Local Applications icon in the
hierarchy (tree) view.

4. Double-click on the Agent Statistics icon in the contents view or single click in
the light-colored circle next to the Agent Statistics icon in the hierarchy view.

The Agent Statistics folders are displayed.

5. Double-click on the PA Process Statistics folder icon in either the hierarchy or the
contents view.

The monitored properties are displayed in a property table (FIGURE B-2).
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FIGURE B-2 PA Process Statistics Property Table

6. Select the Virtual Size table cell, then proceed with one of the following:

■ Click the right mouse button in the table row and select Attribute Editor from the

pop-up menu.

■ Click the Attributes button.

7. Click on the Alarms tab button.

The alarm rows are displayed (FIGURE B-3).

8. Type the desired value in the Critical Threshold (>) field.

9. Complete this procedure with one of the following actions:

■ Click OK to create a new Critical Threshold value and close this window.

■ Click Apply to create a new Critical Threshold value without closing this

window.

■ Click Cancel to cancel your request.
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FIGURE B-3 Alarms Tab for the Virtual Size Property in the Topology Manager Object

Event Manager

The Event manager communicates with other server components through SNMP

using the default port 163. Similar to the Topology manager, the Event manager is

also loaded with the Agent Statistics module. In addition, the Event manager is

automatically loaded with a specialized Event Management module which is

displayed in the Browser Details window in the Local Applications category.

The Event Management module is responsible for the overall maintenance of the

event database. Its responsibilities include purging deleted events, renaming the

trash file, and “smart delete” (FIGURE B-4).
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FIGURE B-4 Event Management Module Data Properties

Smart delete means that Sun Enterprise SyMON automatically deletes closed, fixed,

and open events from the event database after a set period of time. By default, the

closed or fixed events are removed from the database after seven days and the open

events are removed after 30 days. You can change these defaults with the following

procedure.

▼ To Change the Default Values for Smart Delete

in the Event Manager

1. Create the Event manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 311.

2. Open the Details window by proceeding with one of the following:

■ Click the right mouse button on the Event manager icon and highlight Details

from the pop-up menu in the hierarchy view or the topology view.

■ Double-click the left mouse button on the Event manager icon in the hierarchy

view or the topology view.

■ Select the Event manager icon in the main console window then select Tools ➤

Details.

3. In the Browser Details window, double-click on the Local Applications icon in the
hierarchy (tree) view.

4. Select the Event Management module and proceed with one of the following:

For more information, see “To Edit Module Parameters” on page 222.

■ Click the right mouse button and highlight Edit Module from the pop-up menu in

the hierarchy view or the contents view.
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■ In the Details window, select Module ➤ Edit Module.

The Module Parameters Editor is displayed.

5. Type the new time values into the editable fields.

The default time values are displayed in FIGURE B-5.

6. Alternately, you may turn off “smart delete” by selecting Disabled in the
pull-down menu next to the Smart Delete Enabled Switch field.

7. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Reset to reset the Module Parameter Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE B-5 Module Parameter Editor for the Event Management Module
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Reading Sun Enterprise SyMON Log
Files

The server and agents write to various log files in the directory,

/var/opt/SUNWsymon/log .

These files are “circular log files.” A circular log file does not grow in size after a

certain limit. As new messages are logged into the file, the oldest messages are

removed.

Use the es-run interface with the ctail and ccat commands to view these log

files. The es-run interface sets up the proper environment to run Sun Enterprise

SyMON utilities. The utilities ccat and ctail display only the relevant data, after

sorting the data in chronological order. The ccat and ctail commands are similar

to the UNIX cat and tail commands, but are intended for use with Sun Enterprise

SyMON circular log files.

▼ To Use ccat to Read Sun Enterprise SyMON

Log Files

The ccat command reads the specified log file, sorts the messages in

chronologically ascending order, and writes to the standard output. The ccat
command takes one argument, which is the full path to the circular log file.

● Use the es-run interface with the ccat command:

▼ To Use ctail to Read Sun Enterprise SyMON

Log Files

The ctail command reads the circular log file and by default writes the last 15 lines

of the file to standard output.

# /opt/SUNWsymon/sbin/es-run ccat path_to_file/filename
Appendix B Miscellaneous Sun Enterprise SyMON Procedures 319



The ctail command takes four arguments: filename and the -f , -l , and -n options

where:

The filename argument is the full path name to the circular log file. The filename
argument is mandatory.

-f option is used to monitor the growth of the log file. As the log file grows, the

messages appended to the file are also written to the standard output. The ctail
-f option is similar to the -f option for the UNIX tail command.

-l option is used to print the absolute line number at the beginning of each

message.

-n NumOfLines option is used to change the number of lines displayed. By default

only the last 15 lines are printed.

● Use the es-run interface with the ctail command:

Sun Enterprise SyMON Server Issues

This section discusses the following issues:

■ The main console window hangs when users are attempting to start a new

console window and connect to the Sun Enterprise SyMON server. However,

existing console window connections encounter no problems.

■ The Sun Enterprise SyMON server does not support console client machines that

use dynamic IP address (DHCP).

Hanging Main Console Window

This problem occurs because threads that are reading from a socket can hang when

there is a large discrepancy between the read and write rates at either end of a

socket. The memory problem occurs when the Sun Enterprise SyMON server has a

large amount of buffered data waiting to be sent to its clients. This buffered data is

so large that the server runs out of memory while trying to write to the socket. Once

this happens, the server does not recover.

# /opt/SUNWsymon/sbin/es-run ctail [-f, -l, -n NumOfLines] path_to_file_filename
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▼ To Resolve a Hanging Main Console Window

1. Edit the /opt/SUNWsymon/classes/base/server/bin/es-server.sh file.

2. Depending on the memory configuration on your Sun Enterprise SyMON server,
increase the available memory to the server process.

For example, double the default memory from 24 Mbytes to 48 Mbytes.

Console Client Machines with DHPC

The Sun Enterprise SyMON server does not connect properly to console client

machines that use DHCP.

▼ To Connect to Console Client Machines with

DHPC

1. Edit the /opt/SUNWsymon/classes/base/console/bin/es-console.sh file.

2. Add the following after jre on the last line where IP_Address is the IP address of
the console host.

jre -Djava.rmi.server.hostname= IP_Address
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APPENDIX C

Sun Enterprise SyMON Software -
Operating System Modules

The Sun Enterprise SyMON software monitors various components of your system,

including your hardware, operating environment, local applications, and remote

systems. This section provides additional explanation for the core modules described

in Chapter 12 and presents them in their respective categories.

This appendix describes the following modules. For more information on other

modules that may be applicable to your particular system, see the next appendix,

your supplement, or go to the Sun Enterprise SyMON web site: http://
www.sun.com/symon .

■ Operating System

■ Directory Size Monitoring Module

■ File Monitoring Module

■ MIB-II Instrumentation Module

■ Kernel Reader Module

■ NFS Statistics Module

■ Solaris Process Details Module

Most of these modules have default monitoring conditions that generate alarms

when system values fall outside of these conditions. You may alter these default

thresholds by creating your own alarm thresholds, as explained in Chapter 12.

Also, there are modules that utilize the Add Row operation to define what data

properties to monitor. These modules will come up with empty tables and you have

to execute an Add Row operation to activate the specifics for monitoring the

modules.
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The following table lists the modules described in this appendix alphabetically and

provides details on those modules that are automatically loaded and those that can

be loaded multiple times. It also points out those modules that utilize the Add Row

utility.

Operating System

The following modules, when loaded, are found under the operating system icon:

■ Directory Size Monitoring Module

■ File Monitoring Module

■ MIB-II Instrumentation Module

■ Kernel Reader Module

■ NFS Statistics Module

■ Solaris Process Details Module

■ NFS File Systems Module

These modules monitor the operating system on your host.

TABLE C-1 Modules Loaded Automatically, Multiple Times, and Use ‘Add Row’
Operation

Alphabetical Listing of Core Modules Module Loads
Automatically

Module Loads
Multiple Times

Module Uses
Add Row Utility

Config-Reader Module1

1. Refer to your platform-specific supplement for more information on the Config-Reader module.

X

Directory Size Monitoring Module X

Dynamic Reconfiguration

Module2

2. Refer to your platform-specific supplement for more information on the Dynamic Reconfiguration module.

File Monitoring Module X X3

3. Each added row defines what file to monitor.

Kernel Reader Module X

MIB-II Instrumentation Module X

NFS File Systems Module

NFS Statistics Module

Solaris Process Details Module
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Directory Size Monitoring Module

This module enables you to isolate and monitor the size of any directory and its

subdirectories on a host on which an agent is installed. The subdirectories and links

may be viewed recursively using a window accessible from the modules pop-up

menu.

Note – Any number of directories may be monitored individually by loading

multiple instances of the Directory Size Monitoring module.

Directory Monitoring Status Table

The following table provides a brief description of the properties for Directory Size

Monitoring:

File Monitoring Module

This module enables you to monitor the files on a host. Any file or number of tiles

may be isolated and monitored individually by loading multiple instances of the File

Monitoring module. This module requires you to add rows for the data property

tables. For more information, see “Working with Rows” on page 146.

TABLE C-2 Directory Size Monitoring Properties

Property Description

Directory Name Name of the directory being monitored

Directory Size (KB) Current size of the directory in Kbytes

Rate (KB/sec) Rate at which the directory is changing size in Kbytes per second
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File Monitoring Status Table

The following table lists the File Monitoring Status properties and their descriptions:

MIB-II Instrumentation Module

This section presents information on the MIB-II Instrumentation module. It describes

the property tables that belong to the following MIB-II groups:

■ MIB-II System Group Table

■ MIB-II Interfaces Group Tables

■ MIB-II IP Group Table

■ MIB-II ICMP Group Table

■ MIB-II TCP Group Tables

■ MIB-II UDP Group Tables

MIB-II System Group Table

The following table provides a brief description of the properties for MIB-II System

Group:

TABLE C-3 File Monitoring Properties

Property Description

Name Name of the file being monitored

Description Descriptive name provided for this file when added

Filename File being monitored

Last Modified Date and time the file last changed

File Size (Bytes) Size of the file

Size Rate (Bytes) Number of bytes written per second

TABLE C-4 MIB-II System Group Properties

Property Description

System Description MIB-II system description or the description of the host (read-

write)

System OID Object identifier or the Object ID (OID) of the software system

Time Since System Is Up Time in microseconds since the system is up

System Contact The contact name for this system
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MIB-II Interfaces Group Tables

The following tables provide a brief description of the properties for the MIB-II

Interface group:

■ MIB-II Interfaces Group Table

■ MIB-II Interface Table

MIB-II Interfaces Group Table

The following table provides a brief description of the properties for MIB-II

Interfaces Group:

MIB-II Interface Table

The following table provides a brief description of the properties for MIB-II

Interfaces:

System Name The qualified host name on which the agent is running (read-

write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily

offered

TABLE C-5 MIB-II Interfaces Group Properties

Property Description

Number of

Interfaces

Number of interfaces to the machine, including the loopback

TABLE C-6 MIB-II Interface Properties

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface

IF Type Type of the interface

TABLE C-4 MIB-II System Group Properties (Continued)

Property Description
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MIB-II IP Group Table

The following tables provide a brief description of the properties for MIB-II IP:

■ MIB-II Group Table

■ IP Address Table

■ IP Route Table

■ IP NetToMedia Table

IF Largest MTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF Physical Address Physical address of the interface

IF Admin Status Desired state of the interface

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and

running) when the operational state has changed last time

IF In Octets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF In NonUnicast

Pkts

Non-unicast packets received on the interface

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown

Protos

Number of packets with unsupported protocol that were received

on the interface

IF Out Octets Number of octets transmitted out on the interface

IF Out Unicast Pkts Number of unicast packets transmitted out on the interface

IF Out NonUnicast

Pkts

Number of non-unicast packets transmitted out on the interface

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because

of errors

IF Out Queue

Length

Length of the output packet queue

IF Specific Reference to the MIB definitions specific to the particular media

TABLE C-6 MIB-II Interface Properties (Continued)

Property Description
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MIB-II Group Table

The following table provides a brief description of the properties for MIB-II IP

Group:

TABLE C-7 MIB-II Group Properties

Property Description

IP Forwarding Indicates whether this entity is a gateway

IP Default TTL Default Time-to-Live inserted into the IP headers

IP In Receives Number of datagrams received

IP In Header Errors Number of input datagrams discarded because of errors in IP

headers

IP In Address Errors Number of input datagrams discarded because of errors in

destination IP address

IP Forwarded

Datagrams

Number of forwarded datagrams

IP In Unknown

Protos

Number of locally addressed datagrams that were discarded

because of unsupported protocols

IP In Discards Number of input datagrams that were discarded

IP In Delivers Number of input datagrams that were successfully delivered

IP Out Requests Number of datagrams that were supplied to IP for transmission

IP Out Discards Number of output IP datagrams that were discarded

IP Out No Routes Number of output IP datagrams that were discarded because no

route destination was found

IP Reassemble

Timeouts

Maximum time in seconds for which the received fragments were

held for reassembly

IP Reassemble

Requireds

Number of IP fragments received that required reassembly

IP Reassemble OKs Number of IP datagrams that were successfully reassembled

IP Reassemble Fails Number of failures detected by the reassembly algorithm

IP Fragmentation

OKs

Number of IP datagrams that were successfully fragmented

IP Fragmentation

Fails

Number of IP datagrams that have failed fragmentation

IP Fragmentation

Creates

Number of IP datagram fragments that were generated due to

fragmentation

IP Routing Discards Number of routing entries that were chosen to be discarded
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IP Address Table

The following table provides a brief description of the properties for IP Addresses:

IP Route Table

The following table provides a brief description of the properties for IP Route:

TABLE C-8 IP Addresses Properties

Property Description

IP Address Table IP Address Table

IPAT IP Address IP Address to which this entry’s addressing information pertains

IPAT IfIndex Index in the interface table for the corresponding interface

IPAT Net Mask Subnet mask associated with the IP address

IPAT Broadcast

Address

Value of the least significant bit in the IP broadcast address

IPAT Reassemble

Max Size

Size of the largest IP datagram which can be reassembled by this

entity

TABLE C-9 IP Route Properties

Property Description

IP Route Table Entity’s IP routing table

IP Route Destination Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next

hop of this route is reached

IP Route Metric1 Primary routing metric for the route that is specific to the routing 1

protocol

IP Route Metric2 Alternate routing metric for the route that is specific to the routing 2

protocol

IP Route Metric3 Alternate routing metric for the route that is specific to the routing 3

protocol

IP Route Metric4 Alternate routing metric for the route that is specific to the routing 4

protocol

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routing mechanism through which this route was learned
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IP NetToMedia Table

The following table provides a brief description of the properties for IP NetToMedia:

MIB-II ICMP Group Table

The following table provides a brief description of the properties for MIB-II ICMP

Group:

IP Route Age Number of seconds since the route was last updated

IP Route Mask Mask to be logical and with the destination address before being

compared to the route destination

IP Route Metric5 Alternate routing metric for the route that is specific to the routing 5

protocol

IP Route Info Reference to MIB definitions specific to the routing protocol

TABLE C-10 IP NetToMedia Properties

Property Description

IPN2M IfIndex Index of the interface in the interface table on which this entry’s

equivalence is effective

IPN2M

PhysAddress

Media-dependent physical address

IPN2M NetAddress IP address corresponding to the physical address

IPN2M Type Type of mapping

TABLE C-11 MIB-II ICMP Group Properties

Property Description

ICMP In Messages Number of ICMP messages received

ICMP In Errors Number of ICMP messages received with errors

ICMP In Dest

Unreachs

Number of ICMP destination unreachable messages received

ICMP In Time

Exceeds

Number of ICMP time exceeded messages received

TABLE C-9 IP Route Properties (Continued)

Property Description
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ICMP In Parameter

Problems

Number of ICMP parameter problem messages received

ICMP In Src

Quenchs

Number of ICMP source quench messages received

ICMP In Redirects Number of ICMP redirect messages received

ICMP In Echos Number of ICMP echo request messages received

ICMP In Echo Reps Number of ICMP echo reply messages received

ICMP In

Timestamps

Number of ICMP timestamp request messages received

ICMP In Timestamp

Reps

Number of ICMP timestamp reply messages received

ICMP In Address

Masks

Number of ICMP address mask request messages received

ICMP In Address

Mask Reps

Number of ICMP address mask reply messages received

ICMP Out Messages Number of ICMP messages that were attempted to send

ICMP Out Errors Number of ICMP messages that were not send due to problems

ICMP Out Dest

Unreachs

Number of ICMP destination unreachable messages sent

ICMP Out Time

Exceeds

Number of ICMP time exceeded messages sent

ICMP Out

Parameter Problems

Number of ICMP parameter problem messages sent

ICMP Out Src

Quenchs

Number of ICMP source quench messages sent

ICMP Out Redirects Number of ICMP redirect messages sent

ICMP Out Echos Number of ICMP echo request messages sent

ICMP Out Echo

Reps

Number of ICMP echo reply messages sent

ICMP Out

Timestamps

Number of ICMP timestamp request messages sent

TABLE C-11 MIB-II ICMP Group Properties (Continued)

Property Description
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MIB-II TCP Group Tables

The following tables provide a brief description of the properties for MIB-II TCP:

■ MIB-II TCP Group Table

■ TCP Connections Table

MIB-II TCP Group Table

The following table provides a brief description of the properties for MIB-II TCP

Group:

ICMP Out

Timestamp Reps

Number of ICMP timestamp reply messages sent

ICMP Out Address

Masks

Number of ICMP address mask request messages sent

ICMP Out Address

Mask Reps

Number of ICMP address mask reply messages sent

TABLE C-12 MIB-II TCP Group Properties

Property Description

TCP Retransmission

Algorithm

Algorithm used to determine the timeout value used for

retransmitting unacknowledged octets

TCP Retransmit Min

Timeout

Minimum value permitted by TCP implementation for the

retransmission timeout

TCP Retransmit

Max Timeout

Maximum value permitted by TCP implementation for the

retransmission timeout

TCP Max

Connections

Limit on the number of TCP connections

TCP Active Opens Number of times TCP connections have transitioned to SYN-SENT

from CLOSED state

TCP Passive Opens Number of times TCP connections have transitioned to SYN-RCVD

from LISTEN state

TCP Attempt Fails Number of times TCP connections have transitioned from SYN-

SENT or SYN-RCVD to COLSED state and from SYN-RCVD to

LISTEN state

TABLE C-11 MIB-II ICMP Group Properties (Continued)

Property Description
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TCP Connections Table

The following table provides a brief description of the properties for TCP

Connections:

MIB-II UDP Group Tables

The following tables provide a brief description of the properties for MIB-II UDP:

■ MIB-II UDP Group Table

■ UDP Table

TCP Established-to-

Resets

Number of times TCP connections have transitioned from

ESTABLISHED or CLOSE-WAIT to CLOSED state

TCP Current

Established

Number of TCP connections for which the current state is

ESTABLISHED or CLOSE-WAIT

TCP In Segments Number of segments received

TCP Out Segments Number of segments sent

TCP Retransmitted

Segments

Number of segments retransmitted

TCP In Errors Number of segments received in error

TCP Out With Reset

Flag

Number of segments sent containing the RST flag

TABLE C-13 TCP Connections Properties

Property Description

TcpConn State State of this TCP Connection

TcpConn Local Address Local IP address for this TCP connection

TcpConn Local Port Local port number for this TCP connection

TcpConn Remote Address Remote IP address for this TCP connection

TcpConn Remote Port Remote port number for this TCP connection

TABLE C-12 MIB-II TCP Group Properties (Continued)

Property Description
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MIB-II UDP Group Table

The following table provides a brief description of the properties for MIB-II UDP

Group:

UDP Table

The following table provides a brief description of the properties for UDP:

Kernel Reader Module

The Kernel Reader module monitors kernel statistics and all kernel information

including CPU statistics, system load statistics, disk statistics, file system usage, and

so on. This section includes properties and their descriptions for all Kernel Reader

managed objects:

■ Disk Statistics Managed Objects Tables

■ File System Usage Table

■ System Load Statistics Table

■ Filesystem Usage Table

■ CPU Statistics Managed Object Tables

■ Memory Usage Statistics Table

■ Swap Statistics Table

■ Streams Statistics Managed Objects Table

■ Software Rules Table

TABLE C-14 MIB-II UDP Group Properties

Property Description

UDP In Datagrams Number of UDP datagrams delivered to UDP users

UDP No Port

Datagrams

Number of received UDP datagrams for which there is no

application at the destination port

UDP In Errors Number of received UDP datagrams that could not be delivered

UDP Out Datagrams Number of UDP datagrams sent

TABLE C-15 UDP Properties

Property Description

UDP Local Address The local IP address for this UDP listener

UDP Local Port The local port number for this UDP listener
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The Kernel Reader module generates a warning alarm if it finds any disk with an

increasing wait queue while busy.

A warning alarm occurs when the disk is over 75% busy and the average queue

length is over 10 with an increasing wait queue. The warning alarm is on until the

disk is not over 70% busy and the average queue length is no longer than 8.

Similarly, this module generates a warning alarm if 90% of swap space is in use. The

alarm remains open until the swap space in use is less than 80% of the total swap

space.

The following table provides default alarm thresholds for applicable Kernel Reader

modules:

Disk Statistics Managed Objects Tables

The following tables provide a brief description of the properties for Disk Statistics:

■ Disk Details Table

■ Disk Service Time Table

The following table provides a brief explanation of what these tables contain:

TABLE C-16 Kernel Reader Alarm Thresholds

Alarm Threshold Message Condition

Error If file system kpctUsed is > 98

Warning If file system kpctUsed is > 90

Error If file system inode percentage is > 90

Warning If file system inode percentage is > 80

TABLE C-17 Disk Statistics Parameters

Property Description

Disk Details Details that pertain to the disk

Disk Service Time Average time with relation to the processing of a transaction
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Disk Details Table

The following table provides a brief description of the properties for Disk Details:

Disk Service Time Table

The following table provides a brief description of the properties for Disk Service

Time:

TABLE C-18 Disk Details Properties

Property Description

Diskname Name of the disk (sd0 and so on)

Diskalias Name of the disk (c0t0d0 and so on)

Read Operation Per Sec Read operation per sec

Writes Operation Per Sec Writes operation per sec

Operation Per Sec (read +

write)

Operation per sec (read and write)

Number Of Bytes Read Number of bytes read

Number Of Bytes Written Number of bytes written

Number Of Bytes

Transferred (r+w)

Number of bytes transferred (read and write)

Average Number Of

Transactions Waiting

Average number of transactions waiting

Average Number Of

Transactions Running

Average number of transactions running

TABLE C-19 Disk Service Time Properties

Property Description

Diskname Name of the disk (sd0 and so on)

Percentage Of Time

There Is A Transaction

Waiting For Service

Percentage of time there is a transaction waiting for service

(wait queue length)

Percentage Of Time The

Disk Is Busy

Percentage of time the disk is busy (transaction running)
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Filesystem Usage Table

The following table provides a brief description of the properties for Filesystem

Usage:

Note – The Find All Recent Files probe commands for UFS Filesystem Usage and

VXFS Filesystem Usage only finds files that were created 24 or more hours ago.

However, the Find All Files probe commands for UFS Filesystem Usage and VXFS

Filesystem Usage finds all files, including those that have just been created

(FIGURE C-1).

Average Wait Service

Time

Average wait service time

Average Run Service

Time

Average run service time

Average Service Time Average service time

TABLE C-20 Filesystem Usage Properties

Property Description

Mount Point Mount point for the file system

Disk Name Name of the device (/dev/dsk/... )

Size (KB) Total size of the filesystem in Kbytes

Free (KB) Available disk space in Kbytes

Free KB (Non Root) Available disk space for non-superusers in Kbytes

Percent Used Percentage of Disk Space Used

Total Inodes Total size of the filesystem in Kbytes

Available Inodes Available disk space for the file system in Kbytes

Percentage Of Inodes Used Percentage of Inodes Used

TABLE C-19 Disk Service Time Properties(Continued)

Property Description
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FIGURE C-1 Probe Commands for Filesystem Usage

User Statistics Table

The following table provides a brief description of the properties for Solaris User

Statistics:

TABLE C-21 Solaris User Statistics Properties

Property Description

Console User User currently logged in on the console

Number Of Users Number of unique users currently logged in

Number Of User Sessions Number of currently active user sessions

Primary User Login name of the primary user
Appendix C Sun Enterprise SyMON Software - Operating System Modules 339



System Load Statistics Table

The following table provides a brief description of the properties for System Load

Statistics:

CPU Statistics Managed Object Tables

The following tables provide a brief description of the properties for CPU Statistics

managed objects:

■ CPU Utilization Table

■ CPU I/O Table

■ CPU Interrupts Table

■ CPU Systemcall Table

■ CPU Misc Table

■ CPU Process

■ CPU Regwindow Table

■ CPU Pageinfo Table

■ CPU Faults Table

CPU Utilization Table

The following table provides a brief description of the properties for CPU

Utilization:

TABLE C-22 System Load Statistics Properties

Property Description

1 Min Load Average Load average over the last 1 minute

5 Min Load Average Load average over the last 5 minutes

15 Min Load Average Load average over the last 15 minutes

TABLE C-23 CPU Usage Properties

Property Description

CPU Number CPU number

% CPU Idle Time Percentage of time spent by CPU on idle mode

% CPU User Time Percentage of time spent by CPU on user mode

% CPU Kernel Time Percentage of time spent by CPU on kernel mode

% CPU Wait Time Percentage of time spent by CPU on wait mode
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CPU I/O Table

The following table provides a brief description of the properties for CPU I/O:

% CPU Wait Time On I/O Percentage of time spent by CPU on wait mode for I/O

% CPU Wait Time On

Swap

Percentage of time spent by CPU on wait mode for swap

% CPU Wait Time On Pio Percentage of time spent by CPU on wait mode for Pio

Times Idle Thread

Scheduled

Percentage of idle time spent by CPU on threads scheduled

TABLE C-24 CPU I/O Properties

Property Description

CPU Number Central Processing Unit (CPU) number

Physical Block Reads Number of physical block reads

Physical Block Writes Number of physical block writes

Logical Block Reads Number of logical block reads

Logical Block Writes Number of logical block writes

Raw I/O Reads Number of raw I/O reads

Raw I/O Writes Number of raw I/O writes

Bytes Read By Rdwr() Number of bytes read by Rdwr()

Bytes Written By Rdwr() Number of bytes written by Rdwr()

Terminal Input Characters Number of terminal input characters

Chars Handled In

Canonical Mode

Number of chars handled in canonical mode

Terminal Output

Characters

Number of terminal output characters

Physical Block Writes Number of physical block writes

Procs Waiting For Block I/

O

Number of processes waiting for block I/O

TABLE C-23 CPU Usage Properties (Continued)

Property Description
Appendix C Sun Enterprise SyMON Software - Operating System Modules 341



CPU Interrupts Table

The following table provides a brief description of the properties for CPU Interrupts:

CPU Systemcall Table

The following table provides a brief description of the properties for CPU Syscalls:

TABLE C-25 CPU Interrupts Properties

Property Description

CPU Number CPU number

Context Switches Number of context switches

Traps Number of traps

Device Interrupts Number of device interrupts

Interrupts As Threads Number of interrupts as threads

Intrs Blkd/Prempted/

Released

Number of interrupts blocked, pre-empted or released

TABLE C-26 CPU Systemcall Properties

Property Description

CPU Number CPU number

System Calls Number of system calls

Read+Readv System Calls Number of read+ready system calls

Write+Writev System Calls Number of Write+Writev system calls

Forks Number of forks

Vforks Number of Vforks

Execs Number of executables

Msg Count Number of message count

Semaphore Ops Count Number of semaphore operation count

Pathname Lookups Number of pathname lookups

Ufs_iget() Calls Number of ufs_iget() calls

Directory Blocks Read Number of directory block reads

Inodes Taken With Attached

Pages

Number of indexes taken with attached pages
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CPU Misc Table

The following table provides a brief description of the properties for CPU

Miscellaneous:

Indoes Taken With No

Attached Pages

Number of indexes taken with no attached pages

Inode Table Overflows Number of Inode table overflows

File Table Overflows Number of file table overflows

Proc Table Overflows Number of process table overflows

TABLE C-27 CPU Miscellaneous Properties

Property Description

CPU Number CPU number

Involuntary Ctx Switches Number of involuntary context switches

Thread_create()s Number of thread_create()s

Cpu Migrations By Threads Number of CPU migrations by threads

Xcalls To Other Cpus Number of Xcalls to other CPUs

Failed Mutex Enters

(adaptive)

Number of failed mutex enters (adaptive)

Rw Reader Failures Number of read/write reader failures

Rw Write Failures Number of read/write write failures

Loadable Module Loaded Number of loadable module loaded

Loadable Module Unloaded Number of loadable module unloaded

Tries To Acquire RW Lock Number of tries to acquire read/write lock

TABLE C-26 CPU Systemcall Properties (Continued)

Property Description
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CPU Regwindow Table

The following table provides a brief description of the properties for CPU

Regwindow:

CPU Pageinfo Table

The following table provides a brief description of the properties for CPU Pageinfo:

TABLE C-28 CPU Regwindow Properties

Property Description

CPU Number CPU number

User Overflows Number of user overflows

User Underflows Number of user underflows

System Overflows Number of system overflows

System Underflows Number of system underflows

System User Overflows Number of system user overflows

TABLE C-29 CPU Pageinfo Properties

Property Description

CPU Number CPU number

Reclaims Number of reclaims

Reclaims From Free List Number of reclaims from free list

Pageins Number of pageins

Pages Paged In Number of pages paged in

Pageouts Number of pageouts

Pages Paged Out Number of pages paged out

Swapins Number of swap ins

Pages Swapped In Number of pages swapped in

Swapouts Number of swap outs

Pages Swapped Out Number of pages swapped out

Pages Zero Filled On Demand Number of pages zero filled on demand

Pages Freed By Daemon Number of pages fixed by daemon
344 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



CPU Faults Table

The following table provides a brief description of the properties for CPU Faults:

Memory Usage Statistics Table

The following table provides a brief description of the properties for Memory Usage

Statistics:

Pages Examined By Pageout

Daemon

Number of pages examined by the pageout daemon

Revolutions Of The Page

Daemon Hand

Number of revolutions of the page daemon hand

Times Pager Scheduled Number of times pager scheduled

TABLE C-30 CPU Faults Properties

Property Description

CPU Number CPU number

Minor Page Faults Via hat_fault() Number of minor page faults through

hat_fault()

Minor Page Faults Via as_fault() Number of minor page faults through as_fault()

Major Page Faults Number of major page faults

Copy-on-write Faults Number of copy-on write faults

Protection Faults Number of protection faults

Faults Due To Software Locking Req Number of software locking faults

as_fault() s In Kernel addr Space Number of in kernel addr space

TABLE C-31 Memory Usage Statistics Properties

Property Description

Physical Memory Available (MB) Physical memory available in Mbytes

Physical Memory In Use (MB) Physical memory in use in Mbytes

TABLE C-29 CPU Pageinfo Properties (Continued)

Property Description
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Swap Statistics Table

The following table provides a brief description of the properties for Swap Statistics:

Streams Statistics Managed Objects Table

The following section provides the various Streams Statistics properties for the

following managed objects:

■ Streams Head Cache

■ Queue Cache

■ Streams Messages

■ Linkinfo Cache

■ Strevent Cache

■ Synoq Cache

■ Qband Cache

Percent Memory Used Percentage of memory used

Physical Memory Free (MB) Physical memory free in Mbytes

Percent Memory Free Percentage of memory free

TABLE C-32 Swap Statistics Properties

Property Description

Available KB (Anon Memory Not Reserved) Swap available. Total reserved swap

space.

Reserved KB (Anon Memory Reserved But

Not Allocated)

Swap reserved

Allocated KB (Anon Memory Not Free) Swap allocated

Used KB Swap used

Total KB (Used + Available) Swap total

Percent Swap Used Percentage of swap used

TABLE C-31 Memory Usage Statistics Properties (Continued)

Property Description
346 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



The following table briefly describes the managed objects:

All of the preceding property tables have similar entries. These are listed in the

following table.

All of the Streams Statistics managed objects have the same properties. The

following table presents these common properties:

TABLE C-33 Streams Statistics Managed Objects

Properties Description

Stream Head Cache Kernel statistics for streams head cache

Queue Cache Kernel statistics for queue cache

Streams Msgs Kernel statistics for streams messages

Linkinfo Cache Kernel statistics for link information cache

Strevent Cache Kernel statistics for streams event cache

Syncq Cache Kernel statistics for synoq cache

Qband Cache Kernel statistics for qband cache

TABLE C-34 Streams Statistics Table Properties

Property Description

The Name Of The Cache Name of the cache

Current Usage (total - avail) Cache’s current usage

Maximum Capacity Maximum capacity of the cache

Cumulative Total Of Allocations Number of total cache allocations

Number of Allocation Failures Number of allocation failures

Percent Used Percentage of cache used
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Software Rules Table

The following table provides a brief description of the properties for Software Rules:

NFS Statistics Module

This section presents property tables for NFS Statistics:

■ RPC Information Table

■ NFS Information Table

Using the NFS Statistics module, statistical information on the Remote Procedure

Calls (RPC) and Sun’s distributed computing file system (NFS) calls may be

monitored. The number of RPC and NFS calls received by the server and made by

the client are monitored and displayed in the main console window along with the

status of the transaction activity on the local host. The following tables list some of

the properties monitored by this module with both the server and the client

statistics.

RPC Information Table

The following table provides a brief description of the properties for RPC

Information:

TABLE C-35 Software Rules Properties

Property Description

Rule rknrd105 Software rule (refer to rule rknrd105 in Appendix E)

Rule rknrd106 Software rule (refer to rule rknrd106 in Appendix E)

TABLE C-36 RPC Server and Client Information Properties

Property Description

RPC Calls Total number of RPC calls made by the host

Bad RPC Calls Total number of calls rejected by the RPC layer

Bad RPC Calls % Percentage of rejected calls compared to the total number of calls

made (bad RPC Calls/RPC calls)

RPC Call Rate Number of RPC calls made per second
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NFS Information Table

The following table provides a brief description of the properties for NFS

Information:

Solaris Process Details Module

The Solaris Process Details module parameters are listed in the following table. This

table is seen when you try to load the module.

The following section presents the Solaris Process property table.

TABLE C-37 NFS Server and Client Information Properties

Property Description

NFS Calls Total number of NFS calls sent by the host

Bad NFS Calls Total number of NFS calls rejected

Bad NFS Calls % Percentage of rejected NFS calls compared to the total number of

calls sent (bad NFS calls/NFS calls)

NFS Call Rate Number of NFS calls sent per second

TABLE C-38 Solaris Process Details Parameters

Property Description

Module Name Name of the module (this is not editable)

Module Description Description of the module (this is not editable)

Version Version of the module (this is not editable)

Enterprise SNMP enterprise in which the module is loaded (this is not editable)

Module Type Type of the module (this is not editable)

Number of

Processes

Number of processes that is obtained by the module based on the

following selection criteria. One of the given numbers can be

selected by the user.

Selection Criteria Selection criteria by which the processes are sorted and selected. For

example, the user can select the top 10 processes using this function.
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Process Table

The following table provides a brief description of the properties for Solaris Process:

TABLE C-39 Process Properties

Property Description

PS Process ID Process ID of this process

PS Parent Process ID Process ID of the parent of this process

PS User ID Login ID of the user of this process

PS User Name Login name of the user of this process

PS Effective User ID Effective user ID of this process

PS Group ID Real group ID of this process

PS Effective Group

ID

Effective group ID of this process

PS Session ID Process ID of the session leader of this process

PS Process Group ID Process ID of the process group leader of this process

PS TTY Controlling terminal for this process

PS Start Time Starting time of this process

PS Time Cumulative execution time of this process

PS State State of this process

PS Wait Channel Address of an event for which this process is waiting

PS Scheduling Class Scheduling class of this process

PS Address Memory address of this process

PS Size Total size of this process in virtual memory

PS Priority Priority of this process

PS Nice Nice value of this process, which is used for priority computation

PS Percent CPU

Time

Percent CPU time

PS Percent Memory Percent memory

PS Command Base name of the executable file for this process

PS Command Line Full command name of this process, including the arguments
350 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



NFS File Systems Module

The NFS File Systems module enables you to monitor the NFS file systems on hosts

running the Solaris 2 and Solaris 7 operating environments. The NFS File Systems

module monitors the amount of disk space occupied by mounted or unmounted file

systems: the amount of used and available space as well as the remaining total

capacity.

When loading the NFS File Systems module, you may define which file systems you

want to monitor by using pattern matching. Patterns may be used to filter which

NFS file systems are monitored by file system or mount point.

File System Usage Table

The following table provides a brief description of the properties for NFS Filesystem

Usage:

TABLE C-40 Filesystem Usage Properties

Property Description

NFS Filesys Name of the NFS filesystem

Size Total size of the NFS filesystem in Kbytes

Used Used disk space for the NFS file system in Kbytes

Available Available disk space for the NFS file system in Kbytes

% Used Percentage of NFS disk space used

Rate Percentage capacity change per second

Mount Point Mount point for the NFS filesystem

Entry Number Entry number of the NFS filesystem
Appendix C Sun Enterprise SyMON Software - Operating System Modules 351



352 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



APPENDIX D

Sun Enterprise SyMON - Local &
Remote Application Modules

The Sun Enterprise SyMON software monitors various components of your system,

including your hardware, operating environment, local applications, and remote

systems. This section provides additional explanation for the core modules described

in Chapter 12 and presents them in their respective categories.

This appendix describes the following modules. For more information on other

modules that may be applicable to your particular system, see the previous

appendix, your supplement, or go to the Sun Enterprise SyMON web site: http://
www.sun.com/symon .

■ Local Applications

■ Agent Statistics Module

■ Data Logging Registry Module

■ Health Monitor Module

■ Print Spooler Module

■ Process Monitoring Module

■ File Scanning (System Log) Module

■ Remote Systems

■ MIB-II Proxy Monitoring Module

■ HP JetDirect Module

Most of these modules have default monitoring conditions that generate alarms

when system values fall outside of these conditions. You may alter these default

thresholds by creating your own alarm thresholds, as explained in Chapter 12.

Also, there are modules that utilize the Add Row operation to define what data

properties to monitor. These modules will come up with empty tables and you have

to execute an Add Row operation to activate the specifics for monitoring the

modules.
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The following table lists the modules described in this appendix alphabetically and

provides details on those modules that are automatically loaded and those that can

be loaded multiple times. It also points out those modules that utilize the Add Row

utility.

Local Applications

The following modules, when loaded, are found under the local applications icon:

■ Agent Statistics Module

■ Data Logging Registry Module

■ File Scanning (System Log) Module

■ Health Monitor Module

■ Process Monitoring Module

■ Print Spooler Module

TABLE D-1 Modules Loaded Automatically, Multiple Times, and Use ‘Add Row’
Operation

Alphabetical Listing of Core Modules Module Loads
Automatically

Module Loads
Multiple Times

Module Uses
Add Row Utility

Agent Statistics Module X

Config-Reader Module1

1. Refer to your platform-specific supplement for more information on the Config-Reader module.

X

Data Logging Registry Module X

Dynamic Reconfiguration

Module2

2. Refer to your platform-specific supplement for more information on the Dynamic Reconfiguration module.

File Scanning (System Log)

Module

X X X 3

3. Each added row defines what pattern within the monitored file to match. The row needs to be added to the
table, Scan Table.

HP JetDirect Module X

Health Monitor Module

MIB-II Proxy Monitoring Module X

Print Spooler Module X

Process Monitoring Module X X4

4. Each row defines what pattern to match from all the processes that are running on the agent host.
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Agent Statistics Module

This section presents the following information on Agent Statistics:

■ Object Statistics Table

■ Commands Executed Table

■ Transactions Performed Table

■ PA Process Statistics Table

■ PA Total Process Statistics Table

The Agent Statistics module monitors the health of the agent installed on a host.

This module monitors the objects, processes, and execution of processes by the

agent.

The following table provides a brief description of the Agent Statistics managed

objects:

TABLE D-2 Agent Statistics Main Sections

Agent Statistics Tables Description

Object Section Displays data on the objects loaded onto the agent. Status field

displays the current status of the TOE and binary objects loaded into

and used by the agent.

Execution Section Displays data on the number of TCL or TOE commands invoked by

the agent interpreter. Also displays data on the number of

asynchronous transactions initiated by the agent. Status field

displays a brief description of the current status of the objects listed.

TABLE D-3 Agent Statistics Section Properties

Property Description

Object Statistics TOE Count - Number of TOE objects loaded into the agent bob

Count - Number of binary object buffers used by the agent

Commands Executed Total - Total number of commands that have been executed by the

agent

Rate (#/sec) - Number of commands executed by the agent per

second

Transactions

Performed

Total - Total number of transactions performed by the agent

Rate (#/sec) - Number of transactions performed by the agent per

second

PA Process Statistics Process statistics pertaining to the PA

PA Total Process

Statistics

Total process statistics pertaining to the PA
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The following lists default alarm thresholds for applicable Agent Statistics modules:

The following sections describe the property tables for Agent Statistics.

Object Statistics Table

The Objects section displays data on the Objects loaded onto the agent. The Status

field displays the current status of the TOE and binary objects loaded into and used

by the agent.

The following table provides a brief description of the properties for Object

Statistics:

TABLE D-4 Agent Statistics Alarm Thresholds

Agent Statistics Condition

Error If toeCount > 6000

Warning If toeCount > 5000

Error If bobcount > 1200

Warning If bobcount > 1000

Warning If commands rate > 6000

Warning If transactions rate > 8

Error If process size > 35000

Warning If process size > 30000

Error If rss > 25000

Warning If percentage CPU time > 90

Warning If totalstats.count > 15

Error If totalstats.size > 40000

Warning If totalstats.size > 35000

Warning If totalstats.rss > 35000

TABLE D-5 Object Statistics Properties

Property Description

Total TOE Objects Number of TOE objects loaded into the agent

Total Bobs Number of binary object buffers used by the agent
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Commands Executed Table

The following table provides a brief description of the properties for Commands

Executed:

Transactions Performed Table

The following table provides a brief description of the properties for Performed

Transactions:

PA Process Statistics Table

The software monitors the PA process statistics. The following table provides a brief

description of the properties for PA Process Statistics:

TABLE D-6 Executed Commands Properties

Property Description

Total Commands Total number of commands that have been executed by the agent

Rate (/sec) Number of commands executed by the agent per second

TABLE D-7 Transactions Performed Properties

Property Description

Total Transactions Total number of transactions performed by the agent

Transaction Rate

(/sec)

Number of transactions performed by the agent per second

TABLE D-8 PA Process Statistics Properties

Property Description

Process ID Identification number of the process

Process Unique Id Unique identification number of the process

Process Name Name of the process

Process Status Status of the process

Process State State of the process

User ID User ID of the process

Virtual Size Total size of the process
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PA Total Process Statistics Table

The software monitors the total PA process statistics.

The following table provides a brief description of the properties for Total PA

Process Statistics:

Data Logging Registry Module

The Data Logging Registry consists of the registry table.

Resident Set Size Resident size of the process

Elapsed Time Startup time of the process in seconds since January 1, 1970

Start Date Startup date of the process

Start Time Startup time of the process

CPU Time CPU time used by the process

Percent CPU Time Percentage of CPU time used by the process

Context Switches Context switches of the process

System Calls System calls made by the process

Command Line Command line of the process

TABLE D-9 Total PA Process Statistics Properties

Property Description

Number of Processes Number of agent and child processes

Total Virtual Size Total virtual size of agent and children

Total Res Size Total resident set size of agent and children

TABLE D-8 PA Process Statistics Properties (Continued)

Property Description
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Registry Table

The following table provides a brief description of the properties for Data Logging

Registry:

Health Monitor Module

The Health Monitor module monitors the health of your host. When alarm

conditions occur, this module offers suggestions, if necessary, on how to improve the

performance of the system.

For example, this module monitors the swap space that is available, reserved,

allocated, and used. Sample alarm messages, from lowest to highest severity,

include:

■ No Worries: sufficient swap space available

■ There is lots of unused swap space

■ Not much swap left: perhaps add some more

■ Swap space shortage: add some more now

■ Dangerous swap space shortage: add more immediately

This section describes properties of the following Health Monitor module managed

objects:

■ Swap Table

■ Kernel Contention Table

■ NFS Table

■ CPU Table

■ Disk Table

TABLE D-10 Data Logging Registry Properties

Property Description

Log Destination

State

State of the log file destination

Module Name Module name for data value (data from this module is logged in the

registry)

Instance Name Name of the instance

Property Name Property name for data value

Logging Interval Logging interval for data value

File Logging Name of the logged file

Data Cache Cache data

Cache Size (samples) Cache size samples
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■ RAM Table

■ Kernel Memory Table

■ Directory Cache Table

The Health Monitor module tracks the system properties for the above as described

in the following table:

Swap Table

The following table provides a brief description of the properties for Swap:

TABLE D-11 Health Monitor Properties

Property Description

Swap Details the swap space

Kernel Contention Monitors the kernel contention (mutex) properties

NFS Provides NFS client information

CPU Provides information on the power of the CPU

Disk Presents the disc I/O information

RAM Random Access Memory (RAM) information

Kernel Memory Information on kernel memory

Directory Cache Cache of the directory

TABLE D-12 Swap Properties

Property Description

Swap Available KB Swap space value available

Swap Reserved KB Swap space value reserved

Swap Allocated KB Swap space value allocated

Swap Used KB Swap space value used

Swap Rule Rule for swap
360 Sun Enterprise SyMON 2.0.1 Software User’s Guide • May 1999



Kernel Contention Table

The following table provides a brief description of the properties for Kernel

Contention (mutex):

NFS Table

The following table provides a brief description of the properties for NFS client

information:

TABLE D-13 Kernel Contention Properties

Property Description

Spins On Mutexes Spins on mutexes (lock not acquired on first try) - Sum for all CPUs

Number Of CPUs Number of CPUs

Spins On Mutexes Rule Spins on mutexes (lock not acquired on first try) - Sum for all CPUs

TABLE D-14 NFS Client Information Properties

Property Description

Calls Total number of RPC calls received

Badcalls Total number of calls rejected by the RPC layer

Retrans Call retransmitted due to a timeout

Badxids Reply from server not corresponding to any outside call

Timeouts Call timed out while waiting for a reply from server

Newcreds Number of times authentication information was refreshed

Badverfs Calls failed due to a bad verifier in response

Timer Call timed out while waiting for a reply from server

Nomem Failure to allocate memory

Can't Send Failure to send NFS/RPC rule

NFS/RPC Rule Value of the NFS/RPC rule
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CPU Table

The following table provides a brief description of the properties for the central

processing unit (CPU):

Disk Table

The following table provides a brief description of the properties for Disk:

TABLE D-15 CPU Properties

Property Description

Processes In Run

Queue

Number of processes in run queue

Processes Waiting Number of processes blocked for resources

Processes Swapped Number of processes that can be run but swapped

CPU Power Rule CPU power rule

TABLE D-16 Disk Properties

Property Description

Disk Name Name of the disk

Disk Alias Name of the disk (for example, c0t0d0 )

Percent Disk Wait Average number of transactions waiting for service

Percent Disk Busy Percent of time disk is busy

Service Time (ms) Average service time in milliseconds

Disk Rule Disk rule
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RAM Table

The following table provides a brief description of the properties for random access

memory (RAM):

Kernel Memory Table

The following table provides a brief description of the properties for Kernel

Memory:

Directory Cache Table

The following table provides a brief description of the properties for Directory

Cache:

TABLE D-17 RAM Properties

Property Description

Handspread Value of hand spread (one of kernel parameters) pages

Scan rate Page scan rate

Real Memory rule Real memory rule

TABLE D-18 Kernel Memory Properties

Property Description

Total Kernel Allocation

Fails

Value of kernel allocation failure

Physical Memory Free Value of free physical memory

Kernel Memory Rule Value of kernel memory rule

TABLE D-19 Name Cache Statistics Properties

Property Description

Cache Hits Number of times a previously accessed page is found

Cache Misses Number of times a previously accessed page is missed

DNLC Rule DNLC (Directory Name Lookup Cache) rule
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Print Spooler Module

The Print Spooler module monitors the status of the printer daemon and print queue

on the local host as well as the printer devices installed on it.

■ Printer LPsched Table

■ Printer Devices Table

■ Printer Queues Table

The following table describes the print spooler managed objects:

Printer LPsched Table

The printer daemon section displays data on the LP Request Scheduler. The

following table provides a brief description of the properties for the Line Printer’s

Schedule (LPsched):

Printer Devices Table

The Printer Devices table lists the network printers installed on a network printer

server(s). The instance name or alias of the printer is displayed in the Name field

followed by the name of the host on which it is installed, displayed in the Machine

field. If you are running a console displaying data monitored by an agent on a print

server host, the path name of the printer device is displayed in the Device field.

TABLE D-20 Print Spooler Properties

Property Description

Lpsched Status Status of the lpsched process

Printer Devices Table lists information about the printer devices

Printer Queues Table lists information about the printer queue

TABLE D-21 Printer LPsched Properties

Property Description

LPsched state Current status of the printer.
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The following table provides a brief description of the properties for Printer Devices:

Printer Queues Table

The Print Queues table lists the print queues on the local host and displays the

status of each queue. The following table provides a brief description of the

properties for Printer Queues:

Process Monitoring Module

The following section describes the Process Monitoring module parameters and their

property descriptions. This module requires you to add rows for the data property

tables. For more information, see “Working with Rows” on page 146.

When a process “hit” is found, the %CPU and a count of the number of processes

which match is displayed. If you want to change the module parameters, you can

edit all the parameters except for the entry name by accessing the pop-up menu. See

“Pop-up Menu” on page 119 for more information.

TABLE D-22 Printer Devices Properties

Property Description

Printer name Name of the printer device

Host name Name of the host to which the device is attached

Device name Alphanumeric device name

TABLE D-23 Printer Queues Properties

Property Description

Queue Name Name of the printer

Queue State Current status of the printer queue

Total Number of

Queue Jobs

Total number of jobs in the queue

Total Number of

Current Printer Jobs

Number of jobs currently spooled in the queue

Printer Queue Size Total size (in Kbytes) of the jobs currently spooled in the queue
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Process Statistics Table

The following table provides a brief description of the properties for Process

Statistics:

Note – The first five row entries in TABLE D-24 must be entered by you when adding

a row to the process statistics table. See “To Add a Row” on page 146 for more

information.

File Scanning (System Log) Module

The File Scanning module scans files on a host for user-specified patterns. Multiple

instances of the File Scanning module may be loaded to scan multiple files. This

module requires you to add rows for the data property tables. For more information,

see “Working with Rows” on page 146.

The File Scanning module has the following managed objects:

■ File ID Table

■ File Statistics Table

■ Scan Table

TABLE D-24 Process Statistics Properties

Property Description

Entry Name Name of the entry (must be a unique name)

Name Pattern Pattern to match the name of the process that you want to monitor

Argv Pattern Pattern to match the arguments of the command which executes the

process

User Specification User name executing the command

Entry Description Description of the entry (mandatory field)

Monitoring State Toggle between on (row is enabled) and off (row is disabled). When

the row is disabled, all the entries are displayed as 0 (zero).

Process Command Name process

% CPU Usage Percentage CPU used by the processes

Virtual Size Total size of the processes

Resident Set Size Resident size of the processes

Process Count Number of the processes that matched the pattern
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The following table provides a brief description of the properties for File Scanning:

File ID Table

The following table provides a brief description of the properties for File ID:

File Statistics Table

The File Statistics table displays summary information on the file that is to be

scanned. The following table provides a brief description of the properties for File

Statistics:

TABLE D-25 File Scanning (System Log) Properties

Property Description

File ID Name given by you to the pattern used in the file scan

File Stats State of the pattern listed

Scan Table Name given by you to the pattern used in the file scan

TABLE D-26 File ID Properties

Property Description

Filename Full path name of the file to be scanned

Scan Mode Mode in which the file is being scanned

Start Time Time the file scan was first started

TABLE D-27 File Statistics Properties

Property Description

Modification Time Date and time when the file was last modified

File Size Size of the file in bytes

Number of Lines Number of lines contained in the file

Lines Per Second Rate at which the file is changing in lines per second
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Scan Table

The following table provides a brief description of the properties for Scan:

Remote Systems

The software enables you to monitor remote systems, such as HP printers equipped

with a JetDirect card.

The following modules, when loaded, are found under the local remote system icon:

■ MIB-II Proxy Monitoring Module

■ HP JetDirect Module

MIB-II Proxy Monitoring Module

The MIB-II Proxy Monitoring module monitors the MIB-II parameters for remote

systems. The various categories that monitor the MIB-II parameters on remote

systems are listed in the following sections, which list MIB-II group tables:

■ MIB-II System Group Table

■ MIB-II Interfaces Group Tables

■ MIB-II IP Group Table

■ MIB-II ICMP Group Table

■ MIB-II TCP Group Tables

■ MIB-II UDP Group Tables

TABLE D-28 Scan Table Properties

Property Description

Pattern Name Name given by you to the pattern used in the file scan

Pattern Description Name of the pattern entry to be displayed in the name field of the

Scan Results section

Regexp Pattern Regular expression pattern to be used when scanning the file for

entries

Pattern State State of the pattern listed (on/off). The off state indicates that the

pattern listed will not be used in the file scan

Matches Number of pattern matches found during the file scan

Total Matches Total number of matches in current file
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For more information on the properties of these parameters, see “MIB-II

Instrumentation Module” on page 326, which lists the properties for local systems.

The same functionality is applied on remote systems by the MIB-II Proxy Monitoring

module. For more information on the definition of MIB-II, see the standards

documentation RFC1213 (Request For Comments 1213).

HP JetDirect Module

Agents can monitor HP printers equipped with a JetDirect card by proxy using the

HP JetDirect module. Multiple HP printers may be monitored by loading multiple

instances of this module.

Printer Status Table

The following table provides a brief description of the properties for Printer Status:

For platform-specific information, see your supplement.

TABLE D-29 General Printer Status Properties

Property Description

Printer Display Printer’s status
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APPENDIX E

Sun Enterprise SyMON Software
Rules

This appendix lists the Sun Enterprise SyMON rules for the following modules:

■ Kernel Reader

■ Health Monitor

A rule is an alarm check mechanism that allows for complex or special purpose logic

in determining the status of a monitored host or node.

There are two types of rules—simple and complex:

■ Simple rules are based on the rCompare rule, in which monitored properties are

compared to the rule. If the rule condition becomes true, an alarm is generated.

For example, a simple rule can be the percentage of disk space used. If the

percentage of disk space used equals or is greater than the percentage specified in

the rule, then an alarm is generated.

■ Complex rules are based on multiple conditions becoming true. For example, one

complex rule states that when a disk is over 75% busy and the average queue

length is over 10 and the wait queue is increasing, then an alert alarm is

generated.

Note – Any user-customized Solstice SyMON 1.x rules must be ported to the new

environment before the rules can be used in Sun Enterprise SyMON 2.0.1 software.
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Kernel Reader

The following table lists the Kernel Reader simple rules.

TABLE E-1 Kernel Reader Simple Rules

Property Description

avg_1min Load Averages Over The Last 1 Minute

avg_5min Load Average Over The Last 5 Minutes

avg_15min Load Average Over The Last 15 Minutes

cpu_delta Difference between the previous and current time

cpu_idle CPU idle time

cpu_kernel CPU kernel time

cpu_user CPU user time

cpu_wait CPU wait time

ipctused Percent of inodes used

kpctused Percent of Kbytes used

mem-inuse Physical Memory In Use (MBytes)

numusers Number Of Users

numsessions Number Of User Sessions

swap_used Swap Used Kbytes

wait_io CPU wait time breakdown

wait_pio CPU wait time breakdown

wait_swap CPU wait time breakdown
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The following table lists the Kernel Reader complex rules.

TABLE E-2 Kernel Reader Complex Rules

Rule ID Description Type of Alarm

rknrd100 This rule covers a transitory event and generates an alert

alarm when the disk is over 75% busy, the average queue

length is over 10, and the wait queue is increasing. Alert

alarm stays on until the disk is not over 70% busy and the

average queue length is no longer than 8.

Alert

rknrd102 This rule covers a transitory event and generates an alert

alarm if 90% of swap space is in use. Event causing the alarm

stays open until swap space in use is less than 80% of the total

swap space.

Alert

rknrd103 This rule covers a transitory event and generates an alert

alarm if swapping and paging is high for a given CPU. This

indicates that a CPU may be thrashing. Alert alarm is

generated when CPU exceeds 1 swap-out, 10 page-ins, and 10

page-outs per second. Alert alarm stays on if CPU exceeds 1

swap-out, 8 page-ins, and 8 page-outs per second.

Alert

rknrd105 File System Full error. This rule looks for a file system full

error message in the syslog (/var/adm/message ).

Alert alarm that is

closed immediately

rknrd106 No swap space error. This rule looks for a no swap space error

message in the syslog (/var/adm/message).
Alert alarm that is

closed immediately

rknrd400 This rule checks for a continuous CPU load over 6 per CPU

for four hours.

Informational

rknrd401 This rule checks for disks being busy more than 90% of the file

for x hours. The parameters field holds the last time CPU load

was below 6, and is initialized to some date in the year 2001.

Informational

rknrd402 This rule checks if available swap space drops below 10% for

x hours. The parameters field holds the last time CPU load

was below 6, and is initialized to some date in the year 2001.

Informational

rknrd403 Test for Meta CPU events. Informational

rknrd404 Test for Meta Disk events. Informational

rknrd405 Test for Meta Swap events. Informational
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Health Monitor

The following table lists the Health Monitor complex rules.

TABLE E-3 Health Monitor Complex Rules

Rule ID Description Type of Alarm

rhltm000 This rule checks whether there is enough swap space. Critical, Alert,

Caution

rhltm001 Each time a CPU has to wait for a lock to become free, it

wastes CPU power; and this event is counted, since the kernel

uses mutually exclusive locks to synchronize its operation and

keep multiple CPUs from concurrently accessing critical code

and data regions.

Critical, Alert,

Caution

rhltm002 This rule is based on the observation that NFS remote

procedure call timeouts may be associated with duplicate

responses after the call is retransmitted. This indicates that the

network is okay but the server is responding slowly.

Critical, Alert,

Caution

rhltm003 Here the run queue length is divided by the number of CPUs.

This is based upon the fact that every CPU takes a job off the

run queue in each time slice.

Critical, Alert,

Caution

rhltm004 A busy or slow disk reduces system throughput and increases

user response times. This rule identifies the disks that are

loaded so that the load can be rebalanced.

Critical, Alert,

Caution

rhltm005 RAM rule based on residency time for an unreferenced page.

The virtual memory system indicates that it needs more

memory when it scans looking for idle pages to reclaim for

other uses.

Critical, Alert,

Caution

rhltm006 This rule refers to the kernel memory allocation problem. It

shows up when login attempts or network connections fail

unexpectedly. There are two possible causes. Either the kernel

has reached the extent of its address space, or the free list does

not contain any pages to allocate. It is more a sign of a

problem that may otherwise be overlooked.

Critical, Alert,

Caution

rhltm007 There is a global cache of directory path name components

called the directory name lookup cache, or Directory Name

Lookup Cache Rule (DNLC). Missing a cache means that

directory entries must be read from disk and scanned to locate

the right file.

Critical, Alert,

Caution
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APPENDIX F

Internet Protocol Routing

This appendix describes:

■ Overview of IP Addressing

■ Subnetting

■ Netmasks

Overview of IP Addressing

Internet protocol (IP) addresses are 32 bits long. Thus, there is a total possibility of

approximately 4 billion addresses for the entire Internet. An IP address is expressed

as a series of octets separated by dots. For example, the address 11111111 00000001

00000101 00001010 is written as 127.1.5.10, or using hexadecimal notation, 7f.1.5.a0.

Because of this vast number of addresses, there was a need to organize the network

hierarchically into domains. This need led to the definition of name domains and

network classes. Since each site can vary in size, IP addresses are divided into three

main types or classes. A large site can reserve a class A address and receive 224

individual addresses, while a small site can reserve a class C address and receive 28

individual addresses.

Network Classes

Class A uses the first octet for the network address, and the rest for host addresses

within this network. For example, a site whose network address is 129.0.0.0 would

own the 224 addresses between 129.0.0.0 and 129.255.255.255.

Network Host

0xxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx
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Class B uses two octets for the network address, and two for the host address. For

example, a site whose network address is 129.123.0.0 would own the 216 addresses

between 129.123.0.0 and 129.123.255.255.

Class C uses three octets for the network address, and one for the host address. For

example, a site whose network address is 129.123.456.0 would own the 28 addresses

between 129.123.456.0 and 129.123.456.255.

Subnetting

Subnetting is defined as dividing a network into smaller segments, or subnets,

which is imperative for Class A and B networks. Routers do not forward packets

outside a subnet if the destination address is within the same subnet. Thus, network

traffic is decreased dramatically by segmenting a large network. For example, we

have a class B network that is segmented into 255 subnets. Unless a packet

destination is a host outside the subnet, a local packet is sent to 255 hosts instead of

256,000.

Netmasks

The format of the netmask is a series of 1s followed by a series of 0s. By ANDing an

IP address with a netmask, we can get the address of the subnet.

Routers use netmasks to decide whether to forward a packet to an external subnet.

For example, we have a machine with an IP address of 129.123.456.95 that is sending

an email to another machine whose IP address is 129.123.456.100. By ANDing both

IP addresses with a netmask (255.255.255.00), the result is 129.123.456.0 for both

machines. The router then concludes that both the source machine and destination

machine are in the same subnet. Therefore, the router does not forward the email to

external subnets.

Network Host

10xxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Network Host

110xxxxx xxxxxxxx xxxxxxxx xxxxxxxx
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On the other hand, if the destination address is 129.123.567.100, then the resulting

subnet address is 129.123.567.0. The router forwards the email to the external subnet

(129.123.567.0).

Note – Although some of these examples apply to Ethernet links, the principles still

apply regardless of the type of network.
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Glossary

agent A software process, usually corresponding to a particular local managed host,

that carries out manager requests and makes local system and application

information available to remote users.

alarm An abnormal event, which may be indicative of current or impending

problems, is detected by a Sun Enterprise SyMON agent. The agent passes

information about the abnormal event to the Sun Enterprise SyMON server.

The server passes this information on to the user as an alarm, when the

abnormal event matches a predefined alarm threshold.

alarm
acknowledgment Sun Enterprise SyMON users can acknowledge alarms, indicating that the

alarm does not represent a serious problem or that the problem is being

resolved. Acknowledged alarms take a lower priority than unacknowledged

alarms.

Attribute Editor A window which provides information about the selected object. In addition,

the Attribute Editor enables you to customize various monitoring criteria for

that object. The monitoring criteria are dependent on the type of object. There

are Attribute Editors for domains, hosts, modules, and data properties.

bus A point-to-point network component. Used by the software to represent a

network link to which many other hosts may be connected.

community A string similar to a password that is used to authenticate access to an agent’s

monitored data.

complex alarm A complex alarm is based on a set of conditions becoming true. Unlike simple

alarms, you cannot set thresholds for complex alarms.

Console window A graphical user interface component of Sun Enterprise SyMON software

based on Java technology that is used to view monitored hosts (and managed

objects) information and status and to interact with Sun Enterprise SyMON

agents.
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Discovery A Sun Enterprise SyMON tool available from the main console window that is

used to find hosts, routers, networks, and Simple Network Management

Protocol (SNMP) devices that can be reached from the Sun Enterprise SyMON

server.

domain An arbitrary collection of hosts and networks that are monitored by the

software as a single hierarchal entity. Users may choose to divide their

enterprise into several domains, each to be managed by different users.

dynamic loadable
modules A Sun Enterprise SyMON agent module that can be loaded or unloaded at run

time, enabling monitored properties to be displayed on the main console

window without having to restart the console or agent.

event A change in the state of a managed object.

file scanning The act of scanning a file (usually a log file) for certain patterns (regular

expressions) that may be indicative of problems or significant information. Sun

Enterprise SyMON agents use file scanning to assist in the monitoring of

systems and applications when these components do not provide direct access

to status information.

graphical user
interface The graphical user interface, or GUI, is a window that provides the user with a

method of interacting with the computer and its special applications, usually

with a mouse or other selection device. The window usually includes such

things as windows, an intuitive method of manipulating directories and files,

and icons.

hierarchy view A window view that defines objects in a hierarchy or tree relationship to one

another. Objects are grouped depending on the rank of the object in the

hierarchy.

hop The number of routers a packet goes through before reaching its destination.

instance A single word or alpha-character string that is used internally within the Sun

Enterprise SyMON agent to identify uniquely a particular module or a row

within a module.

manage In Sun Enterprise SyMON software, manage is defined as being able to

monitor, as well as manipulate the object. For example, management privileges

include acknowledging and closing alarms, loading and unloading modules,

changing alarm thresholds, and so on. Management privileges are similar to

read, write, and execute access.

MIB Management Information Base. A MIB is a hierarchical database schema

describing the data available from an agent. The MIB is used by Sun Enterprise

SyMON agents to store monitored data that can be accessed remotely.

module A software component that may be loaded dynamically to monitor data

resources of systems, applications and network devices.
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monitor In Sun Enterprise SyMON software, monitor is defined as being able to

observe an object, view alarms and properties. Monitoring privileges are

similar to read-only access.

node A node is a workstation or server.

object A particular resource (computer host, network interface, software process, and

so on) which is subject to monitoring or management by Sun Enterprise

SyMON software. A managed object is one that you can manipulate. For

example, you can acknowledge and turn off an alarm condition for an object

that you can manage. A monitored object is one that you can observe but not

acknowledge or otherwise manage.

remote server context A remote server context refers to a collection of Sun Enterprise SyMON agents

and a particular server layer with which the remote agents are associated.

request caching The Sun Enterprise SyMON server consolidates duplicate outstanding requests

originating from multiple consoles and eliminates the execution of redundant

requests.

rule A rule is an alarm check mechanism that allows for complex or special purpose

logic in determining the status of a monitored host or node.

seed The password for the Sun Enterprise SyMON user group called esmaster . The

seed is an alpha-numeric string of up to 8 characters. (This is not necessarily a

UNIX password.) You can select your own seed, or accept the default seed

(maplesyr ) provided by the Sun Enterprise SyMON software. If you select

your own seed, be sure to record it for later reference.

server The collection of programs and processes (SNMP-based trap, event, topology,

configuration, and Java server) that work on behalf of a Sun Enterprise

SyMON user to help manage a particular set of networks, hosts and devices.

Usually sends requests to Sun Enterprise SyMON agents, accepts collected

data from them, and passes the data to the main console window for display.

server context See “remote server context.”

simple alarm Simple alarms are based on one condition becoming true. You may set alarm

thresholds for simple alarms.

SNMP Simple Network Management Protocol. A simple protocol designed to allow

networked entities (hosts, routers, and so on) to exchange monitoring

information.

SNMPv2 usec SNMP version 2, user-based security model security standards.

Sun Enterprise SyMON
superuser Sun Enterprise SyMON superuser is a valid user on a server host. The

superuser decides what the agents are in the context of the server. By default,

the superuser password is used as a seed for security key generation.
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Sun Enterprise SyMON
user Sun Enterprise SyMON users are the members of the symon group in the

/etc/group file.

topology view The topology view displays the members of the object selected in the hierarchy

view.

URL Uniform Resource Locator. An URL is a textual specification describing a

resource which is network-accessible.
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Index
A
A5000, A5100, A5200 physical view, 275

absolute Time Editor expression, 186, 195 to 201

access control, 282, 286

ACL, 282, 286

Actions tab, 175

adding

a row to a data property table, 146 to 149

from graph clipboard, 156 to 158

objects to domains, 97 to 112

add-on components, 20

Address process property, 260

administrative domain definition, 51

advanced message filtering menu, 267

agent

health, 210

interacting with console and server, 3 to 5

port number, 307

SNMP, 10

agent down alarm notification, 235

Agent Statistics

Configuration manager, 310

Event manager, 310

Sun Enterprise SyMON server, 310

Topology manager, 310

Trap handler, 310

alarm limits, 173

alarm threshold

creating, 174 to 175, 289

alarms

accessing, 244

acknowledged, 240

alert, 374

alert alarm generation, 371

categories, 245

caution, 374

complex, 9

creating, 239

critical, 374

determining the severity of an alarm, 239

generation, 371

red alarm icon, 239

schedule, 185

seeing, 127

sending email when alarm occurs, 177

setting schedule, 202 to 207

severities, 127

simple, 9, 172 to 173

simple rules, 371

states, 245

threshold, 172 to 173

unacknowledged, 240

windows, 173

Alarms tab button in the Details window, 252

Alarms tab in the Attribute Editor, 172 to 173

Attribute Editor, 138

Actions tab, 175

Alarms tab, 172 to 173

definition, 169

History tab, 180

Info tab, 171

module, 226, 230

opening, 170

Refresh tab, 178
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Security tab, 290

attributes

changing, 89 to 91

automatic notification of an alarm condition, 177

B
Browser Details window, 129, 130

Browser tab button in the Details window, 252

buttons

Discovery Request window, 99 to 100

Domain Manager window, 57

Hide Details, 277

Show Details, 277

C
changing attributes about an object, 89 to 91

changing port addresses, 306 to 309

circular log files, 319

class A, B, and C networks, 375

Class process property, 260

Command process property, 261

CommandLine process property, 261

comparison Time Editor expression, 187 to 194, 202

to 207

complex alarms, 9

complex rule

alert alarm generation, 371

definition, 371

Config Reader, 130, 136, 252

special instructions for Details window, 271

Configuration Details window, 130

Configuration manager, 5, 287

agent statistic, 310

port number, 307

Configuration tab button in the Details

window, 252

configuring

Details Process display, 259 to 262

legacy agent as subagent, 304 to 306

port addresses, 306 to 309

conflict with port addresses, 306 to 309

connecting objects, 86

console, 3, 10

interacting with server and agent, 3 to 5

multiple consoles, 3

copying

data property to graph, 138

groups, 88 to 89

module, 137

objects, 87 to 89

to graph clipboard, 156 to 158

CPU thrashing, 373

CPU% process property, 261

creating

a module object, 75 to 77, 226

alarm threshold, 174 to 175

alarms, 239

domains, 58

groups, 78 to 80

links between objects, 86

monitored modules, 75 to 77

nodes, 70 to 74, 81 to 83

objects with Discovery manager, 101 to 104

segments, 84 to 86

server component object, 311

critical

alarms, 374

cron Time Editor expression, 186, 195 to 201

cutting objects, 92 to 93

cyclic Time Editor expression, 186, 187 to 194

D
data

displaying, 144

probing, 152 to 155

refreshing, 151

data property

Attribute Editor, 169

displaying, 144

graphing, 156

monitoring, 185

probing, 153

refresh interval, 179

sampling points, 182

tool tip, 119

data property table

adding row to, 146 to 149
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default domain, 53

default privileges

overriding, 296

topology manager, Sun Enterprise SyMON

default security privileges, 295

deleting

discovery request, 112

domains, 57, 60 to 62

events from event database, 316 to 318

objects, 94 to 95

row, 138

Details

alarms, 130

browser, 130

configuration, 130

log view, 130

processes, 130

Details Process display

configuring, 259 to 262

selecting columns, 259 to 261

Details window

Actions tab in the Attribute Editor, 175

Alarms tab button, 252

Alarms tab in Attribute Editor, 172 to 173

Browser tab button, 129, 252

Configuration information types, 270

Configuration tab button, 252

disk total, 272

exiting, 132

History tab in the Attribute Editor, 180

Info tab button, 252

Info tab in Attribute Editor, 171

Info tab properties, 256

Log View tab button, 252

memory hardware total, 272

monitoring log messages, 268 to 269

moving columns in Process display, 261

Process Statistics window, 262

Processes tab button, 252, 257

processors total, 272

Refresh tab in the Attribute Editor, 178

Solaris Process Details module, 257

sorting columns in Process display, 261

starting, 130, 253 to 255

tab buttons, 130

tape devices total, 272

Directory Name Lookup Cache, 374

Directory Size Monitoring module, 217

list files, 152 to 155

disabling

a module, 137, 224

row, 138

discovery

checking part numbers, 105

deleting request, 112

filters, 106

methods of, 103, 104

modifying request, 111 to 112

request ID, 103

scheduling requests, 106

server context, 103

starting, 98 to 100

starting request, 112

status, 99 to 100

stopping request, 112

timeout, 104 to 105

Discovery Requests window, 99 to 100

disk

busy, 371, 373

complex rules, 371

load, 374

meta, 373

disks, total in Details window, 272

displaying data, 144

domain

creating, 58

default, 53

definition, 7

deleting, 57, 60 to 62

hierarchy examples, 52

home, 53 to 55, 57

initiating a discovery request, 101 to 104

listing, 125 to 126

members, 7

multiple, 51

populating, 58 to 59, 97 to 112

referencing, 57

remote, 62 to 66

security, 12, 57

set home domain, 57

Sun Enterprise SyMON Administrative Domains

pull-down menu, 59

switching between, 125 to 126

Domain Manager buttons, 57

domain-config .x file, 307
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Dynamic Reconfiguration

special instructions for Details window, 271

Dynamic Reconfiguration module, 16

E
Edit menu, 122

editing

graph axes, 165

module, 137, 220 to 223

row, 138

EGroup process property, 260

enabling

module, 137, 224

row, 138

Entity Desc property, 256

Entity Event Destination property, 256

Entity Family property, 256

Entity Full Desc property, 256

Entity Trap Destination property, 256

esadm, 38, 41, 283, 284, 285, 293

esdomadm, 38, 41, 283, 284, 293

es-lic  script, 40

esmaster , 40, 45, 282, 283, 301 to 302

esops , 38, 41, 283, 284, 293

espublic , 40, 45, 282, 283, 287, 288, 292, 301 to 302

es-start  utility, 42, 44

es-stop  utility, 47, 49

EUser process property, 260

Event manager, 5, 287, 315 to 318

agent statistic, 310

port number, 307

events

deleting from event database, 316 to 318

meta disk, 373

meta swap, 373

exiting Details window, 132

F
File menu items, 122

File Monitoring module, 146

adding row to table, 146 to 149

File Scanning module, 146, 150

file system full, 373

filtering

discovery requests, 106

log messages, 265 to 268

finding specific log messages, 270

G
general group, 78

Go menu items, 124

graph

applying template, 161

copying data property to, 138

data property, 156

editing axes, 165

historical data, 180

menu items, 162 to 168

multiple data properties, 156 to 158

opening, 160

sampling points, 182

saving, 159

Group ID process property, 260

groups, 52

copying, 88 to 89

creating, 78 to 80

general and IP-based, 78

moving, 88 to 89

pasting, 88 to 89

security, 12

users, 38

H
hand icon, 274

hardware

pathnames displayed, 274

resources displayed, 272

supported platforms, 16, 17

Config-Reader module, 16

views of, 273

hardware monitored by Sun Enterprise SyMON

software, 2

Health Monitor rules, 371

help, 126

pop-up balloon, 135
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helpful hints

displaying levels of details, 254, 255

Search function is case-sensitive, 279

searching in multiple instances, 279

using tool tips, 119, 135

viewing long messages in table cells, 254

Hide Details button, 277

hierarchy view, 10, 114

mouse actions, 117

history interval

schedule, 185

setting, 182, 187 to 194, 195 to 201

History tab, 180

home domain, 53 to 55, 57

host

Details window, 129

security, 12, 140

host down alarm notification, 235

Hostname property, 256

I
increasing virtual size, 313 to 315

Info tab

Entity Desc property, 256

Entity Event Destination property, 256

Entity Family property, 256

Entity Full Desc property, 256

Entity Trap Destination property, 256

Hostname property, 256

IP Address property, 256

Netmask property, 256

Operating System property, 256

properties, 256

Target Hostname property, 256

Target IP Address property, 256

Info tab button in the Details window, 252

Info tab in the Attribute Editor, 171

Installation

minimum disk space required, 16

prerequisites, 21

installation

default domain, 53

package location, 29

IP Address property, 256

IP addresses within server contexts, 287

IP-based group, 78

J
Java security classes, 281

K
kernel memory allocation, 374

Kernel Reader

creating alarm, 174 to 175

displaying data, 144

rules, 371

keys, 301 to 302

regenerating, 303

L
legacy agent, 304 to 306

license, exceeding of, 39

licensing of Sun Enterprise SyMON software, 39 to

40

load, 374

loading modules, 137, 212 to 219

local applications, modules relating to, 354

locations of log files, 265

log files, viewing, 265

log messages

filtering, 265 to 268

finding specific messages, 270

log view, 11, 130

Log View tab button in the Details window, 252

M
main console window, 10

Management Information Base, See modules, MIB

masking of network addresses, 376

memory hardware, total in Details window, 272

Memory% process property, 261

Menu items, 121

Edit, 122

File, 122
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Go, 124

graph, 162 to 168

Tools, 124

View, 123

menu, View Columns, 259

messages, viewing, 11

modifying objects, 89 to 91

module object, creating, 226

modules

Agent Statistics, 210, 355

Attribute Editor, 226 to 230

Config Reader, 210

copying, 137

creating a monitored module, 75 to 77

Data Logging Registry, 210, 358

definition, 8, 133

Details window, 129

Directory Size Monitoring, 210, 217

disabling, 137, 224

dynamic, 8

Dynamic Reconfiguration, 210

editing, 137, 220 to 223

enabling, 137, 224

File Monitoring, 211

File Scanning, 150, 211, 366

Health Monitor, 211, 359

HP JetDirect, 211, 369

in alphabetical listing, 324, 354

Kernel Reader, 211, 335

loaded by default, 210

loading, 137, 212 to 219

local applications, 354

MIB, 8

MIB-II Instrumentation, 211, 326

MIB-II Proxy Monitoring, 211, 368

monitoring, 226

NFS File Systems, 211, 351

NFS Statistics, 211, 348

number of instances loaded, 216

operating system, 324

Print Spooler, 211, 364

Process Monitoring, 151, 211, 218, 365

remote systems, 368

schedule, 185, 226 to 230

security, 12, 140, 226 to 230

security permissions, 229

setting schedule, 202 to 207

Solaris Process Details, 211, 349

that load automatically, 324, 354

that load multiple times, 324, 354

unloading, 137, 225

using ’Add Row’, 324, 354

monitored hardware, 2

monitored software properties, 2, 8

monitoring

data property, 185

log messages, 268 to 269

objects, methods of, 72 to 73

server components, 311

moving columns in Details Process display, 261

moving groups, 88 to 89

N
navigating

domains, 125 to 126

main console window, 125

Netmask, 105

ANDing, 376

property, 256

NFS remote procedure, 374

Nice process property, 260

node, creating, 70 to 74, 81 to 83

notifying you when a host or agent is down, 235

notifying you when an alarm occurs, 177

O
objects

alarms, 127

copying, 87

creating automatically with Discovery

manager, 101 to 104

cutting and pasting, 92 to 93

delete, 94 to 95

Details window, 129

linking two objects, 86

modifying, 89 to 91

pasting, 87

octets in network addressing, 375

opening

Attribute Editor, 170

graphs, 160
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operating system

modules relating to, 324

property, 256

P
pasting

groups, 88 to 89

objects, 87 to 89, 92 to 93

permissions, security, 281

pfiles process statistic, 262

PGroup process property, 260

physical view, 11, 273

refresh details, 277

pictures of system hardware, 273

PID process property, 260

ping  command, 103, 104

pldd process statistic, 262

pmap process statistic, 262

populating domains, 58 to 59, 97 to 112

pop-up balloon help, 135

port (SNMP) conflicts, 22 to 23

port addresses

changing, 306 to 309

within server contexts, 287

port numbers

discovery process, 105

starting console, 42

PPID process property, 260

printer monitoring, 211

Priority process property, 260

probe a monitored data property, 153

Process display, configuring, 259 to 262

Process Monitoring module, 146, 151, 218

process property

Address, 260

Class, 260

Command, 261

CommandLine, 261

CPU%, 261

EGroup, 260

EUser, 260

Group ID, 260

Memory%, 261

Nice, 260

PGroup, 260

PID, 260

PPID, 260

Priority, 260

Session ID, 260

Size, 260

Start time, 260

State, 260

Time, 260

UID, 260

User, 260

Wait Channel, 260

Process Statistics window, 262

processes, 130

Processes tab button in the Details window, 252

processes view, 11

processors, total in Details window, 272

property, See data property

pstack process statistic, 262

Q
queue length, complex rules, 371

R
rCompare  rule, 9

referencing domains, 57

refresh data, 151

refresh interval

schedule, 185

setting, 179, 187 to 194, 195 to 201

Refresh tab, 178

regenerating security keys, 303

relationships, inclusive, 285

remote domains, 62 to 66

remote server access, 287

remote server context, 5

remote systems, modules relating to, 368

removing Sun Enterprise SyMON software, 24

rhltm000, 374

rhltm001, 374

rhltm002, 374

rhltm003, 374
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rhltm004, 374

rhltm005, 374

rhltm006, 374

rhltm007, 374

rknrd100, 373

rknrd102, 373

rknrd103, 373

rknrd105, 373

rknrd106, 373

rknrd401, 373

rknrd402, 373

rknrd403, 373

rknrd404, 373

rknrd405, 373

RMI port address, 308

router forwarding rule, 376

routing tables, 103, 104

row

adding, 146 to 149

deleting, 138

disabling, 138

editing, 138

enabling, 138

rule, 5, 9

complex, 371

CPU power, 374

Directory Name Lookup Cache, 374

disk busy, 373

disk loaded, 374

Health Monitor, 371, 374

kernel memory allocation, 374

Kernel Reader, 371, 372 to 373

meta disk, 373

meta swap, 373

no swap space error, 373

run queue length, 374

simple, 371

Solstice SyMON 1.x software, 371

Sun Enterprise SyMON 2.0.1 software, 371

swap space, 373, 374

time for an unreferenced page, 374

user-customized, 371

run queue length, 374

running UNIX commands on data, 152 to 155

S
same server context, 5

sampling points for data property, 182

saving graph, 159

schedule, 185, 187 to 194, 195 to 201, 202 to 207, 226

to 230

scheduling discovery requests, 106

search pattern, 269

Search window in Details Logical view, 278

searching for specific log messages, 270

security, 12

access control (ACL) categories, 41, 282, 283

accessing on a module, 290

adding user-defined group, 293

adding users, 41, 289

deleting users, 294

granting administrator privileges, 41, 293

specifying ACL, 286

using key functions, 289

console-to-server messages, 46

default privileges

default privileges, 295

domains, 57

esmaster
private, 282

espublic
public, 282

for a module, 226 to 230

functions

admin, 285

general, 285

operator, 285

host, 140

layers in Sun Enterprise SyMON software, 281

module, 140

permissions, 281

remote, 62

Sun Enterprise SyMON users, 40, 282

tab, 290

security keys, 301 to 302

regenerating, 303

seed for security key, 38, 302

segment creation, 84 to 86

selecting columns in Details Process display, 259 to

261

server

access, 287
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context, 287

context limitations, 288

information required, 21

interacting with console and agent, 3 to 5

interaction with agents, 5

port number, 46, 307

remote access, 287

server component as monitored object, 311

server context, 62

discovery process, 103

limitations, 288

server interacts with multiple consoles, 5

server-config .x file, 307

Session ID process property, 260

setting

alarm schedule, 202 to 207

history interval, 187 to 194

refresh interval, 179, 195 to 201

schedules, 185

Show Details button, 277

simple alarms thresholds, 9

simple rules

alarm generation, 371

monitored properties, 371

Size process property, 260

Smart delete, 316 to 318

SNMP, 10

SNMP port

conflicts, 22 to 23

definitions, 307

SNMP subagents, 17, 304 to 306

software properties monitored by Sun Enterprise

SyMON software, 2, 8

Solaris Process Details module, 257

sorting columns in Details Process display, 261

Start time process property, 260

starting

Details window, 130, 253 to 255

discovery, 98 to 100, 112

the Sun Enterprise SyMON software with

arguments, 42

State process property, 260

statistics

Detail Process Statistics window, 262

pfiles, 262

pldd, 262

pmap, 262

pstack, 262

stopping discovery request, 112

subagent, 304 to 306

subnets, 376

Sun Enterprise SyMON

add-on packages, 20

component layers, 2

core packages, 19

Java security classes, 281

licensing, 39 to 40

monitoring, 72 to 73

remote access, 287

rules, 371

security layers, 281

server

context limitations, 288

server access, 287

server agent statistic, 310

server context, 287

user functions, 285

user security, 40, 282

Sun Enterprise SyMON Administrative

Domains, 59

Sun StorEdge A5000, 5100, 5200 physical view, 275

swap space, 373, 374

error, 373

in use, 373

switching between domains, 125 to 126

syslog , 373

T
tape devices, total in Details window, 272

Target Hostname property, 256

Target IP Address property, 256

text pattern includes UNIX regular

expressions, 269

Time Editor, 185, 186

combining expressions, 186 to 207

Time process property, 260

timeout, discovery process, 104 to 105

tool tip, 119, 135

Tools menu item, 124

Topology manager, 5, 287
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agent statistic, 310

exiting, 313 to 315

function, 313

port number, 307

system resource requirement, 313

Virtual Size limit, 313

topology view, 10, 114

mouse actions, 118

Trap handler, 5, 287

agent statistic, 310

port number, 307

U
UID process property, 260

uninstalling Sun Enterprise SyMON software, 24

UNIX regular expressions in text patterns, 269

unloading a module, 137, 225

User process property, 260

users, 40, 282

default functions, 285

esmaster , 282

espublic
public, 282

V
var/adm/message , 373

view

hierarchy, 10

topology, 10

View Columns pull-down menu, 259

View menu items, 123

view of domain, 114

viewing

error messages, 11

log files, 265

virtual size, increasing, 313 to 315

W
Wait Channel process property, 260
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	1. Change directory to the /opt/SUNWsymon/sbin directory.
	2. If applicable, start the Sun Enterprise SyMON server by typing:
	3. If applicable, start the Sun Enterprise SyMON agent by typing:
	4. Type es-start -c at the prompt to start the console.
	FIGURE�3�1 Sun Enterprise SyMON Login Panel
	TABLE�3�4 Sun Enterprise SyMON Login Panel Buttons

	5. Log in using a valid UNIX user account. This account must be listed in the /var/opt/SUNWsymon/...
	6. Type the host name of the Sun Enterprise SyMON server in the Server Host field.
	7. If you are not using the Sun Enterprise SyMON server default port addresses or want to set the...
	a. Click the Options button.
	b. Type the Sun Enterprise SyMON server RMI host port number in the Server Port Number field.
	c. Click the circle next to the appropriate security message option (FIGURE�3�2).
	FIGURE�3�2 Sun Enterprise SyMON Login Options Dialog

	d. Click the OK button.

	8. Check that you typed in all the information correctly in the Sun Enterprise SyMON Login window...
	9. Click the Login button in the Sun Enterprise SyMON Login window to log into the Sun Enterprise...
	FIGURE�3�3 Sun Enterprise SyMON Main Console Window



	Exiting and Stopping the Sun Enterprise SyMON Software
	TABLE�3�5 Options for es-stop Choices�
	To Exit the Sun Enterprise SyMON Console
	1. Select File ‰ Exit from the menu bar on the main console window.
	2. Click the Exit button to exit the application or the Cancel button to cancel your request.
	FIGURE�3�4 Exit Sun Enterprise SyMON Dialog


	To Stop the Sun Enterprise SyMON Server and Agents
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	Using Sun Enterprise SyMON Administrative Domains
	FIGURE�4�1 Example Domain



	Starting Sun Enterprise SyMON Software
	FIGURE�4�2 Set Home Domain Dialog
	To Set a Home Domain
	1. Proceed with one of the following:
	FIGURE�4�3 Sun Enterprise SyMON File Menu
	FIGURE�4�4 Set Home Domain Dialog

	2. Select the domain you want to set as your home domain.
	3. Click the Set Home button.
	4. Click the Close button.
	FIGURE�4�5 Home Domain



	Creating Domains
	To Select Domain Manager
	FIGURE�4�6 Domain Manager
	TABLE�4�1 Domain Manager Buttons

	To Create Domains
	1. Select File ‰ Domain Manager (FIGURE�4�3) from the main console window.
	2. In the Domain Manager, click the left mouse button on Add.
	FIGURE�4�7 Create Domain Dialog

	3. Type in the name of the new domain in the Domain Name field.
	4. If you do not want your domain populated now, be sure the Populate Now check box is turned off.
	5. Click the Create button.
	6. Create additional domains or populate your domain manually.

	Populating Domains

	Managing Domains
	Selecting Domains
	To Select a Domain
	1. Proceed with one of the following:
	FIGURE�4�8 Sun Enterprise SyMON Main Console Window with a List of Current Domains

	2. Click the left mouse button on the domain you want to view.

	Deleting Domains
	To Delete a Domain
	1. In the Domain Manager window, highlight the name of the domain you want to delete.
	2. Click the Delete button.
	FIGURE�4�9 Confirm Domain Deletion Dialog
	FIGURE�4�10 Confirm Domain Deletion Dialog for Current Domain

	3. Click Delete.
	4. Click the Close button in the Domain Manager.


	Monitoring Remote Domains
	FIGURE�4�11 Remote Domain
	FIGURE�4�12 Remote Domain - Circular Domain Reference
	FIGURE�4�13 Remote Domains - Setting Up for Successful Cross-Monitoring
	To Set a Remote Domain
	1. In the main console window, select File ‰ Remote Domain Manager (FIGURE�4�3).
	FIGURE�4�14 Remote Domain Manager

	2. Type the name of the remote server in the Host field. If applicable, also type the appropriate...
	3. Click the List Domains button.
	4. Click the domain you want to reference.
	5. Click the Reference button.
	FIGURE�4�15 Referencing a Remote Domain


	Attribute Editor for a Domain
	To Set Security for a Domain
	1. Proceed with one of the following:
	2. If not already selected, click the Security tab (FIGURE�4�16).
	3. Type the name(s) of user and administrator groups in the appropriate fields.
	4. Complete this procedure with one of the following actions:
	FIGURE�4�16 Attribute Editor for a Domain
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	Creating a Node
	To Create a Node
	1. In the hierarchy view of the main console window, select the domain in which you want to creat...
	2. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).
	FIGURE�5�1 Create Topology Object Window—Node Tab

	3. In the upper half of the Create Topology Object menu, set up the new node:
	a. Click the Monitor Via button to see the pull-down menu, then select the software or agent to m...
	TABLE�5�1 Types of Sun Enterprise SyMON Monitoring�

	b. If applicable, select a type from the pull-down menu in the Type field.
	TABLE�5�2 Choices Available in the Type Pull-Down Menu

	c. If applicable, scroll and select an object in the Create Topology Object window.
	d. (Optional) Create a unique new name in the Node Label field.
	e. (Optional) Type a description of the node.

	4. In the lower half of the Create Topology Object window, type the requested information.
	5. Complete this procedure with one of the following actions:

	Creating a Monitored Module Object
	To Create a Module Object
	1. In the hierarchy view of the main console window, select the domain in which you want to creat...
	2. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).
	3. Select the Node tab in the Create Topology Object window.
	4. Select SyMON Agent – Module in the Monitor Via field (FIGURE�5�2).
	FIGURE�5�2 Create Topology Object Window for SyMON Agent – Module

	5. (Optional) Type a node label.
	6. (Optional) Type a description.
	7. Type a host name or IP address.
	8. If necessary, change the port number.
	9. Click the List Modules button to display a list of modules that are currently loaded on the host.
	FIGURE�5�3 Module List

	10. Select the module that you want to monitor and click OK.
	11. Complete this procedure with one of the following actions:


	Creating Groups
	To Create a Group
	1. In the hierarchy view of the main console window, click the domain in which you want the new g...
	2. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).
	FIGURE�5�4 Creating an Object
	FIGURE�5�5 Creating a Group in the Create Topology Object Window

	3. In the Create Topology Object window:
	a. Click the Group tab (FIGURE�5�5).
	b. Change the Type field, if desired (General or IP-Based).
	c. Select the object type (Building, Campus, or General).
	d. Create a new group Label.
	e. (Optional) Type a description in the optional Description field.
	f. For an IP-based group, specify the IP address and the subnet mask.

	4. Complete this procedure with one of the following actions:
	5. Add components to your group:


	Creating a Composite Object
	To Create a Composite Object
	1. In the hierarchy view of the main console window, select the Sun Enterprise SyMON domain in wh...
	2. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).
	3. Click the Composite tab in the Create Topology Object window.
	FIGURE�5�6 Create Topology Object Window—Composite Tab

	4. Select an object in the Create Topology Object window.
	5. Create a unique new name in the Label field.
	6. (Optional) Type a description of the node.
	7. In the lower half of the Create Topology Object window, type the requested information.
	8. Complete this procedure with one of the following actions:


	Creating Segments
	To Create a Segment
	1. In the main console window:
	a. In the left window, select a location in the domain where the new segment should be created.
	b. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).

	2. In the Create Topology Object window:
	a. Click the Segment tab (FIGURE�5�7).
	FIGURE�5�7 Segment Tab in the Create Topology Object Window

	b. Change the Type field, if desired (Bus or Ring).
	c. Select the object type.
	d. Type a new segment label.
	e. (Optional) Type a description in the Description field.
	f. Type the IP address for this segment.
	g. Type a subnet mask for this segment.

	3. Complete this procedure with one of the following actions:

	Connecting Objects
	To Connect Objects
	1. Select two objects in the topology view.
	2. Select Edit ‰ Create a Connection.


	Copying Objects
	To Copy an Object
	1. In the main console window, select the existing object in the topology view.
	2. At the top of the main console window, select Edit ‰ Copy in the pull�down menu.
	3. Open the destination group or domain.
	4. At the top of the main console window, select Edit ‰ Paste.

	To Copy a Group of Objects
	1. In the topology view, select the objects to be copied.
	a. Click the first object to select it.
	b. On the keyboard hold down the Shift key and click one or more additional objects.

	2. Select Edit ‰ Copy in the main console window menu bar.
	3. In the hierarchy view, select (highlight) the new group or domain where the group is to be cop...
	4. Select Edit ‰ Paste Into in the main console window menu bar.


	Modifying Objects
	To Modify an Object
	1. Select the object in the main console window.
	2. Select Edit ‰ Modify in the main console window.
	FIGURE�5�8 Modify Object Window—Example for a Node

	3. Edit the characteristics as needed.
	4. Click OK to save your changes, or Cancel to leave the characteristics unchanged.


	Cutting and Pasting Objects
	To Cut and Paste Objects
	1. Select an existing object in the topology view.
	2. Select Edit ‰ Cut (FIGURE�5�9) in the main console window.
	FIGURE�5�9 Cut, Copy, and Paste Options

	3. Navigate to the destination location in the topology view.
	4. Select Edit ‰ Paste. The object is displayed in this location and is removed from the previous...


	Deleting Objects
	To Delete Objects
	1. Select an existing object in the topology view.
	2. Select Edit ‰ Delete Object/Connection from the top of the main console window (FIGURE�5�10).
	FIGURE�5�10 Delete Option
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	Starting the Discovery Requests Window
	To Start the Discovery Requests Window
	FIGURE�6�1 Tools Pull-down Menu
	FIGURE�6�2 Discovery Requests Window
	TABLE�6�1 Discovery Requests Window Fields
	1. New. A new request was added but has never been processed.
	2. Queued. A request has been sent to the server but processing has not yet started.
	3. Running. The request is currently being processed.
	4. Succeeded. The request has been successfully processed.
	5. Failed. Processing of the request has failed.
	6. Stopped. The user has stopped the process.
	7. 0 Host found. The request did not find any hosts that passed the filter limits.

	TABLE�6�2 Discovery Requests Window Buttons


	Initiating a Discovery Request
	To Initiate a Discovery Request
	1. Click the Add button in the Discovery Requests window.
	FIGURE�6�3 New Discover Request Window

	2. (Optional) Type a new name for your discovery request in the Request Name field.
	3. In the Discover Using field, select the method that should be used for discovering the network...
	4. Click the OK button to start the discovery process, or go to the other tabs in this window to ...
	5. If a Sun Enterprise SyMON server or agent is incorrectly reported to be a ping host, create a ...


	Customizing Your Discovery Request
	TABLE�6�3 Summary of Discovery Variables�
	To Customize a Discovery Request
	1. Click the Preferences tab.
	FIGURE�6�4 New Discover Request Preferences Window

	2. Type your selections in the Logging, PING, SNMP, and General fields.
	3. Click the Filters tab.
	FIGURE�6�5 New Discover Request Filters Window

	4. Click one or more boxes for host names, operating system, or platform type.
	5. Click the Scheduling tab.
	FIGURE�6�6 New Discover Request Scheduling Window

	6. If you want to schedule automatic discoveries, click the button for “Periodically discover new...
	7. When you have finished your edits, click OK to save the new discovery request, or click Cancel...
	8. Click Close to exit the window.


	Modifying a Discovery Request
	To Modify a Discovery Request
	1. Select Tools ‰ Discover in the main console window (FIGURE�6�1).
	2. Find and select the name of the discovery request you want to modify.
	3. Click the Modify button.
	4. Select the Discover, Preferences, Filters, and Scheduling tabs and in turn, change settings as...
	5. Complete this procedure with one of the following actions:
	6. Exit from the window:


	Starting, Stopping, or Deleting a Discovery Request
	To Start, Stop, or Delete a Discovery Request
	1. Select Tools ‰ Discover in the main console window (FIGURE�6�1).
	2. Select the name of the discovery request you want to modify.
	3. Click the Start, Stop, or Delete button to start, stop, or delete a request, respectively.
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	Main Console Window
	FIGURE�7�1 Main Console Window

	Domain View
	FIGURE�7�2 Main Console Window With Hierarchy and Topology Views
	Hierarchy View
	TABLE�7�1 Mouse Actions in the Hierarchy View
	To Obtain Specific Information About the Hierarchy View
	Method 1
	Method 2

	To Obtain General Information About the Hierarchy View
	Method 1
	Method 2


	Topology View
	TABLE�7�2 Mouse Actions in the Topology View

	Tool Tip Balloon
	To See a Tool Tip Balloon
	FIGURE�7�3 Tool Tip Balloon


	Pop-up Menu
	To Access a Pop-Up Menu
	1. Click the right mouse button on the object.
	2. Click the left button to select a menu item (TABLE�7�3).
	TABLE�7�3 Common Pop-Up Menu Items




	Menu Bar
	FIGURE�7�4 Menu Bar
	To Use the Main Console Window Menu Bar
	1. Click an entry in the menu bar to display a pull-down menu.
	2. Click an entry in the pull-down menu to initiate that action.

	File Menu Options
	TABLE�7�4 Options for the File Menu

	Edit Menu Options
	TABLE�7�5 Options for the Edit Menu�

	View Menu Options
	TABLE�7�6 Options for View

	Go Menu Options
	TABLE�7�7 Go Menu Items

	Tools Menu Options
	TABLE�7�8 Tools Menu Items


	Navigation Buttons
	FIGURE�7�5 Navigation Buttons
	TABLE�7�9 Navigation Buttons

	SyMON Administrative Domains Pull�Down Menu
	FIGURE�7�6 Administrative Domains Pull-Down Menu
	To View the Current List of Domains
	1. In the main console window, click the SyMON Administrative Domains button.
	2. Click the domain that you want to view.


	Help Button
	FIGURE�7�7 Help Button

	Domain Status Summary
	FIGURE�7�8 Domain Status Summary
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	Browser

	Details View
	Using the Details Window
	TABLE�8�1 Details Window—Common Tab Buttons
	To Start the Details Window
	FIGURE�8�1 Opening the Details Window from the Pop�Up Menu
	FIGURE�8�2 Opening the Details Window from the Tools Menu

	To Exit the Details Window

	Browser Tab
	FIGURE�8�3 Browser Details Window
	FIGURE�8�4 Light�Colored Circles “Unroll” to Provide Additional Levels of Detail
	Hardware
	Operating System
	Local Applications
	Remote Systems
	Browser Buttons
	TABLE�8�2 Browser Buttons�
	FIGURE�8�5 Module Menu Options in Details Window
	FIGURE�8�6 Options Menu Options in Details Window


	Host Security
	FIGURE�8�7 Attribute Editor for a Host or Module
	To Set Security for a Host or Module
	1. Open the Attribute Editor for a host or module by proceeding with one of the following:
	2. Click the Security tab (FIGURE�8�7).
	3. Type the name(s) of user and administrator groups in the appropriate fields.
	4. Complete this procedure with one of the following actions:
	9
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	Monitoring Data Properties
	To Display a Data Property
	1. In the Browser Details window, double�click on the Operating System icon in the hierarchy (tre...
	2. Double�click on the Kernel Reader icon in the contents view or single click in the light�color...
	3. Double�click on the System Load Statistics icon in either the hierarchy or the contents view (...
	FIGURE�9�1 System Load Statistics


	Working with Rows
	TABLE�9�1 Sun Enterprise SyMON Modules That Require You to Add Rows

	To Add a Row
	1. In the Browser Details window, double�click on the Operating System icon in the hierarchy (tre...
	2. Double�click on the File Monitoring icon in the contents view or single click in the light�col...
	3. Double�click on the File Monitoring Status folder in either the hierarchy or the contents view.
	FIGURE�9�2 File Monitoring Table

	4. Proceed with one of the following:
	5. Type the appropriate information in the text fields.
	FIGURE�9�3 Row Adder Window for the File Monitoring Module

	6. Complete this procedure with one of the following actions:
	FIGURE�9�4 Updated File Monitoring Table
	FIGURE�9�5 Row Adder Window for the File Scanning Module
	FIGURE�9�6 Row Adder Window for Process Monitoring Module


	To Refresh Displayed Data
	FIGURE�9�7 Monitored Data Property Pop�up Menu

	Probing Properties
	To Probe a Property
	1. In the Browser Details window, double�click on the Operating System icon in the hierarchy (tre...
	2. Double�click on the Directory Size Monitoring icon in the contents view or single click in the...
	3. Double�click on the Directory Monitoring Status folder icon in either the hierarchy or the con...
	4. Proceed with one of the following:
	FIGURE�9�8 Probe Commands in the Pop�up Menu
	FIGURE�9�9 Probe Select Dialog


	Graphing Properties
	To Graph A Monitored Data Property
	FIGURE�9�10 Graph of System Load Statistics Average Over the Last Five Minutes

	To Graph Two Data Properties
	1. Click the right mouse button in the data property table cell.
	2. Proceed with one of the following:
	3. Go to the graphing window in which you want the additional property to be plotted. Select Grap...
	FIGURE�9�11 Copying Load Averages Over the Last One Minute to the Graph
	FIGURE�9�12 Adding Load Averages Over the Last One Minute to the Graph
	FIGURE�9�13 Load Averages Over the Last One and Five Minutes


	To Save Graphing Parameters
	1. Select Graph ‰ Save Graph Request As or Select Graph ‰ Save Template in the Graphing window.
	2. Type the name in the Enter Graph Name or Enter Template Name fields.
	3. Click the Save button to save your graph request (template) or click the Cancel button to canc...
	FIGURE�9�14 Save Graph Request Dialog
	FIGURE�9�15 Save Template Dialog


	To Open a Graph
	1. Select Graph ‰ Open Saved Graph in the Graphing window.
	FIGURE�9�16 Open Graph Dialog

	2. Select (highlight) a saved graph from the list.
	3. Click the OK button to open the graph or the Cancel button to cancel your request.

	To Apply a Graph Template
	1. Select Graph ‰ Apply Template in the Graphing window.
	FIGURE�9�17 Apply Template Dialog

	2. Select (highlight) a saved template from the list.
	3. Click the OK button to apply the template to the current graph or the Cancel button to cancel ...

	Graphing Menus
	Graph Menu Items
	TABLE�9�2 Graph Menu Items
	FIGURE�9�18 Graph Menu Items

	Edit Menu Items
	TABLE�9�3 Edit Menu Items
	FIGURE�9�19 Edit Menu Items
	FIGURE�9�20 X-Axis Editing Dialog
	FIGURE�9�21 Y-Axis Editing Dialog

	View Menu Items
	TABLE�9�4 View Menu Items�
	FIGURE�9�22 View Menu Items

	Tools Menu Items
	TABLE�9�5 Tools Menu Items
	FIGURE�9�23 Tools Menu Items
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	Attribute Editor for a Data Property
	To Open the Attribute Editor
	1. Click the right mouse button and select a data property table cell (FIGURE�10�1).
	2. Proceed with one of the following:
	FIGURE�10�1 Selected Data Property


	Information Tab in the Attribute Editor
	FIGURE�10�2 Attribute Editor Info Tab for a Monitored Property

	Alarms Tab in the Attribute Editor
	FIGURE�10�3 Attribute Editor Alarms Tab for a Monitored Property
	TABLE�10�1 Common Simple Alarm Limits in Sun Enterprise SyMON Software

	To Create an Alarm
	1. Click the Browser tab button in the Details window.
	2. Click the light�colored circle next to the Operating System icon in the hierarchy tree view.
	3. Click the light�colored circle next to the Kernel Reader icon.
	4. Double�click on the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 1 ...
	6. Click the Attributes button.
	7. Click on the Alarms tab button.
	8. Type a value in the Critical Threshold (>) field which is less than the current value.
	9. Complete one of the following actions:
	10. Click the Alarms tab button in the Details window.
	11. Acknowledge this alarm.
	12. Create additional alarm thresholds and familiarize yourself with their operation.

	Actions Tab in the Attribute Editor
	FIGURE�10�4 Attribute Editor Actions Tab for a Monitored Property

	To Send an Email
	1. Click the Browser tab button in the Details window.
	2. Click the light�colored circle next to the Operating System icon in the hierarchy tree view.
	3. Click the light�colored circle next to the Kernel Reader icon.
	4. Double�click on the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click the Actions tab button.
	8. Type email username in the Critical Action field.
	9. Complete this procedure with one of the following actions:

	Refresh Tab in the Attribute Editor
	FIGURE�10�5 Attribute Editor Refresh Tab for a Monitored Property

	To Set a Refresh Interval
	1. Click the Browser tab button in the Details window.
	2. Click the light�colored circle next to the Operating System icon in the hierarchy tree view.
	3. Click the light�colored circle next to the Kernel Reader icon.
	4. Double�click on the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click the Refresh tab button.
	8. Type a value (in seconds) in the Refresh Interval field or click the Advanced button.
	9. Complete this procedure with one of the following actions:

	History Tab in the Attribute Editor
	FIGURE�10�6 Attribute Editor History Tab for a Monitored Property

	To Set a History Interval
	1. Click the Browser tab button in the Details window.
	2. Click the light�colored circle next to the Operating System icon in the hierarchy tree view.
	3. Click the light�colored circle next to the Kernel Reader icon.
	4. Double�click the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click the History tab button.
	8. Type a value (in seconds) in the Sample Interval field or click on the Advanced button.
	9. Click in the check box next to Save History as Disk File or Save History in Memory Cache.
	10. If you decided to save history as a disk file, determine the file type (circular or text) and...
	11. If you decided to save history in memory cache, type the number of history data points in the...
	12. Complete this procedure with one of the following actions:
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	Using the Time Editor
	FIGURE�11�1 Time Editor
	Combining Time Expressions
	To Create a Time Expression Using the Cyclic and Comparison Tabs
	1. Click on the Advanced button in the History tab of the Attribute Editor for a data property.
	2. If any value is in the Time Expression field, highlight the value and delete it by clicking th...
	3. Click the Insert button.
	4. Determine the frequency for the history interval (FIGURE�11�2).
	a. Highlight the number field and click the up or down arrows until the number 1 is displayed.
	b. Highlight the units field and click the up or down arrows until hours is displayed.
	FIGURE�11�2 Setting a Cyclic Time of One Hour


	5. Click the Apply button.
	FIGURE�11�3 Time Editor With Cyclic Time of One Hour

	6. Click the Insert button.
	7. Click the Comparison tab.
	8. Determine the start of the Time Range (Monday).
	a. Select Day of week from the left pull�down menu.
	b. Select >= from the middle pull�down menu.
	c. Select Monday from the right pull�down menu.
	FIGURE�11�4 Setting the Start Range to Monday


	9. Click the Apply button.
	FIGURE�11�5 Time Editor Is Updated With a Start Range of Monday

	10. Determine the end of the Time Range by clicking the Insert button.
	11. Click on the Comparison tab of the Time window.
	12. Determine the end of the Time Range (Friday).
	a. Select Day of week from the left pull�down menu.
	b. Select <= from the middle pull�down menu.
	c. Select Friday from the right pull�down menu.
	FIGURE�11�6 Setting the End Range to Friday


	13. Click the Apply button.
	FIGURE�11�7 Time Editor Showing a Cycle Time of One Hour From Monday to Friday

	14. Click the Apply button.
	FIGURE�11�8 Updated History Attribute Editor Showing a Cycle Time of One Hour From Monday to Friday


	To Create a Time Expression Using the Absolute and Cron Tabs
	1. Click on the Advanced button in the History tab of the Attribute Editor for a data property.
	2. If any value is in the Time Expression field, highlight the value and delete it by clicking th...
	3. Click the Insert button.
	4. Click the Absolute tab.
	5. Determine the starting time and date (FIGURE�11�9).
	a. Highlight the hour, minute, and if desired, the seconds fields and click the up or down arrow ...
	b. Highlight the month, date, and year fields and click the up or down arrow until the correct da...
	FIGURE�11�9 Starting Time of 12:00:00 PM on August 20, 1999


	6. Click the Apply button.
	FIGURE�11�10 Time Editor With Starting Time of 12:00:00 PM August 20, 1999

	7. Click the Insert button.
	8. Click the Cron tab.
	9. Select the time when the history interval is active.
	a. Select 0 from the Minute pull�down menu.
	b. Select 3rd from the hour pull�down menu.
	c. Select Every from the Day of month pull�down menu.
	d. Select Every from the Month pull�down menu.
	e. Select Monday from the final pull�down menu.
	FIGURE�11�11 Cron Tab Selected With 3:00 AM Every Monday


	10. Click the Apply button.
	FIGURE�11�12 Time Editor Selected With Starting Date/Time 12:00:00 PM, August 20, 1999, and Histo...

	11. Place the cursor in the Cron field on the Time Editor screen. Backspace using the left arrow ...
	FIGURE�11�13 Time Editor With Starting Date/Time of 12:00:00 PM, August 20, 1999 and History Inte...

	12. Click the Apply button.
	FIGURE�11�14 History Interval With Starting Time of 12:00 PM August 20, 1999 and 3:00 AM Every Mo...


	To Create an Alarm Schedule Using the Comparison Tab
	1. Click on the Advanced button in the Alarms tab of the Attribute Editor for a data property.
	2. If any value is in the Time Expression field, highlight the value and delete it by clicking th...
	3. Click the Insert button.
	4. Determine the start of the Time Range (9:00 AM).
	a. Select Hour from the left pull�down menu.
	b. Select >= from the middle pull�down menu.
	c. Select 9 from the right pull�down menu.
	FIGURE�11�15 Comparison Tab With Greater Than or Equal to 9:00 AM


	5. Click the Apply button.
	FIGURE�11�16 Time Editor With Greater Than or Equal to 9:00 AM

	6. Determine the end of the Time Range by clicking the Insert button.
	7. Determine the end of the Time Range (Friday).
	a. Select Hour from the left pull�down menu.
	b. Select <= from the middle pull�down menu.
	c. Select 17 from the right pull�down menu.
	FIGURE�11�17 Comparison Tab With Less Than or Equal to 5:00 PM


	8. Click the Apply button.
	FIGURE�11�18 Time Editor With Time Interval Between 9:00 AM and 5:00 PM

	9. Click the Apply button.
	FIGURE�11�19 Alarms Attribute Editor With Alarm Window From 9:00 AM to 5:00 PM Every Day
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	Sun Enterprise SyMON Modules
	Default Modules
	Module List
	TABLE�12�1 Sun Enterprise SyMON Modules�


	Loading Modules
	To Load a Module
	1. Select the host machine on which the module will be loaded by clicking on the host machine icon.
	2. Open the Load Module dialog by doing one of the following:
	FIGURE�12�1 Load Module Pop�Up Menu in Hierarchy View
	FIGURE�12�2 Load Module Pop�Up Menu in Topology View
	FIGURE�12�3 Tools Menu in Main Console Window
	FIGURE�12�4 Load Module Menu in Details Window
	FIGURE�12�5 Load Module Dialog

	3. Click the name of the module you want to load.
	4. Click the OK button.
	FIGURE�12�6 Module Loader Dialog For Directory Size Monitoring
	FIGURE�12�7 Module Loader Dialog for Process Monitoring

	5. If necessary, type the relevant information into any editable name fields.
	6. Complete this procedure with one of the following actions:


	Editing Modules
	FIGURE�12�8 Edit Module Pop�Up Menu in Hierarchy View
	FIGURE�12�9 Edit Module Pop�Up Menu in Contents View
	FIGURE�12�10 Edit Module Menu in Details Window
	To Edit Module Parameters
	1. Select the selected module.
	2. Proceed with one of the following:
	3. Type the relevant information into the editable fields.
	FIGURE�12�11 Module Parameter Editor

	4. Complete this procedure with one of the following actions:

	To Disable a Module
	FIGURE�12�12 MIB-II Instrumentation Module Is Disabled

	To Enable a Module
	To Unload a Module
	1. Proceed with one of the following:
	FIGURE�12�13 Unload Module Dialog

	2. Click the Unload button to remove the module or the Cancel button to cancel this request.


	Monitoring Modules
	Attribute Editor for a Module
	Setting a Module Schedule
	To Set a Module Schedule
	1. Open the Attribute Editor for a module by proceeding with one of the following:
	2. Click the Schedule tab (FIGURE�12�14).
	3. Click the Advanced button and set the module schedule.
	4. Complete this procedure with one of the following actions:
	FIGURE�12�14 Setting a Module Schedule


	Setting Security Permissions for a Module
	To Set Security Permissions for a Module
	1. Open the Attribute Editor for a module by proceeding with one of the following:
	2. Click the Security tab (FIGURE�12�15).
	3. Type the name(s) of user and administrator groups in the appropriate fields.
	4. Complete this procedure with one of the following actions:
	FIGURE�12�15 Setting Module Security in the Attribute Editor
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	FIGURE�13�1 Domain Status Summary in the Main Console Window
	FIGURE�13�2 Alarm Severities
	Down Alarms
	Critical Alarms
	Alert Alarms
	Caution Alarms
	Off/Disabled Alarms
	FIGURE�13�3 Objects with Irrational States Identified by Black Star or “Splat” Icon



	Notifying Users That a Host or Agent is Down
	To Set Up User Notification for Down Host or Agent
	1. In the main console window, select the host or group of hosts that you want to receive notific...
	2. Click the right mouse button to display the pop-up menu, and select Alarm Action (FIGURE�13�4).
	FIGURE�13�4 Pop�Up Menu in Hierarchy View

	3. Enter the email address and username to be notified for the host down, and agent down condition.
	4. To include any email users who are linked to the down host or agent group, click “yes” in the ...
	FIGURE�13�5 Attribute Editor - Alarm Action

	5. Click OK to close the Attribute Editor - Alarm Action screen.


	Creating Alarms
	Viewing Alarm Information
	Colored Alarm Icons
	FIGURE�13�6 Alarms in the Details Window
	FIGURE�13�7 Alarms in the Contents View

	Seeing Alarms in Domain Status Summary
	FIGURE�13�8 Domain Status Summary Buttons

	To Access Alarms from the Main Console Window
	1. Click on one of the Domain Status Summary buttons in the main console window. (FIGURE�13�8).
	2. Complete this procedure with one of the following actions:
	FIGURE�13�9 Domain Status Details Window



	Information on Alarms
	To Access Alarms from the Alarms Tab in the Details Window
	1. Click with your right mouse button on the selected host icon in the main console window and hi...
	2. Click on the Alarms tab button.
	FIGURE�13�10 Alarms Tab Data from the Details Window


	Alarm Categories
	TABLE�13�1 Alarm Categories Displayed in Table�
	TABLE�13�2 Additional Alarm Information Displayed When a Single Row is Selected

	Alarm States
	FIGURE�13�11 Open and Closed Alarms

	To View Alarm Categories
	1. Click on the Show button below the Table actions field.
	2. Click on the appropriate tab to filter your alarm request.
	3. Click on the Severity tab (FIGURE�13�2).
	4. Click on the check box next to a severity to show alarms of that severity.
	5. Click on the State tab (FIGURE�13�11).
	6. Click on Open or Closed to show these types of alarms.
	7. Click on the Acknowledge tab.
	8. Click on Acknowledged or Unacknowledged to show these types of alarms.
	9. Complete this procedure with one of the following actions:

	To Sort Alarms
	FIGURE�13�12 Sort Alarm Table
	1. Click on the Sort button below the Table actions field.
	2. Select your sort feature by clicking in the circle next to your selection.
	3. Complete this procedure with one of the following actions:

	To Reset the Alarm Table

	Acknowledging and Deleting Alarms
	To Acknowledge and Delete Alarms
	1. Select the alarms you want to update by clicking the selected row(s) in the table.
	2. Click the appropriate button under the Alarm actions field.
	TABLE�13�3 User Actions That Can Be Performed on Alarms



	Creating Alarm Conditions
	To Create Alarm Conditions To Monitor Hosts
	1. Navigate through the Operating System modules until you see the User Statistics icon (part of ...
	2. Select Attribute Editor from the pop-up menu.
	3. Create an alarm condition by following the procedure in “To Create an Alarm” on page�174.
	4. Click on the Alarms tab button in the Details window.
	5. Acknowledge, then delete this alarm if the alarm is closed.
	6. Create additional alarm conditions and familiarize yourself with their operation.
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	Starting the Details Window
	To Start the Details Window
	1. Double click the left mouse button on an object icon in either the hierarchy view or the topol...
	FIGURE�14�1 Details Window for a Selected Object

	2. Click a tab to view detailed information for that category.
	FIGURE�14�2 Light�Colored Circles “Unroll” to Provide Additional Levels of Detail


	To Close the Details Window.

	Info Tab
	TABLE�14�2 General Properties in the Info Tab of the Details Window

	Browser Tab
	Alarms Tab
	Processes Tab
	FIGURE�14�3 Processes Tab
	Configuring the Process Display
	Selecting Columns for Viewing
	1. Click the View Columns button above the Process table to display the View Columns pull-down menu.
	FIGURE�14�4 View Columns Menu

	2. Highlight one or more process properties that you want to display.
	TABLE�14�3 Process Viewer Properties�


	Sorting Columns
	To Sort Columns in Ascending Order
	To Sort Columns in Descending Order
	Moving Columns
	To Reorder Columns in the Table
	1. Select a column by clicking and holding down the mouse button on the table column header.
	2. Drag the column to the desired position.


	Process Statistics Window
	TABLE�14�4 Process Statistics

	Process Summary Field

	Log View Tab
	FIGURE�14�5 Logview Tab
	Log File Type Button
	To View the Log File Messages
	Filtering Your Messages
	To Filter Your Log Request
	1. Click the Filter button in the log viewer (FIGURE�14�5).
	FIGURE�14�6 Message Filter Options Dialog

	2. Using the down arrows, select the starting date by highlighting the month, day, and year for t...
	3. Select the starting time by using the down arrows.
	4. Select the ending date.
	5. Select the ending time.
	6. Type the text pattern to be matched in the field marked “Text pattern to match.”
	7. Click the Advanced button if you want to refine further your filter request. Otherwise, skip t...
	FIGURE�14�7 Advanced Message Filter Options Dialog

	8. To perform a forward or backward search through the log file, select Forward or Backward.
	9. (Optional) Type the maximum number of log messages that should be matched in the field marked ...
	10. Complete this procedure with one of the following actions:


	Reload Button
	Monitor Button
	To Monitor Log Messages
	1. Click the Monitor button in the log viewer (FIGURE�14�5).
	FIGURE�14�8 Monitor Filter Options Dialog

	2. Click the appropriate circle to enable or disable log file monitoring.
	3. To display only currently monitored log messages, click the check box to clear old monitored m...
	4. Type the text pattern to be matched in the field marked Text pattern to match.
	5. Complete this procedure with one of the following actions:


	Finding Specific Log Messages
	To Find a Log Message
	1. Type the specific character sequence (part of the log message) in the Find field (FIGURE�14�5).
	2. Click Return or the down or up arrow to search the log messages for that sequence.
	3. Click Return or the down or up arrow to continue your search and find additional occurrences o...



	Configuration Tab
	FIGURE�14�9 Configuration Details Window
	To View a Configuration
	Resources
	TABLE�14�5 Resources

	Physical View
	FIGURE�14�10 Configuration Physical View
	View Points
	FIGURE�14�11 Component Physical View

	Physical View When a Sun StorEdge Device is Connected
	FIGURE�14�12 Pop-up sena Menu
	FIGURE�14�13 sena (0) Physical View with Details

	Dynamic Reconfiguration
	Show Details
	FIGURE�14�14 Property/Value View


	Logical View
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	Search
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	Show Details
	15
	Sun Enterprise SyMON Security



	Access Control (ACL) Categories
	Sun Enterprise SyMON Users
	Public and Private Users
	General Users
	Sun Enterprise SyMON Superuser


	Sun Enterprise SyMON Groups
	Sun Enterprise SyMON OPeratorS or esops
	Sun Enterprise SyMON ADMinistrators or esadm
	Sun Enterprise SyMON DOMain ADMinistrators or esdomadm

	Admin, Operator, and General Functions
	TABLE�15�1 Domain Admin, Admin, Operator, and General Functions�


	Specifying Access Control (ACL)
	Admin, Operator, and General Access
	Sun Enterprise SyMON Remote Server Access
	Sun Enterprise SyMON Server Context
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	Using Access Control (ACL)
	To Add Sun Enterprise SyMON Users
	1. Become superuser (on the Sun Enterprise SyMON server host).
	2. Edit the file /var/opt/SUNWsymon/cfg/esusers. Make sure that the user name is that of a valid ...
	3. Add the user name on a new line.
	4. Save the file and exit the editor.

	To Access ACL on a Module
	1. Proceed with one of the following:
	2. Select the Security tab within the Attribute Editor window (FIGURE�15�2).
	3. Change the values as required.
	FIGURE�15�2 Example of Security Fields in the Attribute Editor
	TABLE�15�2 Security Attributes


	To Add a User-Defined Group to an ACL
	1. Become superuser.
	2. Create a group:
	3. Add users to the newly created group:
	a. Edit the /etc/group file.
	b. Add users to the group.
	c. Save the file and exit the editor.

	4. Add the new group to the ACL of interest.

	To Grant a User esadm, esops, or esdomadm Privileges
	1. Become superuser.
	2. Make sure that the user is a valid Sun Enterprise SyMON user.
	3. Edit the /etc/group file.
	4. Add the user to one of the following lines as applicable: esadm, esops, or esdomadm.
	5. Save the file and exit the editor.

	To Delete Sun Enterprise SyMON Users
	1. Become superuser on the Sun Enterprise SyMON server host.
	2. Edit the file /var/opt/SUNWsymon/cfg/esusers.
	3. Delete the line corresponding to the user name you want to delete.
	4. Save the file and exit the editor.
	5. Delete the user names from additional groups.


	Default Privileges
	Topology Manager Default Privileges
	TABLE�15�3 Default Privileges for Topology Manager
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	Regenerating Security Keys
	To Regenerate the Security Keys
	1. Log in as root.
	2. Depending on your installation, type one of the following.
	3. Restart the Sun Enterprise SyMON server.


	Configuring a Legacy SNMP Agent as a Subagent of a Sun Enterprise SyMON Agent
	To Configure a Legacy SNMP Agent as a Subagent of a Sun Enterprise SyMON Agent
	1. Log in as root.
	2. If the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x does not exist, copy it from the /opt...
	3. In the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x, find the block that is similar to CO...
	CODE�EXAMPLE�B�1 Before Editing Registry file�

	4. Remove the comment symbol at the beginning of the line (#) so that the code looks like CODE�EX...
	CODE�EXAMPLE�B�2 After Removing the Comment Symbol in the Registry file�

	5. Modify the lines as follows:
	a. Change sa2 to the unique subagent name for the agent.
	b. type is legacy.
	c. persist is false if the subagent is stopped when the Sun Enterprise SyMON agent exits. If this...
	d. snmpPort is the UDP port number on which you want to run the subagent.
	e. errorAction can be restart, ignore, or kill. If the restart option is used, then the Sun Enter...
	f. startCommand is the mandatory command to start the subagent. This command should contain %port...
	g. stopCommand is the command to stop the process. %pid can be used to represent the process ID (...
	h. pollInterval defines the time (in seconds) in which the Sun Enterprise SyMON agent polls the s...
	i. pollHoldoff is the time (in seconds) after which the first poll is done on the subagent after ...
	j. oidTrees gives the space�separated list of SNMP OIDs managed by the subagent.
	k. snmpVersion can take values SNMPv1 and SNMPv2.
	l. securityLevel can be priv, auth, or noauth.
	m. securityName is the SNMPv1 community name or SNMPv2 security name to use.

	6. Stop then restart the agent:


	Configuring Sun Enterprise SyMON Software to Use Different Port Addresses
	To Determine if a Port Is Used
	TABLE�B�1 Sun Enterprise SyMON Default Port Addresses

	To Reconfigure Sun Enterprise SyMON Software to Use Nondefault Port Addresses
	1. Run the es-setup script to create the domain-config.x and server�config.x (server configuratio...
	2. Edit these files with the new port numbers.

	To Reconfigure Sun Enterprise SyMON SNMP Port Addresses
	1. Log in as root.
	2. Edit the domain-config.x file and change the address port to an unused port.
	3. Save the file.

	To Reconfigure Sun Enterprise SyMON RMI Port Address
	1. Log in as root.
	2. Edit the /var/opt/SUNWsymon/cfg/server-config.x file.
	3. Search for the block which starts with rmiReceptor.
	4. Uncomment the line that reads property:rmiPort = 2099 by deleting the pound (#) character.
	5. Change the address port to a new unused port number.
	6. Save the file.


	Monitoring Topology Manager and Event Manager
	To Create a Server Component as a Monitored Object
	1. In the main console window, select Edit ‰ Create an Object.
	2. Click the Node tab.
	3. Click the Monitor Via button to see the pull-down menu, then select SyMON Agent - Host.
	4. Type the name of the server component in the Node Label field.
	5. (Optional) Enter a description of the node.
	6. Enter the name of the Sun Enterprise SyMON server in the Hostname field.
	7. Type the port number for the server component in the Port field (FIGURE�B�1).
	8. Complete this procedure with one of the following actions:
	FIGURE�B�1 Creating a Server Component as a Monitored Object
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	To Increase the Critical Threshold for the Virtual Size Data Property.
	1. Create the Topology manager monitored object.
	2. Open the Details window by proceeding with one of the following:
	3. In the Browser Details window, double�click on the Local Applications icon in the hierarchy (t...
	4. Double�click on the Agent Statistics icon in the contents view or single click in the light�co...
	5. Double�click on the PA Process Statistics folder icon in either the hierarchy or the contents ...
	FIGURE�B�2 PA Process Statistics Property Table

	6. Select the Virtual Size table cell, then proceed with one of the following:
	7. Click on the Alarms tab button.
	8. Type the desired value in the Critical Threshold (>) field.
	9. Complete this procedure with one of the following actions:
	FIGURE�B�3 Alarms Tab for the Virtual Size Property in the Topology Manager Object
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	FIGURE�B�4 Event Management Module Data Properties

	To Change the Default Values for Smart Delete in the Event Manager
	1. Create the Event manager monitored object.
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	3. In the Browser Details window, double�click on the Local Applications icon in the hierarchy (t...
	4. Select the Event Management module and proceed with one of the following:
	5. Type the new time values into the editable fields.
	6. Alternately, you may turn off “smart delete” by selecting Disabled in the pull�down menu next ...
	7. Complete this procedure with one of the following actions:
	FIGURE�B�5 Module Parameter Editor for the Event Management Module
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